


HHaalltt!!  WWhhoo  ggooeess  tthheerree??

■■ eeddiittoorriiaall

“Is this another step
towards a controlled
society? Are we
willing to let someone
else choose what
content is appropriate
for us?”

The police in Mumbai recently announced plans to make it manda-
tory for cyber cafe owners to demand proof of identification from anyone
wanting to access the Internet from their establishments.

Did our future on the Internet just take a wrong turn? Are we perhaps
seeing the beginning of a trend that will spread to other parts of the coun-
try? Or is this just another typical knee-jerk reaction to a situation that no
one around here understands? 

Consider the stated objectives. To bring under control various kinds of
cyber crimes and to curb access to pornographic content.

But what is the point of this move? 
Put aside for a second the completely justified concern you might have

about your privacy being compromised. Keep in mind the fact that cyber
crime is an issue we will need to grapple with sooner rather than later. It
still isn’t going to work. There are too many ways for people to get around
this requirement. At the very least it’s going to be completely ineffective.

The bigger danger is that people might become uncomfortable about
using cyber cafes to access the Internet. Just at a time when Internet usage
needs to be encouraged. Both government and industry are working to
develop the potential of the Internet and cyber cafes, which provide inex-
pensive access to a large percentage of Internet users in India, have a crit-
ical role to play in this development process.

Consider also the matter of freedom of choice. Cyber cafe owners will
now have to monitor and filter Internet usage. Is this another step towards
a more controlled society? Are we willing to let someone else choose what
content is appropriate for us? Must we disclose personal information to
someone just because we need to access the Internet?

Is this freedom something that needs protecting in a democracy?
To effectively address cyber crimes, our police forces need to gain a bet-

ter understanding of the tools used by the Internet criminal. It must be
made mandatory for businesses to invest in protecting the interests of their
customers. And greater synergy needs to be created between the industry
and police agencies to tackle this very real menace.

A roadblock isn’t usually the most effective way to catch a clever crim-
inal, and it can often be disruptive. But it is usually the most obvious and
visible solution to the problem.

Maybe that’s exactly the point.

Karan Manral
Assistant Editor
karan_manral@jasubhai.com
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Responding quickly to
AMD’s announcement of the
Athlon 4 chips for mobile
PCs, Intel announced the
introduction of five new
mobile Pentium III chips in
July. These are aimed at con-
tinuing Intel's total domina-
tion in processors for mobile
PCs. The ‘Tualatin’ chips will
be essentially Pentium III
based, with clock speeds
ranging from 866 MHz to
1.13 GHz. Manufactured
using a new 0.13-micron
manufacturing process, they
will decrease power con-
sumption, thanks to a newer,
version of the power-saving
SpeedStep technology. The
current generation of Intel’s
processors are manufactured
using a 0.18 micron process.
The new  chips are also
expected to feature 133 MHz
FSB and 512 KB of Level 2
cache. Intel plans to launch
lower-powered versions
which will compete with
Transmeta products for
smaller-sized notebooks.

Palm Inc, the leading
manufacturer of hand-
held devices is expected to
announce a Jordan-edi-
tion device. Hopefully,
this will help boost the
sales of Palm handhelds,
which have been affected
by a slowdown in demand
for handhelds, which is
also affecting rivals such
as Handspring. Palm
already has a deal with
model Claudia Schiffer to
endorse a special edition
of the Palm Vx device that
comes with its own customised
software and can be purchased

through the model’s personal
Web site.

Intel responds 
with Tualatin
for laptops

◆ Oracle introduces 9i database solution  ◆ Suck.com and Feed.com, and Sabeer Bhatia’s Arzoo.com shut down 

SRSWOWcast
▲ WWhhaatt  iiss  iitt??
SRSWOWcast would devel-
op high quality digital audio
technology for various
media. It provides
enhanced voice solutions
for streaming over the
Internet, Internet radio and
also for 3G wireless equip-
ment. They are also cater-
ing to a few other
segments like VOIP and
Internet Telephony.

▲What’s so great about it?
SRSWOW is the latest tech-
nological innovation, which
would enable the restora-
tion of loss that usually
occurs while compressed
audio is streamed. WOW
entirely redefines the quali-
ty of music and delivers
ultimate music experience
to the audience.

▲Who made it?
It’s developed and released
by SRS Technologies, the
world leaders in providing
audio and voice enhance-
ment solutions. They have a
multitude of audio solu-
tions catering to various
segments of consumers.
Find them at 
www.srswowcast.com

hypethesis
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Graphics chipset supremo
nVidia is looking to grab a
piece of the PC motherboard
market. The
nForce is a new
PC platform
design, which
integrates sys-
tem, graphics
(a GeForce 2
MX core), communications,

and audio technologies (Dolby
Digital 5.1 Sur-

round) into the
motherboard.

The chipset,
which will
work with

AMD proces-
sors only, uses the

HyperTransport bus, a
technology licensed by

AMD. It aims to provide an
integrated solution for main-
stream and performance PCs.

nVidia has also announced
that Fujitsu-Siemens intends 
to use the nForce platform in
their co sumer PCs.The nForce
is a modified version of a
chipset that nVidia has devel-
oped for Microsoft's much
anticipated Xbox console.

➜

NTT DoCoMo launched the
world’s first 3G mobile phone
service in Japan. The service,
named Foma, is being tested by
a few lucky users who will get
access to trial services that allow
data to be downloaded at speeds
between 64 and 384 kilobytes
per second.

Full-scale services are
unlikely to be introduced until
October this year.

Most users seem satisfied
with the service despite glitch-
es such as high battery con-
sumption, ‘freezing’ of phones
(solved by a restart), and some
trouble accessing mail due to a
malfunctioning mail server.
NTT DoCoMo has also
announced that it will replace
all 1,400 3G mobile handsets
originally handed out to
improve functionality.

DoCoMo puts 3G into action

SNAPSHOT 
In 1972 
Noel Bushnell, the cre-
ators of Atari, introduced
Pong, the first video game

UNIVAC, the predecessor of
today’s business PCs, is now 

50 years old

Source: CNN, Time

nVidia launches motherboard chipset

Can Jordan score for Team Palm?
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At a time when PC and hand-
held device purchases seem to
be slowing down, one catego-
ry of personal gadgets that is
seeing promising growth is
digital still cameras. Growth
rates are being projected to be
in the region of 50 per cent,
despite high adoption rates in
countries like the US. The
major Japanese manufactur-
ers, namely Sony, Olympus,

Fuji, Canon and others in the
US like Eastman Kodak and
Hewlett-Packard are all hop-
ing that their products will
capture the imagination of
customers.

Major improvements in
CCD resolution and lens tech-
nology have brought about a
vast improvement in the
image quality of the current
generation of still cameras.

◆ Norton lays off 10,000 workers  ◆ MP3 format gets upgraded to MP3Pro ◆ Mail bug hits NTT DoCoMo mobile users in Japan  

Comically Yours
Attracting children to activate a
virus is one strategy that cyber
vandals seem to be taking into
deep thought. Pikachu, a yellow
rabbit-like character, which
belongs to the Pokeman series
of games, has shown his happy
face to many of the computer
users in the US and faithfully
deleted their system files also.
This little brat has been quite a
big menace. The virus
researchers from Symantec say
that they have never, until now
seen a virus targeted at chil-
dren. In fact, this is one of the
first viruses targeted at children
as the little Pokeman attracts
children and makes them dou-
ble-click him. The e-mail

appears with a title, ‘Pikachu
Pokemon’ and an English mes-
sage, “Pikachu is your friend”. 

Pikachu has been spreading
very slowly and has given
enough time for researchers to
put updates with their packs.
Despite the fact that the virus
has spread slowly, it has had
heavy impact on the victims. It
deletes the windows and sys-
tem directories. The OS from
the Redmond giant has to be
installed from scratch and since
it happens to be on most desk-
tops all over the world, it’s
indeed a heavy impact on PC
users. Trend Micro from Japan
has warned Japanese people to
delete any mail with such a
message. 

Sulfnbk.exe
A hoax e-mail warning people
of a virus, which would be trig-
gered on June 1, was on the
prowl for sometime recently.
The message stated that your
computer might be infected
with virus and it asked you to
check for a file by the name
sulfnbk.exe. 

The message added that the
virus is not detectable by any of
the anti-virus software and that
it could be safely deleted by
searching it with the Microsoft
Find File tool. 

People who received the 
e-mail were astonished to find
that the file actually exists in
their computer in the Windows
directory. 

In reality it’s a Microsoft file,
which is used by the OS to
resolve long file names. 

The file is harmless and
what’s more, deleting this sys-
tem file would make the feature
of resolving long file names
inactive. 

Alarmed by its contents,
everyone tried to help their
friends, spreading the hoax. 

All this started with a virus
named W32.Magistr.24876@mm,
which infected the file
sulfnbk.exe. It was curable with
any of the available anti-virus
software. The first victim
thought that the infected file
was the virus and started
spreading the message that
sulfnbk.exe was a virus.

Redalert

On e-publishing, an area
where it is now making an
entry
▲ what is e-publishing?
E-publishing is basically distrib-
uting content in the electronic
format. What IDG
Books offers in this
area is value to the
reader. On our Web
site you can create
your own books or
customise your
own chapters
across a lot of
books. You can
pay and down-
load it or if you
order minimum
three chapters, we will send a
printed format of the same,
fully customised for you. 
▲ What are hybrid books?
Given the rapid developments
in software and technology, by
the time a book on a particular
technology is out, either that
technology is outdated or a
new version has come out. So
after you’ve bought a book, we

give you free updates of that
technology or software through
our Web site. You can use the
unique password issued with
the book to login. We are the
first in the world to introduce

this concept.
▲ What is the future of
e-publishing and
eBooks in India?
E-publishing hasn’t
taken off in India
because of the copy-
right problem. Online

book publishing and
online books will
never take off with-
out an offline model
supporting it. Fur-

thermore, you would never be
comfortable reading large vol-
umes of text off your screen.
And again, it would be costlier
for you to take a printout of
the eBook. So to make the e-
publishing and eBooks a suc-
cess, a lot o work needs to be
done to improve computer
displays so that there is less
eye strain.

IDG Books is a leading publisher of computer books

quicktake

Vikas Gupta
MD 

IDG Books India

➜

Apple has announced that it
would now stop shipping CRT
monitors with its professional
systems and switch over to
LCD displays. This would
make them the first manufac-
turer to switch over complete-
ly to flat panel LCD displays
for a major part of their prod-
uct lineup. The iMac range,
however, is likely to continue
with CRT monitors for now.

With prices of LCD monitors
coming down, partly due to an
increase in volumes of LCDs
being manufactured, these dis-
plays are likely to continue to
become more affordable. IBM
recently announced a new
manufacturing process, which
it claims would allow improve-
ment in screen quality and
viewing angles, and helps
reduce the cost of production.

Apple switches to LCD displays

Digital cameras are hot!
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◆ IE 6.0 will be the first to support P3P (Platform Privacy Preferences)  ◆ Japanese government orders takedown of school murder game

“It (Linux) is a cancer that attaches
itself in an intellectual-property

sense to everything it touches”
SStteevvee  BBaallllmmeerr,, CEO Microsoft,
in another one of Microsoft’s
tirades against Linux.

realitybites
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WEB SERVER USAGE

Sounds a lot like
an MS Word
macro virus

A couple of comic stars have
become very popular with
users of Club Nokia. More
than 3,000 Europeans reli-
giously log into this free
Nokia mobile Internet site to
catch the latest adventures of
Flip and Mick. This duo, cre-
ated by Helsinki-based Mov-
ing Entertainment, find
themselves trapped inside the
pixelated world of mobile
phones. About 400 episodes
involving the two characters
have been created and the
company expects to see read-
ership increase to 50,000 by
end 2001.

Mobile Toonz!

Market share analysis of Web servers based on two parameters:
Top 50 referred sites (based on how many sites link to each server) and across all domains

thermometer
Hot
Audiogalaxy
Alternative to
Napster that
guides people to
free copies of
almost any popu-
lar song
Linux
Leading TV tech-
nology compa-
nies are working
together to
design Linux-
based set-top
boxes 

Cold
WAP
After GSM Associ-
ation announced
plans to intro-
duce a Mobile
Services Initiative
to replace WAP
Web ‘zines
After Suck.com
and
Feedmag.com
shut downcing

“We are targeting fence-sitters who
have stayed away from owning

a mobile because of a perception that it’s
expensive”

SSaannjjaayy  KKaappoooorr,,  CEO, Bharti Cel-
lular, talking about their efforts to
increase the number of mobile
users in India by lowering prices.

It isn’t too
expensive 
initially. And
once you get
used to it, you
won’t mind too
much

“U nlike those other products, we
offer a compelling package of

hardware, software and service”

RRoobb  BBaarrtteellss,, GM for Product Development,
Sony Electronics, on why Sony is launching its
eVilla Network Entertainment Center at a time
when others like 3Com, Netpliance and Gateway
have given up on their Internet appliances.

There’s one thing
you really need
to remember...
IT’S A SONY

➜

Thomson Multimedia, the
company that released the
original MP3 music format,
has released an upgraded ver-
sion called MP3Pro. Files in
the new format are backward
compatible and will work
with existing software and
devices that are designed for
MP3 files.

Developed by Stolkholm-
based Coding Technologies,

the new format will produce
better quality sound at lower
bitrates. That is, you can get
CD quality sound at just 64
Kbps. You can download a
demo version of the MP3Pro
encoder from 
www.codingtechnologies.com.

Mastering MP3

Illustrations: Farzana Cooper



July 200120

■■ ppuullssee

20

Intel researchers have pro-
duced a silicon transis-
tor with dimensions of
80 atoms wide by 3
atoms thick. This tiny
switch is constructed
with the same
equipment that
is used to build
the current gen-

eration of chips (Pentium
IIIs and 4s) and can

be switched on and
off 1.5 trillion
times a second.
Intel estimates
that this
research will
allow it to build

chips with speeds

up to 20 GHz over the next few
years. The Pentium 4, which
contains 42 million transistors
and uses a 0.18-micron manu-
facturing process. Compared to
this, the new technology will
use a 0.045-micron process
and allow an estimated 1-bil-
lion transistors on the 20 GHz
chip by 2007.

Intel’s new atomic transistor

tomorrowstechnology

Intel has finally
announced production of
its much-delayed Itanium
series of processors for
servers. The Itanium,
which uses a 64-bit archi-
tecture, and has been
developed in collabora-
tion with HP, will be
pitched against the IBM’s
Power family and Sun’s Sparc
processors. Despite the delays
in development, initial bench-
marks seem to suggest that its
performance will compare

favourably with existing chips.
HP and Dell, amongst others,
have been quick to announce
products that will use the new
processor.

metrics

▲
▲

$240 million
loss incurred by India due to pirated software in 2000, accord-
ing to the annual Business Software Alliance Global Piracy
Study for 2000.

According to Nasscom estimates for 2008, the number of soft-
ware exporting companies in India is expected to exceed 

4,500

Intel’s Itanium arrives. Finally!

TV Cabo, a Portugal-based
cable-TV company, will be the
first to introduce services
using Microsoft TV software, a
platform that allows the
delivery of interactive TV serv-
ices to viewers. 

It supports a range of TV
devices ranging from current
and next-generation set-top
boxes and digital video
recorders to integrated TV
sets, entertainment appli-
ances and other computing
devices. Some services that
will be offered include e-mail

and high-speed Internet
access on television as well
as interactive programming,
electronic program guides
and digital video recording. 

A lot of the features avail-
able are similar to those that
Microsoft’s Ultimate TV serv-
ice currently provides to sub-
scribers of DirecTV’s satellite
service in North America.

Interactive TV does seem
to have a lot of potential but
has been slow to catch on. TV
Cabo’s move should boost
usage of this technology.

Microsoft takes Interactive 
TV to Europe

from site ◆ Orbitz.com becomes the fastest-growing site on the Internet ◆ MSN to offer music subscription services through portal ◆

Whois?
XYBERNAUT
▲ What is it?
Xybernaut produces most of
the wearable computers
and has been in this arena
for more than a decade. The
company claims that it
holds most of the patents
for wearable computers. 
▲ What does it do?
Xybernaut works on minia-
turising wearable comput-
ers, keeping in mind
thermal aspects and conser-
vation of power by making
these devices versatile.
Mobile Assistant, a product
of Xybernaut, has the capa-
bilities of a desktop PC. The
company was one of the
pioneers to have introduced
wearable PCs with speech
recognition capabilities.
▲ What is its future plans?
Xybernaut’s plan is to make
cheaper wearable computers
for each new generation and
has the vision of making
these gadgets lighter, smaller
and more powerful. The
team at Xybernaut is working
towards improving display
devices in such PCs and also
improving the I/o schemes
and storage options.

Intel has announced a new 845
chipset for its P 4 processors
that will support DRAM
(dynamic random access mem-
ory) chips that run at 133 MHz.
The chipset, which is expected
to be released around the third
quarter of the year, will be the
first Pentium 4 chipset without
support for RDRAM. This is a
big blow for Rambus, the man-
ufacturers of RDRAM memo-
ry, which is much faster than
the current SDRAM speed of
133 MHz. Intel’s move is prob-
ably due to the cost factors
involved in going with the
expensive RDRAM.

Pentium 4 without
RDRAM?
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TToooo  DDiiggiitt  ttoo  QQuuiittDear Karan,
After hearing about the change, I visited your Web site at

www.thinkdigit.com and really liked what I saw. Hearing the reasons

for the change of name straight from the ‘horse’s mouth’ made me

feel that it is time that we moved on. After all, those very same intel-

ligent, witty, dedicated and hardworking people who earlier made

CHIP will still be there, won’t they? What originally made me get

worked up was the thought that this magazine wouldn’t have you

people working on it. Now I feel assured of getting high quality stuff

just like before. If Digit is going to be what it says it will be, then I have

absolutely no problem at all. I shall continue to buy Digit.
Here’s wishing Digit best of luck in the future.

ROHIT
Via e-mail

Over the last month or so since we announced the release
of Digit, we have received a lot of feedback via our Web site,
through e-mail, and through regular post. So many of you,
even those who were initially apprehensive about the new
name, have written in with words of encouragement.

We would like to take this opportunity to thank all of
you for the overwhelming support that you have given the
inaugural issue.

RRuunnnniinngg  llaatteeDear Digit,
You have a BIG delivery problem! After getting in touch with your office regard-

ing the non-receipt of my issue till the 12th, I received a call from your courier

company. They informed me that as per their records I had already received my

June copy! 
Only after extended conversations with your customer service department

and challenging the courier company to show me the signed receipt, was I able

to get him to admit that “perhaps” there might have been some mistake on the

delivery boy’s part. They then expected me to wait another day for my copy, and

it was only upon my insistence that I received my copy by special delivery at 5.30

p.m. on the same day (June 12, 2001).Earlier, your distribution had improved to a point when I was getting my

copies latest by the 3rd or 4th of the month.  However, over the last three

months, I have been receiving them around the 12th or 13th. This is certainly

not acceptable. Why can’t you ensure that delivery is made around the 2nd or

3rd as was done in the past? Late receipt of the copy means that I can’t partic-

ipate in contests that carry an early bird prize. This is adding insult to injury! As

a customer of your company since the inception of CHIP, I expect service. I have

always received this in the past, but I am sad to say that it has been missing these

last three months. ROBERT DE SOUZAVia e-mail

Dear Robert,
First, allow me to apologise for the inconvenience faced by you
despite being a Digit subscriber. I entirely agree that having to wait
till the 10th of the month in order to receive your copy is unac-
ceptable. We shall work with the courier company to ensure that
you receive your copy much earlier in the month, as has been hap-
pening in the past.

GGaammeess  ppeeooppllee  ppllaayyDear Karan, 
I find that you do not give sufficient coverage to the Unreal series. Your obses-

sion with Quake goes to the extent that you have completely ignored

the Unreal 2 engine, which definitely deserves a mention, as it will

soon revolutionise gaming. It seems to me that your writ-
ers are biased towards Quake III and have neglected to
mention other contenders.In past articles on mods, you have failed to men-

tion some of the most popular mods for Unreal Tour-
nament. This is blasphemy, or perhaps complete
ignorance. You always seem to assume that Quake III
Arena is the most widely played game, but there are many who
play other games too. The gaming world doesn’t begin and end with

Quake. Please keep that in mind for the gaming articles that you do in the future.

ARJUN
Via e-mail

Hatim Kantawala replies:
Dear Arjun,
It’s great to hear from a passionate gamer who swears by his games and lives by his
mods! I was beginning to think we were an extinct species.

UT probably hasn’t got its due in some of our articles. But even an entire article
on UT mods is bound to seem incomplete. However, I admit we missed out on some
very popular ones.

Personally, I find installing and creating mods/maps for Quake III much simpler.
The source code and tools for them are more widely available. And if you were to
compare the number of mods/maps head to head, Quake III would win hands down.
This hopefuly explains our apparent bias towards Quake. We missed out the
Unreal 2 engine basically due to lack of real-time rendered videos, without which any
comments on our part would be premature. Ready for a death match?

PPrryyiinngg  eeyyeessHi Karan,
I read an earlier editorial by you and I fully agree with your views on security. However,

I am surprised that you guys then go ahead and blatantly provide spyware-embedded soft-

ware such as Go!Zilla on your CDs. I understand that in order to earn revenue and make

the software available freely, software makers have to depend upon advertising support.

But this does not justify preying on the privacy of uninformed users. Some kinds of spy-

ware, such as the Aureate/Radiate monster on Go!Zilla, which also prevents the software

from working when the spyware is removed, do exactly this.
I believe that as an institution you owe it to your consumers to enlighten the masses

about spyware. 
JAIDEEP SAPTARSHIVia e-mail

Dear Jaideep,
I think you will agree that there is a wide gap between the security issues that I
discussed and any possible concerns about privacy that spyware could raise.
Security, which I was discussing, and any possible piracy are two completely
separate issues. We have been very clear in stating which of the software includ-
ed in our CDs is adware. This is not necessarily the same as spyware, which
seems to have become an accepted Internet jargon for any advertising-sup-
ported software. The choices available to us are to either completely deny our
readers the chance to try out the software or to allow them to make a choice
about whether or not they would like to use them. The second choice is the one
that we feel is correct. While I agree with some of your observations on Radi-
ate, I think that if you really feel uncomfortable about the fact that the software
monitors your usage of it, just go ahead and get rid of it.



Short Bytes

BBaacckk  ttoo  tthhee  ffuuttuurree
Dear Digit,
The five major changes in Indian
history:
Congress to BJP
Corruption to Tehalka
Shah Rukh to Hrithik
Azharuddin to Ganguly
CHIP to Digit 
AVIJEET MOHANTY
Via e-mail

IInn  tthhee  ‘‘wwrriittee’’  ffrraammee
Dear Digit, 
As this is the beginning of a new
phase, I think it is appropriate for
Digit to start a section in which its
readers can also contribute their
articles and not just letters and
pieces for Backbyte. This will help
make Digit more interactive and
interesting to readers.
DAVINDER OBEROI 
Via e-mail ■

Dear Davinder,
Why don’t you make a start
by writing for Digit Dia-
logue, the quarterly newslet-
ter for our subscribers.
E-mail your articles to:
dialogue@jasubhai.com

Goof Ups
■■ The technology-savvy
Lokesh informs us rightly that
the graphics processor for
the Xbox is not NV20 as we’d
mentioned, but NV25.
■■  Mandeep Mehta is con-
cerned about the value of a
scanner we recommended in
the decision maker—the HP
Scanjet 6350C (the most
expensive scanner)—for the
price-conscious. Oops…it
should have been Acer Scan-
Prisa 640U for the budget
segment and HP Scanjet 5300
in the mid-range segment

Notice any goof-ups? Write to
goof@jasubhai.com

2255

TTeessttiinngg  ggrroouunnddss
Dear Karan,

Once upon a time there was this wonderful magazine called CHIP. Every month I would antici-

pate the arrival of a new issue packed with useful information and a CD full of great software. I

was filled with trepidation when I heard that CHIP was going to be replaced with a new maga-

zine. I comforted myself by saying that it was the same people who were behind the new mag-

azine, but when I bought the first issue of Digit it was my worst nightmare come true. I found

that the paper quality of the magazine had gone down. The anti-virus software comparison was

very superficial—I expected better from you. The Playware CD had very few games, and the tuto-

rials and software on the Mindware CD were no good. I could go on and on but I’ll stop here.

Earlier I used to buy every issue of CHIP without a second thought, but I’ll think twice before I

buy the next issue of Digit. 

Your former fan,

MANOJ JOHN ZACHARIAH

Via e-mail

Dear Manoj,
Wow! That’s a long list of complaints, but let’s take things one at a time.

Quality of paper: It is still 160 GSM for our cover and 60 GSM for the magazine pages. And we print
them at the same printing press too. Superficial testing: We did test more anti-virus products than we did
in the previous anti-virus test. We now included testing for features such as e-mail scanning, checked for
cleaning of the 10 most prevalent viruses and more. You could find the detailed test process and reviews
on the Mindware CD. Going a step further, where else would you get 50 products tested across five cate-
gories every month?

Too few games in Playware CD: Perhaps, but we keep receiving complaints that with eight or nine
games every month, we are too gaming oriented. CD Tutorials: We’ve included an exclusive free tutorial
from Gurukul Online (Windows 2000 for end-users) in the current CD.

Clearly, however, as you have mentioned in the case of the software on the CD, there are several
improvements that we need to make. Your continuous feedback and constructive criticism will only help
us improve as we grow. So keep it coming.

DDuuttyy  ffrreeee
Dear Digit,

I want to draw your attention to an absurd situation.

In the US, a Geforce2 GTS card costs a little more

than Rs 11,000. The same is priced at Rs 20,000 in

India. That’s a huge difference! What exactly is

going on? I can understand a difference of a cou-

ple of thousand rupees, but this is ridiculous. This

price puts this card way out of the reach of people like

me. What is the reason for this disparity and why

are we in India forced to pay so much more?

SHRIPAD KUDTARKAR

Via e-mail

Dear Shripad,
Yes, it is quite absurd. The high prices, especially for certain types of
products like graphics cards, are primarily due to additional duties that
are levied at the time of import. The duties add up to an increase of
approximately 35 per cent on the original price. Which is why a laptop
that is available in the US for $2,000 (about Rs 94,000) would end up
costing you about Rs 1,75,000 in India.

Duties are intended to protect the interests of the local industry, but
what really ends up happening is that because of the speed of change
in hardware technology, it becomes impossible for most Indian manu-
facturers to compete. Which leaves us paying through our nose for
products that are not manufactured in India.

Anybody got a solution? Tell us.

SSeenndd  yyoouurr  lleetttteerrss  mmaarrkkeedd  
‘‘RReeaaddeerrss  LLeetttteerrss’’  ttoo  tthhee  

DDiiggiitt  ooffffiiccee::  
DD--222222//22,,  MMIIDDCC,,  TTTTCC  

IInndduussttrriiaall  EEssttaattee,,  
OOmm  SSaaggaarr  BBuuiillddiinngg,,  NNeerruull,,  

NNaavvii  MMuummbbaaii  440000  770066
PPhhoonnee::  002222--77662299119911//99220000;;    

FFaaxx::  002222--77662299222244
EE--mmaaiill::

rreeaaddeerrsslleetttteerrss@@jjaassuubbhhaaii..ccoomm  
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C
ourses from private insti-
tutes can be very good, pro-
vided you bear in mind the
repute of the institute and

what you learn from it. Com-
panies from the organised sec-
tor have better technological
and personnel strength to back
up the students’ requirements
than institutes from the unor-
ganised sector, which don’t
have the competence to deliver.

Private companies provide
several benefits to students.

These include a trained faculty,
customised courses tailor-made
to industry needs, exposure to
real time environment and pre-
placements (students get jobs at
the company that trains them).

Other deciding factors are
the quality of training, course-
ware and the company’s cre-
dentials and background. The
technology base should also be
evaluated before a student
decides on an institute.

About foreign affiliations
and alliances, these provide
some very obvious benefits,
such as certified trainers, offi-
cial courseware developed by
the parent company, high 

certification value and licensed
software for the institute. It also
shows the institute’s commit-
ment to students, as it has to
pay substantial affiliation fees
with stringent renewal terms.

A majority of students from
private institutes get good jobs.
Today, organisations believe in
skillsets rather than certificates
and degrees. While the cream of

recruiters may insist on BEs
and BTechs, if they don’t get the
profile that they seek, they turn
to qualified, certified profes-
sionals from private institutes.

In fact, many students at
private institutes are from engi-
neering colleges, indicating that
latest software technology
training from private institutes
has become indispensable.

The steps taken by AICTE
are very encouraging. This will
make all institutes answerable
to a particular body. But while
conceptually it is a very wel-
come sign, its implementation
should be fast-paced and not
get bureaucratic.

C
omputer courses run by
private institutes are
worthwhile, provided they
are run in an efficient and

systematic manner, with guide-
lines for the students and the
administration. But currently,
there are dozens of ‘shops’ in
every nook and corner of the
country trying to pass off as
institutes. They fleece students

by charging hefty fees for
makeshift courses.

For instance, if they sense a
demand, they will go ahead and
teach a ‘career-oriented’ course,
without the required infra-
structure. Classic examples are
institutes such as Wintech and
Zap, which published full-page
advertisements in the media
and later shut shop, leaving
many a student in the lurch.

Moreover, the quality of
training in many private insti-
tutes is not up to the mark. The
faculty often comprises ex-stu-
dents of the institute, who may
themselves be unclear about
the subject they are teaching.

As far as foreign affiliations
and certifications are con-
cerned, these certificates are
legally invalid in our country.
Certain universities don’t even
have accreditation in their par-
ent country, and are offering
courses here without any qual-
ity controls and inadequate or
incompetent faculty.

AICTE is in the process of
putting up detailed guidelines
for a more structured system of
education. This would serve as

a deterrent for people who try
to create unrealistic aspirations
among gullible students, while
consistently failing to deliver
the quality of education that is
expected from them.

AICTE would like reputed
corporates such as IBM, Wipro,
Sun, etc to join hands with us
to start modular short-term
courses in the non-formal sec-
tor in a structured manner, so
that our students and profes-
sionals are trained on industry-
specific courses. This would
reduce the retraining cost for
the industry and also enhance
practice-oriented teaching in
institutions.

PPrrooffeessssoorr  II..KK..  BBhhaatt
Advisor, All India Council for Technical
Education

In search of knowledge
Do computer courses provided by private institutions actually satisfy your thirst for learning, or are
they just a mirage in the desert? Nilesh Kakade speaks with representatives of AICTE and Karrox

JJiitteennddrraa  NNaaiirr
VP (Software and Education Division),
Karrox International

“A majority of
students from
private institutes get
good jobs. Today,
organisations
believe in skillsets
rather than degrees
and certificates“

“There are dozens
of ‘shops’ trying to
pass off as
institutes...they will 
go ahead and teach
a so-called ‘career-
oriented’ course
without the required
infrastructure“
WWhhaatt  ddoo  yyoouu tthhiinnkk??  CCoommee,,  ssppeeaakk  yyoouurr  mmiinndd  aatt  wwwwww..yyaahhoooo..ccoo..iinn

wwwwww.y.yahoahooo.c.coo.in.in CCaattcchh  ‘‘eemm  lliivvee  oonn  YYaahhoooo!!  
JJIItteennddrraa  NNaaiirr oonn  JJuullyy  1122  aatt  44  ppmm  aanndd  II..KK..  BBhhaatt oonn  JJuullyy  1199  aatt  44  ppmm



N
o other Internet application has received as
much attention as the use of the Net for
education. Online education is more than
just online content—it includes peer-to-

peer and student–expert interactions, evaluation
and assessment, and access to additional learn-
ing resources. Tomes have been written on the
market potential of online education, with esti-
mated figures varying from $11 billion upwards.

Most education companies and universities
are in the process of experimenting with a vari-
ety of business and instructional models—from
the completely free online content that MIT

plans to host to a lot of combinations of brick-
and-mortar and Net-based systems.

Large Fortune-500 companies have all
embarked on some form of online initiative,
with a few setting up full-fledged virtual univer-
sities to impart training to their employees, part-
ners and distributors. For the student there are
now a host of graduate and post-graduate pro-
grams available on the Net, offered primarily by
universities. Most schools in the US have some
component of access to Internet resources as
part of their education methodology.

In India, the cost effectiveness of online train-
ing, though accepted at the conceptual level by
organisations, has not found many takers. Only a
few progressive organisations are implementing
some pilot programs. While technology/infra-
structure is often cited as a reason for not imple-
menting, the more deep-rooted issues are cultural
acceptance and changes in mindsets. The rela-

tionship between the faculty and students has
been one of the most enduring ones from the
dawn of civilization, and will not change in a
hurry. At the student level, it remains, at best, a
matter of curiosity and at worst, a fad.

WWhheerree  ddoo  wwee  ggoo  ffrroomm  hheerree??
In the context of the dot com world crashing all
around us, belief in e-learning has so far weath-
ered the downturn. E-learning has the potential
to be the next killer application of the Net and in
the words of John Chambers, CEO of Cisco,
“…the scale of network traffic generated by 
e-learning, will make today’s exchange of e-mail
messages look like a rounding error”. But in
order to make this potential a reality, leaders of
organisations and educators must spearhead a
‘cultural revolution’ to put technology-based
learning in perspective. Most importantly, the
use of the Net for education does not mean the
end of the classroom.

Rather the classroom, the Net and the teacher
will have to restructure their roles in the learn-
ing process. Such changes have happened before,
but they take time. To take a very Indian analo-
gy, in ancient India the only format of education
was for the student to live with the master for
many years.

Through this extended interaction it was
believed that knowledge would pass on from
master to pupil. Imagine the consternation of
the guru if he were told that from the next year
his students would come to the classroom
(ashram) for a few hours a day only, and then
return home. Yet this classroom method has
been the only way that we, in our generation,
have experienced education! A similar inflection
point is now occurring as the Internet comes to
play a greater role in our lives.

The future of learning is e-learning. This is
true of all the segments: K-12, graduate educa-
tion, corporate training and continuing educa-
tion. As we move to a connected and networked
world, the Internet will become the primary tool
for learning, suitably supported by the classroom
and faculty.

30 July 2001

■■ ccoonnnneecctt~~ccoolluummnn

The future of online education
A resistance to change is the primary hurdle in the way of online 
education reaching its full potential in India

r. krishnan

Using the Net for
education does not

mean the end of the
classroom. Rather the
classroom, the Net and
the teacher will have to
restructure their roles in
the learing process

R. Krishnan is the COO, Content Services, Jasubhai
Digital Media. You can e-mail him at
r_krishnan@jasubhai.com



C
onvergence.You’ve heard it, I’ve heard it, and
it’s coming. Simply put, convergence is the
consolidation of a wide range of technolo-
gies and devices into a single, more open

device. Which means that you will be able to do
a lot more with any one device.

For example, Interactive TV merges the con-
venience of the Internet with regular television
and the cellular phone in your pocket acts as
your PDA and MP3 player. But what fascinates
me is the extremely rapid pace at which tech-
nology and entertainment are converging.

Next generation console systems are posi-
tioning themselves as general-purpose enter-
tainment devices rather than mere video game
machines. With home theatre functionality, USB
and FireWire (iLink) ports, expansion bays, and
online connectivity, these ‘toys’ are on an
inevitable collision course with home consumer
electronics. In fact, Sony is going out of its way
to re-christen the PS2 as a central hub for home
entertainment, facilitating all aspects of digital
entertainment from electronic gaming, home
audio/video, to Internet browsing and even dou-
bling up as a digital video recorder. Not bad for
a $300 game box, is it? 

Sony’s new alliances with America Online,
RealNetworks and Macromedia will bring the
PS2 one step closer to becoming a true Internet
Appliance with Web browsing, e-mail, stream-
ing media and instant messaging. I for one am
eagerly looking forward to this, as now I’ll be
able to beat the stuffing out of some PS2 user in
Quake and taunt him on Instant Messenger till
he either blocks me or logs off my Internet! 

Microsoft’s much-hyped Xbox is the first
game console to feature built-in broadband con-
nectivity and a beefy hard drive. Running a deriv-
ative of the Windows 2000 OS, the Xbox can
easily be mistaken for a high-end PC at a low-end
price. Remember the commotion when Netpli-
ance’s i-opener Internet Appliance was modified
to function as a Linux-based PC? I’m sure that
someone will figure out a way to unleash the true
potential from this Pentium powered box.

With Sega announcing that it plans to license
out the Dreamcast technology to consumer elec-
tronic manufacturers and VM Lab’s NUON pro-
viding 3D interactive graphics and audio to DVD
players, set-top boxes and digital satellite
receivers, single-function appliances will become
a thing of the past. Soon we won’t need to spend
money for each individual device since these new
age appliances will combine a host of functions.

Digital entertainment will finally become a
de facto part of every home, since the largest bar-
rier is the cost of these various technologies and
not their acceptance.

Another interesting parallel is that these game
boxes will soon provide a real threat to the dom-
inance of traditional beige boxes that sit on your
desk. The most widespread uses of Home PCs
are productivity applications, surfing the Internet
and using multimedia content. With Internet
connectivity, bucketloads of storage space, USB
ports and a $300 (approx Rs 15,000) price tag,
I’m sure that these over-the-top consoles will
soon be replacing the PC in many a home. Con-
venience is an important factor too. Gaming
machines will provide the perfect starting plat-
form for the technologically challenged. It does-
n’t take a genius to figure out how they
work—switch power on and put disk in drive.

As technologies for gaming consoles become
more and more PC-like, I believe that these
beefed-up game consoles are the best candidates
to fulfil the promise of convergence of PCs and
other home electronics!
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All for One and One for All
Gaming consoles are all set to be transformed from single-utility gaming
machines to multifunctional devices that will significantly blur the differ-
ences between themselves, the PC and home consumer electronics

vinit aggarwal

These ‘toys’ (next
generation console

systems) are on an
invevitable collision
course with home
consumer electonics  

Vinit Aggarwal (Editor, Computer Gaming World)
loves slapping anyone who calls gaming an indul-
gence for children. You can contact him at 
vinit_aggarwal@jasubhai.com
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VIDYARAMANAN S

C
irca 1970: An evening at the movies. Moth-
er dresses the kids for the outing and father
takes his car out. At the theatre, it’s fun time,
with popcorn and Amitabh Bachchan.

Cut to 2003: It’s movie time again. Father,
mother and kids get comfortable on the couch.
Mother switches on the home theatre system,
and at the same time logs on to the Internet. The
screen on the wall comes alive with Anjelina Jolie
as Lara Croft. Is this fantasy? No. It’s happening
and it’s happening now. Digital video is already
an established fact and now online relay or
streaming of movies is making its presence felt.

Video is going the same route as MP3 music,
and distribution of films over the Net is fast
catching on. Most Internet sports and news sites
stream video to attract viewers to their sites.

ESPN has been relaying live sports over the Net
and so has CNET, a news company that has a
store of news videos for you to choose from and
view. If you missed a particular news coverage
on the TV or on the Net, you could always go to
the archive and catch up on what you missed.

All this has been made possible through tech-
nologies such as Codecs (Compressor-Decom-
pressor) that crunch the size of movies so that
they can be rushed through the Internet across
the world.

FFrraammee  bbyy  ffrraammee
Digital video is measured in terms of number of
frames per second and by the size and the reso-
lution of these frames. The total size requirement
for video is huge, particularly if one wants NTSC
(National Television Standards Committee, of

First it was music,
and now it’s movies.
Digital technology is
all set to bring you
hassle-free video
from the Net to your
PC with crystal-clear
sound and picture

Let the SHOW begin

Photograph: Mexy Xevier, Imaging: Neeta Wadiker
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the US) video. A 640x480
image with 24 bits of data
representation for colour
and a frame rate of 30 per
second easily gulps down a
staggering 27 MB and
that’s without sound.
Streaming or downloading
such a video would be next
to impossible. This is
where compression comes
into action.

The digital media cur-
rently available such as
VCDs do not project good
quality images due to vari-
ations and drawbacks in
the existing digitisation
methods. Moreover, these
movies require greater
space and hence you would
need more than two to
three CDs for a single
movie. The current digital
video standard used by video coders in SVCD
(Super VCD) is MPEG-2. SVCD is midway
between DVD and VCDs. MPEG-2 does not
keep full copies of every frame of a video; it pre-
serves the details of only those frames where
there is a change. DVD does compensate with
higher precision, preserving frames for perfect
picture delivery and better sound effects. But the
cost of a DVD is higher and the amount of space
occupied by a DVD movie would be more (3.5
GB at a maximum). Thus, existing standards
have certain drawbacks, which lead to a need for
an improved technology, providing better pic-
ture quality, high-quality sound and a drastic
reduction in the size of the movie.

IItt’’ss  lliivvee!!
Streaming video has been around for quite some
time, and the video technologies till date range
from low-quality streaming audio with an occa-
sional picture to traditional download-and-play
systems for a variety of file formats. The issues
impeding the popularity of streaming video are
compression and bandwidth. About the latter,
nothing can be done unless technology improves
and low-cost, high-bandwidth services are
obtainable in the market. Compression is some-
thing that has seen improvement down the years.
Microsoft, Apple and RealNetworks are some of
the key players in the Internet streaming video
arena, and streaming of video over the Net is cur-
rently usually done with standard formats devel-
oped by these companies.

Streaming works on the principle of buffer-
and-deliver method. When the user clicks on a
video, the associated application is launched and
the video is buffered packet-by-packet on the

client side and relay starts
once enough packets have
been acquired from the
server. Thus, the user need
not wait for a full down-
load of the clip that he
wants to view. Streaming
has the advantage of live
relay and also store-and-
relay service over the Inter-
net. But the issue here is
one of quality—of picture
and sound.

With newer Codecs,
images would be sharper
and near-DVD quality. The
method and channel of dis-
tributing video and movies
will change if these tech-
nologies prove to be suc-
cessful in the market.

Already Apple is work-
ing on Darwin, a stream-
ing media server that will

allow you to start your own Internet broadcast-
ing company for news, entertainment and edu-
cational programmes. It’s built on the
industry-standard Internet protocols, RTP (Real-
Time Protocol) and RTSP (Real-Time Stream-
ing Protocol). This enables the
video-on-demand service by serving clients with
QuickTime movies of their choice. Companies
like Cisco and Sun are also taking part actively in
the streaming video market. Texas Instruments is
working on DLP or Digital Light Processing. It
claims that DLP Cinema has the ability to proj-
ect clearer, more realistic digital images than the
current generation of analog movie projectors.

It’s important to realise that the development
of these technologies will mean much more than
just developing a set of improved Codecs.

HHoonneeyy,,  II  sshhrruunnkk  tthhee  ffiillmmss  
DivX is the new kid on the block, changing the
way video will be delivered in the near future. It’s
a highly efficient video compression file format
adapted from Microsoft’s MPEG-4 Codec,
removing some of its limitations, such as its
inability to save files in AVI format. With DivX-
based encoding program, a full-length movie in
letterbox or full-screen format can be encoded
with near-DVD quality and saved onto a single
650 MB CD! The compression ratio is an
astounding 44:1 from AVI to DivX format.

This makes it the next step in compression
technology for video delivery on the Internet.
DivX uses the MP3 Codec for sound and hence
the sound quality of DivX movies is enhanced.

OOppeenn  SSeessaammee
At present, ripping a DVD is illegal, so is putting

A Codec, used for com-
pressing video files, is any
technology that can com-
press and decompress
data. Codecs can be imple-
mented in software, hard-
ware, or a combination of
both. An example of a
hardware Codec would be
the DVD decoder cards
that accompany many DVD
drives in place of such soft-
ware as Power DVD or
WinDVD. Codecs can sim-
ply be looked upon as
plug-ins to a system to
allow interpretation of a
type of file that the operat-
ing system cannot recog-
nise. For instance, if you
download a movie trailer
that has been encoded in
MPEG4 format using the
DivX Codec, you will need
the same Codec installed
to watch the trailer. For
more information on
Codecs and their function-
alities visit www.codecs.com

Most compression meth-
ods are either Lossy or Loss-
less. Lossy compression
doesn’t perfectly represent
what was compressed, but
it’s close enough given the
size savings. Lossless com-
pression guarantees that
what goes in at one end
comes out at the other end
and hence compression in
this case causes no loss in
quality. Lossless compres-
sion isn’t really a considera-
tion when dealing with
video over the Internet.
Compression always
involves a trade-off between
picture/sound qualities and
file size, with larger files
obviously resulting in longer
download times.

Compressing Data

DLP projectors from Texas Instruments



up a DivX-encoded movie on a Web site. They
are either available as one big chunk in one of
those free drive areas or available as 25 MB
chunks which could be downloaded and com-
bined to frame a full-length movie. But this is
likely to change soon. Jerome Rota, a 27-year-
old Frenchman, the mind behind DivX, is
preparing to release a complete, legal version of
the video and audio encoding technology that
does not require the use of Microsoft’s MPEG-4
Codec. You would then be able to download
movies from the Internet, if they are released
legally over the Net.

Another project that is working towards an
open standard version of the complicated com-
pression technology—OpenDivX, is Mayo.
Mayo believes that there has to be an open stan-
dard that’s independent of any existent technol-
ogy and this has resulted in OpenDivX. DivX
Deux was released as OpenDivX on January 15,
2001. This is an open standard, so anyone inter-
ested in DivX can register, have a peek at the
code, analyse it and submit suggestions for the
enhancement of the project.

According to the developers at Project Mayo,
“The Project Mayo vision is a world of standard
video technologies that deliver mind-blowing,

stunning visual quality, and a wide set of
tools and applications on a variety of plat-
forms...”

Stux, the brain behind the DivX play-
er for Mac, and his team are working on
a new DivX Codec called 3ivX. The team
claims that their Codec is going to be a

fully open source Codec and will be optimised,
so that the file size is considerably reduced with
no compromise on quality. But the most impor-
tant part of the 3ivX is that it will be fully
streamable. As DivX is not streamable in its pres-
ent state, 3ivX would surely gain popularity.

3ivX targets wired and wireless markets such
as movie distribution, set-top-boxes, video-on-
demand, video conferencing, Internet TV, in-
flight entertainment, game consoles, etc. Besides,
3ivX is multi-platform, so the same file can be
viewed on all OSes. The team also claims that
services like Digital Rights Management,
encryption, and payment systems are all possi-
ble. This would in a way aid the movie industry
to choose the appropriate digital wagon to dis-
tribute movies on a pay-per-view basis.

HHoolldd  tthhee  ppooppccoorrnn  yyeett!!
Download movies? Sounds great, except for one
thing. Is your connection up to it? Bandwidth is
the main issue as far as downloading movies
from the Web is concerned. For a mere 1 MB
mail over a dial-up connection the average user
keeps his fingers crossed. So you can imagine
what will happen if you try downloading a DivX
movie. At least for now, DivX movies are meant
for users who use ISDN, cable or T1 lines.

Besides, all said and done, one simply cannot
ignore the issue of copyright and other legalities
involved with downloading DivX. Hollywood is
facing the same issues plaguing the music indus-
try and it’s facing them sooner than it expected.
The software program that is turning out to be
the source of Hollywood’s digital headache is
DivX. The movie industry is waging an aggres-
sive legal battle to protect its copyrights. The
Motion Picture Association of America (MPAA)
recently joined hands with the recording 

July 2001

■■ ccoonnnneecctt~~tteecchhnnoollooggyy  nneexxtt

38

RealSystem iQ by RealNet-
works points to the future of
media delivered via the
Internet. It is preparing itself
for a future when video-on-
demand, gaming networks,
and broadcasting to wireless
devices become common-
place. RealSystem iQ uses a
distributed architecture that
can deliver digital media-to-
media networks and even
consumer devices beyond
the PC. For more informa-
tion on RealSystem iQ, you
can log on to www.real.com.

Active Streaming Format
(ASF) is Microsoft’s offering
to the streaming media
world. ASF files can be
played locally, over the net-
work or over the Internet
while maintaining the quali-
ty of the picture and/or
sound. The small size of ASF
files lends itself easily to
medium quality video clips
being transported over long
distances. Microsoft has also
released Windows Media 8,
which can be used for
streaming as well as for
downloads. It has a com-
pression efficiency of an
additional 30 per cent over
Windows Media 7 and offers
near-VHS quality at 250
Kbps, and near-DVD quality
at 500 Kbps. Windows
Media 8 comes with Digital
Rights Management, which
can be a form of succour to
the movie industry plagued
with rampant piracy.

What’s Cooking? Streaming it Thru

Streaming technology enables you to watch a video while it downloads. This means that you need
not download the full movie to see it, which is a great relief for the low-bandwidth users. Streaming
is done as shown in the figure. First the movie frames that are to be relayed are created and they
are put on a server for digitisation and compression. This process could be called encoding or just
compression. The compressed movie is sent to the media server which acts as the base, from which
the user requests movie clips for viewing. The streaming audio and video could be relayed as and
when requested or it could be a live relay. For the live relay, the media server and the compression
at the encoding server has to be extremely fast, so that the user finds no delay in frame relay

A clip from the sports site of ESPN, which
allows the user to pick the connection speed
so that he can view the highlights or the full
video of a particular series or game

Infographics: Jaya Shetty
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industry to sue Scour, whose online file-sharing
service is similar to the ‘music bazaar’ offered by
Napster. While the studios fight in court over
online distribution of movies, they are support-
ing the creation of technology that provides for
secure transmission of video over the Internet.

SightSound technologies is a company that
provides for video and audio download and file-
sharing supporting the motion picture and
music industries as they adopt digital distribu-
tion. This year, the company demonstrated the
first Internet-based movie download system for
distribution in theatres.

This revolutionary technology model gives
people the choice of selecting between enter-
tainment from the digital platform and other
conventional means. SightSound offers short
films for rent or sale on its Web site, depending
on the kind of transaction that you have with
the company. For rentals you could view the
movie as many times as possible during the rent-
ed and allotted time slot. The Pennsylvania
Company encrypts the files, and then sells elec-
tronic keys that unlock the file once for a rental
or permanently for a purchase.

FFiinnaall  ttaakkee
Because digital compression technology is
improving all the time and making it possible
for great quality video to be distributed easily

over the Internet, movie distribution companies
are looking to use this medium to offer content
to you. However, you can already see the begin-
ning of a Napster-like situation where illegal
download of movies off the Net will increase the
rate of adoption of digital movie formats by con-
sumers. This will force the hand of the distribu-
tors, as their revenues are likely to be affected.
Irrespective of who comes out on top at the end,
what’s inescapable is that movies on your PC,
and via the Internet are coming, whether or not
the industry is ready for it. The only thing that
is stopping anyone (consumers or movie com-
panies) right now is the availability of the
required bandwidth. Cutting-edge compression
technologies and high-speed Internet access are
poised to remove that last obstacle.

DivX is the brandname con-
ferred on high-quality video
compression technology.
But there are different nam-
ing standards that you might
come across such as DivX,
DivX ;-), and OpenDivX. To a
certain extent their funda-
mental idea is the same.
They are all part of the DivX
family. The difference in ver-
sion is what introduces
changes in the name. 

DivX ;-) is  version 3.11
of DivX and OpenDivX is ver-
sion 4.0. The latter is not a
backward compatible ver-
sion, which means that it
will not be able to play ver-
sion 3.x rips. Formats pro-
duced by these different
versions are not the same.
OpenDivX would be packed
with new features and it
would be multi-platform. 

The Game
behind the Name

www.microsoft.com/windows/
windowsmedia/en/WM8/default.asp
For more information on Windows Media 8
www.realnetworks.com
Learn about RealSystem iQ
www.3ivx.com
Know how DivX ;-) is used for streaming
www.sightsound.com
All about Digital Rights Management
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ANIL PATRICK R.

W
hat could be more satisfying for a gaming
fanatic than starting off each day with a
round of Unreal Tournament and wiping
the last grains of sleep from his eyes by

blasting the living daylights out of some unsus-
pecting fellow online gamer? 

Well, how about holding the power to play by
your own rules and getting others to follow them
as well? True paradise is being able to build your
own game. The one thing more satisfying than
being able to kill that vicious monster in the final
boss level of a game, is knowing that you created
him! Could things get any sweeter? You better
believe it! Because it always helps if the game you

churned out also rakes in the money for you! And
if nothing, then the adulation of the gaming
community, or the chance to be the next ‘John
Carmack’ should draw you into the gaming
arena. Did we get your attention?

We’re talking professional game development
here. No child’s play this. This is a highly compet-
itive field and only the best survive. And to the
victors go the spoils. But it’s not all fun and games.

DDoo  yyoouu  hhaavvee  iitt  iinn  yyoouu??
While there are many kinds of job options in the
gaming industry such as for designers, program-
mers, play testers, producers, sound and music
specialists, writers, etc, it isn’t exactly a cakewalk

Developing your own
game may take
longer than the
creation of the world,
but the thrill remains

Photograph: Rahul Sharma, Imaging: Ram
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to get a foothold in the industry. To get into the
arena you must have at least a year of experience
to grasp the graphics and programming require-
ments. The entry-level requirements for a fresh-
er are much higher than in most other
programming professions. And it takes a lot of
hard work.

The gaming industry is a dog-eat-dog world,
especially in India where it is still in a fledgling
state. So if you have any illusions of having a
pleasant time with a 9 to 5 schedule where all you
do is play games, now’s the time to drop out! The
real picture includes some 50-hour or more
working weeks, very tight deadlines, and even
tighter competition. The game development cycle
can take months, sometimes even years as in the
case of complex 3D games such as Quake III.

Well, so much for the hair-raising part. Now
for the good news. The gaming industry pro-
vides, in most cases, flexible
working hours, informal
working conditions and
good pay. If that’s not
enough, the thrill of seeing
your game gaining popu-
larity in the market is the
ultimate ecstasy that any
gaming geek can ever wish
for! 

TThhee  ssttaarrttiinngg  bblloocckkss
The most essential require-
ment for any aspiring
entrant into the world of
game development is a
burning passion and love for games. You need
to have an in-depth knowledge of how games
work, which can be attained only through play-
ing games. Critical appreciation and insights
into the game through close observation are the
key here. How does the game operate? What
makes it appealing? What are the goals—the dif-
ferent win-and-lose situations?

For instance, consider a game such as Quake.
Here the focus is on being constantly alert and
on the move, gaining attributes such as health,
weapons, etc. Observing the manner in which
your opponent behaves gives you an idea of how
artificial intelligence (AI) is used in the game.
Look at the graphics employed in the game—
how is the visual effect going to enhance the
experience? How does the game respond to the
entire chemistry (or rather Physics) of inputs
from the mouse, keyboard, joystick, etc? 

Check out the graphics, the animation being
used, how the background music improves the
feel of the gameplay. Think about how you
would improve the game if you got the chance.
Try to understand the experience that the devel-
opers tried to incorporate into the game.

But be warned—dropping out of school to

study gaming on a full-time basis is not an
option that you would want to consider. The
game industry does not exactly encourage
dropouts. A BE or a BTech in Computer Science
would go a long way in helping you land that
first job, especially in programming. Make sure
that you have a sound educational background
that is relevant to the area of the gaming indus-
try that you want to enter.

BByy  ddeessiiggnn
If the labyrinths and arenas that make Unreal
Tournament such an out-of-the-world sight and
the cool graphics is what blows your mind, and
you are simply itching to put your own vision into
effect, then design is where you should be headed.

Though the term ‘designer’ is widely used,
there is no such thing as a game designer. The
term is loosely used to define a whole lot of jobs

related to designing games, such as lead
designer, concept artist, level designer,
texture artist, skin artist, modeller, ani-

mator, and computer game cinematic animator.
You need some basic things in your satchel

before you set off on the path to becoming a
game designer. First of all, get well acquainted
with design software such as Director, 3D Studio
Max, Maya, Photoshop, Flash, Illustrator, Light-
wave, etc.

Director is very useful if you want to design
2D and 3D games (with Director 8.5), and
comes with the Lingo scripting. Almost all 3D
games such as Quake, Doom, etc have 3D mod-
els that usually make use of software packages
such as 3D Studio Max and Maya. Illustrator
proves handy when it comes to character ani-
mation. There are a whole host of free software
tools that you can download from the Net and
work on towards level designing . This is the best
way to learn how to build your own game as well
as learn the ropes.

Although you don’t really need a degree in
fine arts to make the grade as a designer, it is
imperative that you have good drawing skills
since designers are often required to make con-
cept sketches.

It doesn’t end there. A good understanding
of Physics (how else are you going to animate
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Developing a game calls for
a whole lot of effort and
time from several people.
These are the experts who
make a game possible.
Here’s a look at what it
takes to be one of them. 
Artist/animator: The peo-
ple who make all those
breath-taking environs and
animations in a game. You
need creativity and good
drawing skills and familiarity
with various 2D- and 3D-
rendering software. 
Designer: The folks who
give the game its groove
with the skills of an artis
and a basic knowledge of
programming fundamentals. 
Programmer: The people
who make the games tick.
You need to be self-direct-
ed, have excellent knowl-
edge of mathematics,
trigonometry and physics, in
addition to excellent pro-
gramming skills.
Producer: The head hon-
cho, he takes care of the
organisation part. Producers
are usually programmers or
lead artists or have moved
up the ranks from quality
assurance.  
Game tester: They run a
game through its paces by
rigorous testing. Long atten-
tion span, ability to commu-
nicate efficiently, and good
memory are a must. 
Music composer/sound
engineer: The magicians
behind the stunning theme
music and sound effects.
The music composer writes
music keeping the charac-
ter and situation in mind
and should be a profes-
sional.
Concept writer: Every game
has its own story, which is
crafted by the concept
writer. To be one, you need
to have good communica-
tion skills, and understand-
ing of how games work.

The Game Architects

Programming games is
not like standard program-
ming. A game programmer
requires more logic, even a
lot of creativity”
NNiitteesshh  WWaaddeekkaarr
Project Manager, Indiagames.com

➜
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the guy falling off a castle?) and human anato-
my (so you can get all of Lara Croft’s curves in
the right places!) will add to your proficiency as
a designer. So will a fundamental knowledge (at
least) of programming aspects. You need to
understand the technical aspects of the platform
for which your game is being designed. Only
then would you be able to create models effective
enough for your system to support. For instance,
when a game is designed to run on a system with
an 8 MB graphics card, as a designer, you need
to keep the hardware constraints in mind. If you
churn out graphics that require higher capabil-
ities than what the card can provide, the game is
bound to mess up.

PPrrooggrraammmmeedd  ttoo  wwoorrkk  rriigghhtt
The importance of designing aside, the real
magic lies in interweaving all those graphic
objects into a game. This is where the program-
mer steps in.

The programming field also involves several
levels—the lead programmer, 3D programmer,
gameplay programmer and the network pro-
grammer. How can one get
into one of these jobs, you
ask? A true and undiluted
love for gaming, coupled
with some sound program-
ming knowledge will take
you there.

As a beginner, you need,
first of all, a good knowl-
edge of OOPs fundamen-
tals. You need to have an
in-depth understanding of
languages such as C and
C++ if you want to develop
a 3D game in particular.
Learning the ins and outs of
Windows programming with tools such as Visu-
al C++ is also very useful. And if you can get the
grasp of assembly language, nothing like it.

A good grasp of the fundamentals of embed-
ded C++ is essential for developing games for
Pocket PCs and Java-based development tools
for the Palm OS. Developing games for mobile
phones calls for an understanding of WAP tech-
nology. A thorough knowledge of Flash or
Director helps if you have a penchant for online
games. Other tools that can be used are
JavaScript, ASP, VBScript, etc. Oh, and did we
mention a good understanding of scripting for
game engines such as the A4, Quake or Unreal
Tournament engine? 

However, merely being good with C or C++
is not going to get you anywhere. You have to
know the tools you use in and out as well as the
platform for which your game is being designed.
Other than the quintessential tools, you also
need sufficient knowledge of mathematics,

physics, computer architecture, AI and expert
systems and networks. Knowledge of DirectX
and OpenGL is also necessary. Knowledge of
graphics-related aspects such as using colour
palettes, image optimisation, etc is always a plus
point for a programmer.You also need to under-
stand aspects such as porting which, put simply,
involves getting a game designed for Windows
to also work in Linux.

Before you take the plunge though, it always
helps to gain some professional insight. Meet
Nitesh Wadekar, Project Manager, Indi-
agames.com who started his career as a Web pro-
grammer, then went on to multimedia
programming and finally game programming.
Says Nitesh, “Programming games is not like
standard programming. A game programmer
requires more logic, even a lot of creativity. Even
an excellent Java programmer cannot get into
game programming unless he has that special
something in him.”

RRoolllliinngg  oouutt  yyoouurr  oowwnn  ggaammee
So you’ve mastered the tools required. Now

what? The best way to get noticed by
the industry is to develop your own
game. “It is always best to try develop-

ing a simple 2D game using sprites (cells in an
animation) at first. This will help you out in
understanding and getting the basics of game
programming right,” says Vinay P. Namboodiri,
who works at the National Centre for Software
Engineering’s (NCST) graphics department.

You can start off with simple 2D games such
as Hangman, Tic-Tac-Toe or Tetris in C, C++ or
some other language, rather than a full-fledged
3D game. You can even use Director for games
with a presentable level of graphics. Be careful
not to overdo the graphical elements as it tends
to make the game slow and also, this is your
first step buddy! A demo with just one level is
more than enough to showcase your talent.
Make sure that the game you’re working on is
the kind that you like to play so you can do full
justice to it.

Now comes the time to test your creation.
Get some of your friends and people you know
to play it. Their feedback will be very useful in

The Indian gaming develop-
ment industry is still a niche
industry, though rapid
inroads are being made.
Some of the pioneers in the
field are Indiagames, Dhruva
Interactive, and Vbeing. You
also have online game offer-
ings from Nazaragames.
com, Contests2win.com
and Gamesmasti.com.
Dhruva Interactive: Devel-
opers of the 3D technology
demo titled Saloon, and the
game Mission: Impossible,
Dhruva Interactive develops
games for overseas clients. 
Address: Dhruva Interactive,
946, 12th Main, 5th Cross,
HAL 2nd Stage, Indiranagar,
Bangalore 560 008. 
Phone: 080-5267091 
E-mail: info@dhruva.com
Web site: www.dhruva.com
Indiagames.com: The
developers of India’s first 3D
shooting game titled Yod-
dha – The Warrior, Indi-
agames develops games for
the Internet, CD-ROMs,
touch screen kiosks, gaming
consoles, etc. 
Address: Indiagames.com
Ltd, 4A, Diamond House,
35th Road, Off Linking Road,
Bandra (West), Mumbai -
400 050.
Phone: 022-649 6712/3
E-mail:
jobs@indiagames.com
Web site: www.indi-
agames.com
Vbeing Software: Having
started out as a company to
provide customised soft-
ware solutions for e-com-
merce, Vbeing has branched
out into game development
as well. 
Address: Vbeing Software
Limited, G-29, Lajpat Nagar
III, New Delhi.
Phone: 011-6821329 
E-mail:
develop@vbeing.com
Web site: www.vbeing.com

The Indian Gaming
Industry

It is always best to try
developing a simple 2D
game. This will help you
get the basics of game 
programming right
VViinnaayy  PP..  NNaammbbooooddiirrii
Graphics Department, NCSE
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improving the game. However, don’t show it to too many people as
this may confuse you about the quality of your game.

If you’re into graphics, you can even design game levels, or if
you prefer modelling try designing 3D models that can be show-
cased on your Web site or sent on a CD to the company you want
to entice. Another popular course is to make maps and mods for
games such as Quake, Half-Life and Unreal Tournament to gain an
understanding of aspects such as level design, texture design and
3D-modelling techniques.

BBrreeaakkiinngg  ffrreeee
How do you go about establishing contacts and making forays into
the gaming world? Here’s what you need to do. Keep yourself
updated with the latest trends in game development and upgrade
your skills by downloading the various freeware tools from the
Internet and by reading books. You can compile your game and
send it to gaming companies on a CD or put it up on your person-
al Web site, if you have one, so that companies can check out your
game.

When sending across your resume, remember that nothing
speaks louder than experience. Companies like to look at the work
you’ve done—the game(s) or levels you’ve developed. Customise
your resume after doing some background research on the com-
pany. This will help you prepare your resume according to their
requirements and area of expertise. Showcase skills such as com-
munication and management abilities, etc, since they count a lot in
this industry.

The most common path that aspirants take is to start their career
as a play tester. This not only gives you a toehold in the industry but
also gives you an opportunity to understand how the industry oper-
ates, as well as develop more contacts in the gaming arena. Contacts
are a major driving force in your game development career. Make
sure you have the right contacts if you want to succeed.

TThhee  ooppppoorrttuunniittiieess
While the future of the gaming development industry in India may
look bleak at present, there are opportunities coming up in the near
future. Already, gaming for handhelds and mobile phones is becom-
ing quite popular. So, if you hold the dream within you, keep it
burning as by the time you acquire all the necessary skill sets, this
industry is going to be ready with enough opportunities.

If you have visions of making it really big in game development
overseas, then the UK is the place to head for. The UK is the hub of
the gaming industry with almost all gaming majors having a pres-
ence there. Even Australia and New Zealand are picking up as off-
shore development centres, and therefore, you get a wider scope to
create some serious waves in the gaming industry.

Considering that we have some of the best and most cost-
efficient programming
manpower available,
game developers from
other countries may
consider it worthwhile
to outsource the job to
Indian companies. Make
the right moves, and in
a couple of years you
could be employed as a
full-fledged game devel-
oper right here in apna
Bharat.

www.gamasutra.com
Check it out for comprehensive pro-
gramming resources
www.gamedev.net
This is yet another useful site for
aspiring programmers
www.dperry.com
A thorough guide for game develop-
ing aspirants 

1/2 page V. AD
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W
ant some work done from a government
office? You know the drill. Hundreds and
thousands of poor souls are standing out-
side the Indian public distribution service

department or the local tehsildar’s office at this
very moment, to apply for a ration card or a house
loan or a license to start a new business. They all
know the drill.

First, you stand in a mile-long queue. Be pre-
pared for a long wait, because your work will
never get done on time. Then let your file do
endless rounds of the same office, or grease the
palms of some slimy middlemen just to get to
the officer concerned. Tired of this delay-n-

corruption? Feeling irritated? Helpless? Frus-
trated? Well, don’t start tearing your hair in
despair, there is hope yet. Hope in the form of a
concept called e-governance.

EEnntteerr  tthhee  ee--aaggee
E-governance basically means governance
enabled by information technology. The admin-
istrative process is a tedious one and involves
various levels of interaction between people and
the governing body.

To face the challenge of managing this inter-
action effectively, the government is taking the
help of information technology. E-governance
will allow you to electronically file your 

E-governance
promises to fulfil the
dream every Indian
dreams of—a
progressive country 

Digital Democracy

■■ ccoonnnneecctt~~wwiiddee  aannggllee



applications, get information online about the sta-
tus of applications, obtain other general informa-
tion about any government department, deposit
state levies and taxes and even file your returns
electronically. Under ideal conditions, citizens will
be able to undetake basic tasks or gather infor-
mation such as application status for a passport,
filling in provident fund forms, etc, without ever
having to visit any government office.

Provision of such information through 
e-governance will reduce one step in the chain
of activities, thereby doing away with a bit of the
red tapism normally associated with government
services. And because most transactions that
occur can be monitored easily  through reports

that will be automatically generated from a data-
base, there is greater likelihood of transparency
in the administrative system.

TThhee  ee--nniittiiaattiivvee    
Keeping in mind the benefits of e-governance,
the Ministry of Information Technology has
declared 2001 the year of e-governance and is
encouraging the state governments to work
towards this. Training programmes on IT appli-
cations and e-governance are being held in many
states for employees in government institutions.

The passage of the IT Act, 2000, is another
step in promoting e-governance. The Act gives
legal recognition to electronic documents and
digital signatures and allows government records
to be kept in electronic form. It even permits
applications and forms to be filled up.

These processeses are another step towards
decentralisation—important for any meaning-
ful decision-making process. Planning in four
important sectors—services, environment,
industry and agriculture—will be decentralised
through active participation from people.

CChhaalllleennggeess  aahheeaadd
The greatest impact of e-governance will
undoubtedly be felt in rural areas, where the bulk
of our citizens reside. Herein lies a challenge as
well as an opportunity for the government.

Due to the extremely low level of penetration
of IT in the Indian society, the government will
face cultural and attitudinal barriers not just
from the masses but from employees as well.
Communication barriers will also have to be
overcome. It is unlikely that the layman in rural
India will understand any other language besides
his own mother tongue. So, multilingual 

software packages with user-friendly interfaces
are being developed that can work across plat-
forms and be used in different states. A start has
been made and it is heartening. Here are two
examples of how e-governance is bringing a new
wave of change across the countryside.

CCaassee  II::  DDhhaarr——tthhee  mmeesssseennggeerr  ooff  kknnoowwlleeddggee
The Dhar district in Madhya Pradesh has used e-
governance in an exemplary manner. Their proj-
ect, called Gyandoot, has been envisaged to cater
to the social, economic and developmental needs
of the villagers through an innovative G2C (gov-
ernment to citizen) model. Gyandoot is basical-
ly an intranet connecting rural cybercafes and

49

Andhra Pradesh claims to be
on the fast-track towards the
digital age with chief minis-
ter Chandrababu Naidu
championing the cause of
providing IT for the masses.
Apswan: Network for voice,
data and video communica-
tion throughout Andhra
Pradesh. Operational with 2
Mbps fibre optic links and
scalable up to more than
600 Mbps, connecting the
State Secretariat with 25
centres. 
Card Project: Manual sys-
tem of registering and pre-
serving documents of
immovable property trans-
actions replaced by a simple
and transparent system. 
Fully Automated Services
of Transport: Provides serv-
ices such as issuing learner’s
licenses, driving licenses
and registration of vehicles
through a comprehensive,
networked solution. 
Secretariat Knowledge
Information Management
System: Generic product
that efficiently manages
information and knowledge
at the Secretariat. 
Andhra Pradesh Develop-
ment Monitoring System: A
system that helps in
research, analysis, project
design and monitoring of
state projects.

AP is putting efforts not
only into transforming gov-
ernment activities into e-
mode, but is also giving a
secured environment to the
IT market—from production
and trading companies to
educational institutions and
consultancies. Keeping future
investment in view, AP has
established a new technolo-
gy park named Hi-Tech City.
It has its own power supply
and broadband telephone
lines for faster Internet com-
munication.

Andhra Pradesh: 
Digital State

—it works!

Illustrations: Ram
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It is the financial capital of
the country, but in recent
times, some technological
innovations have been hap-
pening. 
Registration of New Vehi-
cles, Issue of Licenses, Tax
Collections and Defaulter
Prosecutions: Developed
for the Motor Vehicle
Department of Maharashtra.
Stamps and Registration
Project: Clearing backlogs.
Department staff trained for
software. Plans to integrate
all 300 offices in a phased
manner. 
Department of Irrigation: A
comprehensive MIS for the
Department of Irrigation,
Government of Maharashtra. 
Integrated Information
System for the Sales Tax
Department: The system is
designed to facilitate elec-
tronic business such as elec-
tronic filing of returns and
payment of taxes. Most
application forms will be
available on the Web, which
can be downloaded and
used.

These projects are just
some of the initiatives taken
by the government, and the
administration has met with
success in its ventures. 

The state has given IT
top priority and that is evi-
dent in the International
Infotech Park set up at
Vashi, Navi Mumbai. Besides
this, the government is also
keen on setting up a Millen-
nium business park. 

Maharashtra State Road
Development Corporation
(MSRDC) has helped to lay
telecom ducts with fibre
optic capacity for various
prospective users.

information kiosks, called soochnalayas, catering
to the everyday needs of the people, whether they
are related to commerce, education or health.

According to Rajesh Rajora, Collector, Dhar
District,“We started off with e-governance serv-
ices in the quest to bridge the digital divide. The
network has shown outstanding results, with
more than 55,000 users in the last 18 months.
One out of two users belong to the Below Pover-
ty Line families, one out of three users belong to
the SC and ST category and one of seven users
are illiterate! The network has empowered the
disempowered.”

Its innovative use of the administrative sys-
tem and functioning has won Gyandoot the
Stockholm Challenge IT Award 2000 in June last
year. Gyandoot was declared winner in the ‘Pub-
lic Service and Democracy’ category out of 109
IT projects from all over the world. It was also
awarded the CSI-TCS National IT Award for
best IT usage, instituted by the Computer Soci-
ety of India, for the year 2000.

BBeehhiinndd  tthhee  sscceenneess
The entire expenditure
for the Gyandoot net-
work has been borne
by the village panchay-
ats and private entre-
preneurs. The total
initial cost was Rs 25
lakh, with additional
investment from pri-
vate parties for expan-
sion of the project. The
average cost incurred
in establishing a single
kiosk was Rs 75,000.

The kiosks have
dial-up connectivity through local exchanges
on optical fibre or UHF links. As of now, the sys-
tem is hosted on a Pentium III Remote Access
Server (RAS) located in a computer room of the
zilla panchayat and connected to all the
soochnalayas. Keeping in view the widespread
power cuts in rural areas, the soochanalayas have
been equipped with UPS systems that can run
the computer and printer for four hours at a
stretch without power.

Out of 34 soochanalayas, 25 already have
optical fibre connectivity. And by the end of
June 2001, the remaining would also be con-
nected through optical fibre lines.“We have gone
into Wireless in Local Loop technology devel-
oped by corDECT/TeNet in IIT Chennai,” says
Rajora. “This state-of-the-art technology pro-
vides 70 Kbps bandwidth along with wireless
telephony. Phase I of the technology has already
been introduced,” he adds.

A simple menu-driven Hindi software is
used in the machines, which requires minimum

data entry at the client end. Gyandoot Samiti, a
registered society, supports the project to run
the intranet and various services. Local people
manage the soochnalayas, so this not only gen-
erates employment, but they are also able to
handle and resolve queries faster, through their
understanding of the local processes.

CCaassee  IIII:: LLaanndd  iinn  mmyy  hhaanndd
Just about a year ago, Karnataka’s farmers faced
the delay-n-corruption drill if they wanted to
procure the record of rights and tenancy and
cultivation certificate (RTC). Now, the state
government’s initiative to computerise land
records under the Bhoomi scheme and issue
printed RTCs has come like a boon for them.

The details of all land records can be
obtained from one of the 40 touch-screen
kiosks installed at the various taluka offices in
Karnataka, at the cost of a mere Rs 15. The state
has some 6.7 million farmers and 17 million
land records spread over 30,000 villages, and is

spending a hefty amount to digitise all the 
documents.

Rajeev Chawla, the additional secretary (Rev-
enue) of the Government of Karnataka vouches
for the success of this scheme. “The success rate
of the e-governance implementation is such that
the Government of India has requested the entire
team behind the e-governance initiative to visit
other states and try helping them replicate this
model so that the concept of e-governance catch-
es up in as many states as possible,” he says.

TTrraaddiinngg  tthhee  oolldd  ffoorr  tthhee  nneeww
The land record computerisation software, called
Bhoomi, has been designed by NIC, Bangalore.
The initial data entry is done at the taluka level
through private data entry agencies. After that,
printouts are taken, which are validated by com-
paring them to the original land records books.
After this correction, the data is ported onto
Bhoomi.

This software incorporates online updating
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Maharashtra: 
Economic Powerhouse

The success rate of the e-gov-
ernance implementation is such
that the Government of India has
requested the entire team
behind the e-governance initia-
tive to visit other states and try
helping them replicate this
model
RRaajjeeeevv  CChhaawwllaa
Additional Secretary (Revenue), Govt. of Karnataka



to ensure that the RTCs provided to the farmers
are up-to-date. It also allows printing of land
records as and when required. All changes to the
land records database are done on the comput-
er itself, to ensure that data on the computer
remain current with time.

The Bhoomi software also has the provision
of scanning original change orders of the rev-
enue inspectors (the persons authorised to pass
orders for adding or removing markings in land
records) and the notices served on interested
parties. Both documents are scanned. This
ensures that in the future the responsibility can
be fixed on the revenue inspector by showing the
original documents signed by him, and also
ensures that the interested parties cannot claim
in the court that they were not served with the
notice before the mutation.

The software incorporates a state-of-the-art
bio-logon metrics system from Compaq, which
authenticates various users on the Bhoomi soft-
ware on the basis of their fingerprint. This also
adds an additional security aspect to the whole
process.

The other useful aspect of Bhoomi is that it
enables administrators to generate various
reports on the types of soil, the number of
landowners owning land above a certain aver-
age, type of crops grown in a taluka, etc. This
information enables administrators to take
informed decisions for policy-making.

TThhee  lloooopphhoolleess
But everything isn’t quite rosy. Presently, steps in
e-governance are based on the initiatives of cer-
tain government officers or state governments.
The Central government is yet to talk of e-gov-
ernance at the highest level. Worse, implementa-
tion suffers due to the lack of a unified body to
monitor the whole process, and ensure that
everyone is moving in the right direction. This
is not surprising because seriously implementing
e-governance calls for restructuring procedures
as well as doing away with the existing system.

Again, even with computerisation in place, the
success of e-governance still depends on people.
True, you might not have to wait in a queue just
to get a form, but the processing of the form still
passes through the very same people who are in
their present day seats. As Rajora says, “E-gover-
nance can be no replacement for good gover-
nance. For a successful e-governance project,
technology plays only 15 per cent of the role, while
management of the project plays 85 per cent of
the role!” If management is in the hands of a few
political, commercial and other elite groups, and
they use this power to suit their purposes, e-gov-
ernance will hardly benefit the common man.

Though there might be considerable enthu-
siasm at the individual level, driven by forward-
looking individuals, things will not move in the
right direction till the authorities take it upon
themselves to implement it right.
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The Karnataka government
has been taking some steps
in the e-governance direc-
tion. We present details of
some of the initiatives. 
Small Scale Industries
The state has computerised
the permanent registration
of over 2.5 lakh small-scale
industries. All the districts as
well as 26 taluka industry
centres have been com-
pletely computerised. 
Zero-piracy territory
Karnataka has become the
only state in the country and
the first in the Asia-Pacific
region to adopt a systematic
approach to combat soft-
ware piracy. 
Police IT 2000
The police department is
already computerised to a
large extent and has an
ambitious project to
enhance the capabilities of
the intelligence wing.

At present, computers
are used in several depart-
ments and such initiatives
are taken in a decentralised
manner. The government
also proposes to establish a
Centre for E-governance
under the Department of
Information Technology. This
is likely to further fuel the
process of IT adoption in the
governance of the state.

Karnataka: 
India’s Silicon Valley

The Gyandoot project (www.gyandoot.net)
has really helped the villagers of MP’s tribal hin-
terland in making their lives simpler and by
benefiting them economically. Here are a few of
the success stories that abound.
The house that Gyandoot built     
On June 21, 2000, Kamalabai, a poor tribal lady
from Dantoli village of Sardarpur development
block, complained through a kiosk that the
entire sanctioned amount through the Indira
housing scheme had not been disbursed to her.
At that stage, her cottage was half built and the
rainy season was looming large. 

Merely seven days after her complaint had
been sent, an officer came for ground verifica-
tion and completion of all other formalities. The
sarpanch then gave her the remaining amount
and she was able to complete her home before
the rains began.
Bride through kiosk 
Mohanlal and Suraj Khati of Bagdi village are
two unmarried young men. They came to know
about the ‘online matrimonial’ facility available

at soochnalayas. 
They came independently to the

soochanalayas and registered themselves to
scan the available data of young women for a
bride of their choice. Imagine their joy when
each found the girl of his dreams. The hitch?
Both of them liked the same girl from Dhar.
Now, both are competing to reach out to the
girl’s parents. Kaun banega pati?
Online transaction? Sure!
A cow for Rs 3,000. This is the first real e-com-
merce transaction in the rural area of the tribal
district. Kalsingh of Mirjapur village wanted to
sell his cow. He registered at the soochanalaya
of nearby Gunavad village to put up his offer of
the animal online. He received four trade
enquiries on his account and he finally sold his
cow to the highest bidder, Premnarayan of
Dilawara village. The auction facility of the
Gyandoot enables trading of commodities like
milch animals, cultivable land, tractors, agricul-
tural tools, etc, creating a virtual marketplace to
benefit villagers.

How Digital Technology went to the Countryside
SUCCESS STORIES 



July 2001

■■ ccoonnnneecctt~~nneettrreettuurrnn

54

NILESH KAKADE

F
rom hardbound editions to paperbacks,
we’ve seen them all. From roadside book-
stalls to the huge shopping malls, we’ve come
across books varying in shapes and sizes, not

to mention a wild assortment of topics.
So, do we say exit paper and enter eBooks?

It’s the digital age after all. Why trudge all the
way to your local library when you can get the
book you want right at home, with the click of a
button? Why bother rushing through the daily
news when you can read it at leisure in the online
newsletter that’s delivered to your office inbox
everyday?

That’s the power that the Internet has grant-
ed us.

‘Computers and the Web will change the way
we access information and revolutionise our
lives’—truer words were never spoken! Access to
information has become speedier and more user
friendly. From electronic formats of books and
even entire encyclopaedias to magazines, jour-
nals and guides, you can find them all on the Net
and download the book of your choice onto a
handheld, PDA or even your desktop PC.

The idea behind eBooks is that you can avail
of books in a faster, more economical, and envi-
ronment-friendly manner. And they provide for
a richer interaction by giving you the advantage

of links to other information sources and sup-
port for multimedia. These books are easier to
carry around and are extremely useful when
searching for and updating information.

WWhhyy  ee--ppuubblliisshh??  
We don’t mean here that eBooks are only useful
for those totally devoted to books, and forever
want to be reading something or the other.
eBooks can also serve as your first foray into the
literary world if you are an aspiring writer. For a
writer, nothing beats the pleasure of having his
work published.

But in the conventional paper-and-ink world,
this pleasure doesn’t come easily. For one, you
would have to be sufficiently recognised for a
publisher to take you on. After all, why would
someone invest money in your work if they
weren’t certain of a decent return through sales?
And if you decide to publish your own work,
you’d need enough dough to blow and well-
placed contacts because distributors and retail
outlets are normally reluctant to display the
works of novices.

On the other hand, for you to publish an
eBook today, all you would need is a word
processor, a free plugin such as MS Reader that
creates the eBook in the desired format and an
Internet connection.

No more lugging
voluminous tomes of
literature. eBooks
bring you all the
books you’d ever
want to read, right in
your hand
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BBooookkmmaarrkkss
Sites that promote e-learning
1100  EE--bbooookkss
Check out 
PPllaayywwaarree & MMiinnddwwaarree
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All you have to do now is log on to the Net
and put up your precious work in the form of an
eBook on any one of the sites that allow you to
publish your own eBook for free.

While you can start off with creating an
eBook in text format or Rich Text Format (the
two formats that are by and large universally
accepted), this won’t add the much needed func-
tionality and readability to your eBook.

eBooks make for engrossing reading only
when you add interactive elements such as book-
marks (chapter divisions), hyperlinks, tags, etc,
that allow for a smoother navigation and more
functionality.

AArree  tthhee  ggiizzmmooss  rreeaaddyy  ffoorr  uussee??
Excited about the prospects pre-
sented by eBooks? Well, hold your
horses—here comes the bad news.
Owing to the fact that eBooks are a
relatively new medium, entrepre-
neurs are seeking to cash in on it as
a business opportunity.

Of late, the market has seen the
entry of quite a few eBook readers
and devices such as PDAs and
handhelds.

However, an accompanying problem is the
fact that some of these devices are dedicated
devices, which means that they support any one
particular format.

A handheld device, such as the Palm or the
Pocket PC that can read multiple formats will
therefore be preferred over these dedicated
devices that read only one format.

A few other technical setbacks with handheld
devices include a small viewing area and also prob-
lems with the display of text and graphical images,
which are in low resolution and are pixelated. As a
result, eyestrain is a major complaint that people
have with eBook devices, or with reading eBooks

Writers all over the world
look for inspiration from fel-
low writers and at times
they do find a certain bit of
information interesting and
it very easily gets included in
their own work. But nothing
irks more than when some-
one tries to take the credit
for your hard work and tries
to pass it off as theirs! The
Net is a place where such
things go largely unnoticed,
as it is near impossible to
keep track of who is using
your information and how
they’re using it.

Companies and other
institutional bodies worry
about copyright infringement
due to content theft. It is but
natural then, that they feel
insecure about losing their
content to hungry prowlers.
So what’s the remedy?

Enter Digital Rights Man-
agement (DRM). Similar to
digital water marking tech-
nology that helps to identify
your prized documents, DRM
is basically a server-side soft-
ware that helps to keep track
of your information online.
This technology makes it vir-
tually impossible to steal
information from Web pages.
The software has multi-level
administration rights and is
useful for safeguarding your
content. The software uses
advanced encryption param-
eters such that it doesn’t
allow individuals to copy and
paste documentations, or
even photographs from Web
pages. Aside from this, it lets
visitors to the site view and
print certain information only
for a certain amount of time.
To view the content, you
have to download plugins.
Once protected, images or
text cannot be copied,
saved, printed or screen
captured. 

A Question of 
Copyright

Once you’ve written your eBook, you then need
to convert it to an e-format that can be read on
the screen of your computer or handheld
device.
Using MS Reader: When you download the MS
Reader software and plugins (from
www.microsoft.com/reader), an icon called
‘Read’ is installed on the main tool bar. Open
the text in MS Word and choose the Read
option from the File Menu to convert the docu-
ment to MS Word format. Just follow the

onscreen instruc-
tions to com-
plete the
process. 

This converts
your file into .lit
format, which
can be read on a
handheld device
such as the MS
Book Reader.
The software is

very user friendly,
and helps you to bookmark, change font or
highlight from the options menu.
PDFs for your handheld: The best feature of
Adobe’s portable document format (PDF) is its
cross-platform compatibility. Since Adobe PDF
files can be viewed on all major computing 

platforms, users can read e-books on desktop
computers and other devices, and also transfer
e-books between devices such as the Palm,
Windows CE or PocketPC. If you happen to have
Adobe Acrobar 5.0, then creating PDFs is even
simpler. Install Adobe Acrobat to your machine.
Now, you can choose to print to the PDF Writer
from the application you are typing your text it.
Alternatively, if you are using Microsoft Word,
then the task is even simpler. 

Acrobat integrates seamlessly with Microsoft
Word and places an icon on the toolbar to cre-
ate PDFs. Open the document in Microsoft
Word. Click the Create Adobe PDF button in the
toolbar or choose File > Create Adobe PDF. 

Creating your eBook

Format
Weight
Updates
Features
Cost factor
Reach
Works on 

PPaappeerr  bbooookk
Paper 
Depends on the edition
Buy a new one
Excellent photo quality
Expensive
Universal
-

eeBBooookk
Electronic
Light and easily portable
Update via the Net
Depends upon the technology used
Rather expensive at the moment
Catching on
Battery

Books vs eBooks

Your first eBook?

Using the Adobe eBook Reader
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off a computer screen for that matter. However,
Microsoft claims to have come up with a display
technology that lends the look and feel of high
resolution printing to onscreen reading.

Called Clear Type, this technology provides
you with crisp and easy-to-read text on your
screen, be it a laptop, PDA or any other specialised
reader.Another prototype device being developed
by a core group consisting of Toshiba, NTT Data
and E-book Initiative, Japan, to address this prob-
lem consists of two vertically attached LCD pan-
els with a high-resolution screen.

MMoorree  tthhaann  mmeerree  bbooookkss
Technology isn’t only about creating innova-
tions, but about coming up with innovative solu-
tions that help towards achieving the most
important of goals—helping people. eBooks
wouldn’t be as big an achievement if those that
are visually impaired couldn’t also enjoy them.

Microsoft and Pulse Data International seem
to have taken up the challenge by attempting to
make Braille-ready eBook readers. The plan of
action involves integrating the Microsoft Read-
er and Pulse Data’s BrailleNote software, a fam-
ily of screenless devices that translate text into
speech and Braille.

A visually impaired individual could choose
from downloading an e-book to be read on a
Braille reader, or even listen to the speech version.

The National Institute of Standards and Tech-
nology (NIST) has developed a prototype that can
translate text into Braille, and features variable
speeds, allowing people to read faster or slower,
or to pause the device. The reader can transform
text into Braille and can also be used for reading
e-mail, browsing the Web, and
other text-based applications.

FFllaasshh  iinn  tthhee  ppaann??
Will e-books make it big in the
future, or will they remain just a
passing fad? It is too early to say.
Since eBooks have emerged on
the scene only recently, they are
yet to catch up with the main-
stream. As of now, the two major
suppliers of e-books are Amazon
and Barnes and Nobles, who pro-
vide you with access to eBooks at
a price. While there are quite a few
sites that allow you to download
eBooks for free, there also exists
the question of copyrights. But if
you’re looking to make your mark
as a writer, then this is the perfect
medium that should get you
there. So what are you waiting for?
)Logon and start e-publishing
your magnum opus.

1/2 page H AD

www.planetebook.com
www.ebookland.net
www.ebookcompiler.com
Free eBook publishing sites
www.peanutpress.com
Free downloads of PalmPilot software 
www.free-ebooks.com
Download free eBooks and also 
submit your own 
www.pyramidsofmars.com
Lets you download a wide range of stories
www.promo.net/pg/
One of the most reliable sources for  eBooks 
www.memoware.com 
One of the best resources for finding help
regarding eBooks
www.nightkitchen.com
Download TK3 Reader, publish your eBooks
and also download free TK3 book samples
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RINKI  BANERJI

“A
re you underworked and overpaid?”asks
a banner, rather temptingly, at the top of
a Web page I’m scrolling through.“Who
is?” I ask myself rhetorically, as I click on

it. Needless to say, it takes me to a job site.
Like ‘true love’, the concept of a ‘perfect job’

haunts us as we go about our dreary lives. It is
waiting for us, just round the corner, we say to
ourselves, but only if we read the signs right, and
are ready to take the chance, and don’t muck it
up. “Why does it have to be so tough?” we sigh.

“It doesn’t!” job sites reply. I am now begin-
ning to understand the lure of these sites.“There
is a perfect job waiting here for you,” they seem
to say, “just come and get it.”

Whether you are looking for your first job, or
your eleventh, it is difficult to be unaware of the
existence of job sites. They leap out at you from
Web banners and roadside hoardings, and some-
one you know knows someone who got the ‘per-
fect job’ through them. And of course, in today’s
hectic world, when you have little time to pore
over the classifieds and recruitment columns in

Searching for your
dream job? Maybe
posting your resume
on the job sites will
help

Apply, Apply, is there a reply?
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newspapers, they seem to be the easiest way to
keep track of the job scene.

SSttaayy  aahheeaadd  iinn  tthhee  rraatt  rraaccee
Why are people thronging online for career
advancement? The answers are simple.

You expect there to be a variety and range of
job choices available on the Net, which is entic-
ing, whether you’re looking to be based in India
or abroad. The sites claim to be updated regu-
larly, and send you daily updates and job offers
in your inbox. While most of these sites are free,
the paid ones would certainly seem to offer value
for money. For instance, Jobsahead.com claims to
send your resume to 500
reputed consultancies
across the country, for a
sum of Rs 1,000 (Rs 2 per
agency).

Job sites also provide a
lot of valuable information
such as tips to polish up
your resume, career coun-
selling, online training and
expert advice from people
who’ve made successful
careers. You also have
access to up-to-the-minute
market news and links to other relevant sites.

Consultancy services and recruitment agen-
cies are a feasible option, but they lag behind job
sites in several respects. They won’t keep you
updated daily. Some make you pay them to
maintain your bio-data, but have a negligible
success rate. If you happen to reject their first job
proposal, some agencies never get back to you
again. And think of all the time that you have to
spend interacting with them. Job sites, on the
other hand, are easy to access and they are open
24 hours a day, 365 days a year.

GGeett  wwiitthh  tthhee  pprrooggrraamm
You can find a plethora of Indian job sites listed
on www.hydinternews.com. Or simply search via
any popular search engine like Google.com,
Altavista.com or Yahoo.com. The most frequent-
ly used sites with exhaustive databases are

Careerindia.com, Jobsahead.com, Jobsdb.com,
Jobstreet.com, Monsterindia.com (Indian inter-
face), Naukri.com, etc.

The usual way to go about things is to regis-
ter and submit your resume to the site. If you
wish, you can create a personalised page con-
taining your resume for daily alerts matching
your criteria. Or you can apply for vacancies
online itself, on sites like Naukri.com, where com-
panies put up live postings on their require-
ments. Listings of walk-in interviews are also
available on some sites like Jobsahead.com.

Message/discussion boards are good places to
share your views and ideas about job prospects

and experiences at work
with others. This section is
visited by a lot of recruiters,
so you can make use of it to
blow your own trumpet
with an attractive resume.
Of course, if you don’t want
your current boss to stum-
ble upon your resume, it is
best to submit it to the site
database, where it is kept in
absolute confidentiality
and your resume is sent
only to companies that

have openings that match the job profile you’ve
asked for.

Once you’re registered with a site, expect to
see mailers and updates in your inbox with sub-
jects such as, ‘Congrats…you got a job!’ or
‘Urgent…here’s a vacancy!’. As Sulekha Ranade,
a Web designer working for a Web development
company says,“I have registered with Naukri.com
and Jobsahead.com. They supply daily newslet-
ters with three job openings matching my crite-
ria on an average.” Of course, if you have your
heart set on a very specific type of job, you would
do well to keep a constant watch on the sites and
browse daily for new openings.

A junior or middle level job is generally easi-
er to find than a senior position. If you’re plan-
ning a switch in mid-career, then the place to
shop is Timesjobsandcareers.com, where you can
opt for more than one field of work. If you want

➜

Alltimejobs.com
This site provides career
resources, a listing of hot
companies, counselling,
articles, previews, etc. The
distinctive feature of this
site is the corporate online
test that enables HR man-
agers to use their recruit-
ment tools and also get
feedback from casual
surfers who are not neces-
sarily seeking employment.
The total number of jobs
offered by them is more
than 2,500, in addition to
links to recruiters.
Careerindia.com
Columns dealing with the
work environment and 
how to cope with stress are
the first thing that you
notice here. In addition,
there are tips for facing
your interviews boldly 
and convincingly. Expert
career talk, employee
search and selecting talent
are some of its most attrac-
tive features.
Careersindia.com
It’s a different site than the
one above, and has a career
centre, an e-mail feature to
alert you of the latest job
openings, and features and
articles. Unfortunately, for
getting the search results for
a job, you need to give a
valid e-mail ID where you
get the results.
Jobsahead.com
Search for a job here, and
you also come to know of
the number of people who
have applied till date.
There’s a resume blaster
service that links users to
500 consultants but you
have to pay Rs 1,000 for it.
Along with a huge database
of vacancies all around
India, they keep the users
posted with career tips and
provide various communi-
ties for discussion boards.

Working with 
Some Jobsites@india

Secrecy is an important issue when it comes to
submitting your resume on a job site. The last
thing you want is your boss coming across it,
and turning your dream of leaving the company
into a reality too soon!   

The best way to stay out of trouble is to add
your resume to the database of the site, and
subscribe to the newsletter to keep you updat-
ed about new vacancies. The databases are

kept confidential and protected from intruders. 
In case you wish to make your presence felt,

you will find sections meant for employers on
naukri.com where you can post your resume
along with a brief description about yourself. 

If you are a fresher, it makes sense that you
not only apply for the newsletters and post your
resume on the database, but also post it on the
free display section for higher visibility.

Keep the Cat in the Bag

Find the job for you at Jobsdb.com 
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to keep yourself posted
about consultancy services
and placement agencies,
Naukri.com and Jobsa-
head.com have a listing with
complete contact details.

CCaauuttiioonn!!  WWoorrkk  iinn  
pprrooggrreessss
But looking beyond the
hype, are these sites actually
getting the job done? While
the going seems good, Indi-
an job sites still have a long
way to go before they can measure up to their
international counterparts. The biggest problem
with almost all the sites right now is the unavail-
ability of non-IT jobs.

There are hardly any job postings or alerts
related to, say, photography or media. Job open-
ings abroad are also usually restricted to a few
categories: IT, telecom, HR, finance, manage-
ment and sales. Another bothersome aspect is
that the newsletters informing you about the list
of vacancies rarely provide the telephone num-
ber of the companies, and the recipients are
forced to find it out for themselves.

“There’s one frustrating thing about the
newsletters. It is really difficult to get the contact
details, as you are only given links to the sites,”
says Ranade. “And the worst part is, after all the
rigmarole of sending your resumes through, you
hardly ever get a response. In fact, some of my
friends had to call the employers over the phone
to fix an appointment,” she adds.

Also, the e-mail updates may not be that up-
to-date, as Rekha Banerjee found out. “After
resigning from my company, I had availed of the
free service by jobsahead.com with a dream job
in mind.” However, she happened to get into the
company she wanted without help from jobsa-

head.com.“Just after I joined my dream compa-
ny, I found an alert in my mail box about a
vacancy in the same organisation.” It turned out
to be the vacancy that she had already filled! 

Ankush Garg, working in quality manage-
ment at forindia.com also had his patience test-
ed by these sites. “My uncle wanted a non-IT
senior level management job and I applied for
him at the payment service with jobsahead.com
and the free service with naukri.com. I received a
response from jobsahead.com in 13-14 days...
better than naukri.com, which still hasn’t given
me a single acknowledgement,” says Garg.

“However, it was a waste of money, as the
vacancy we were alerted about was for an elec-
tronics company and was partially IT-related,”
he adds. The matchmaking process still needs a
bit of tweaking. The jobs offered may not meet
the desired criteria, especially if you’re looking
for something non-IT or at a senior level.

The bottom line is that job sites are no manna
from heaven. But if you get over that ‘perfect job’
mania, they have a lot to offer you. Maybe even
a near-perfect job.
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Top 10 reasons for registering at a job site
1. Comprehensive job listings for India and
abroad
2. Daily mailers and updates for job offers
3. Space for salary negotiations
4. Message boards to share views and opinions
with communities such as IT, management,
finance, etc 
5. Career counselling, tips to improve your
interview skills, etc 
6. Expert advice from people successful in their
professions   
7. Articles and analysis regarding various careers
and job profiles
8. Links to latest happenings and news affecting

the job market
9. Information about emerging career opportu-
nities
10. Walk-in interview alerts
The shortfalls
1. Acknowledgements upon registration and
responses to job queries are not always prompt
2. Very few non-IT jobs listed
3 Contact details are usually not given
4. E-mail updates may not be that up-to-date,
as companies fail to alert the job site if the
vacancy is filled through other means
5. The matchmaking process is not foolproof.
You get alerts for jobs that don’t match the cri-
teria specified

The Upside and the Downside

Jobsdb.com
It had 910 jobs on its list
when we visited it. Apart
from posting your resume
and searching for jobs, you
can look up some career
resources such as preparing
for interviews. As usual, you
can search for jobs by key-
words, date, etc, but what
really stands out is the vast
categorisation of jobs. Regis-
tration allows you to receive
personalised alerts and mar-
ket yourself to prospective
employers. You can also
scan through job offers in a
few other countries. 
Monsterindia.com
At the Indian counterpart of
Monster.com (one of the
biggest job sites in the
world), you can set up your
own e-mail account and
search for jobs across a
wide category. The regular
sections on expert advice on
preparing a resume, career
advice, etc, are present, as
also a list of favourite com-
panies. One aspect you
notice is that a job search
reveals a detailed descrip-
tion of the job, along with
company details and not
just some basic information
as on some sites. 
Naukri.com
This is an extensive job por-
tal, and also includes some
job offers abroad. The site
uses free resume managers
to upload your resume and
get free alerts and claims to
have covered more than
11,000 companies. You can
also avail of a column with
free counseling advice. And
one of the columns also
gives a listing of various
recruitment services. You
can apply for daily newslet-
ters on the site to get free
updates about vacancies.

I applied on behalf of my
uncle for a non-IT senior
management job…but it
was a waste of money as
the vacancy we were
alerted about was partially
IT-related   
AAnnkkuusshh  GGaarrgg
Quality Management, Forindia.com

Working with 
Some Jobsites@india

Tried hunting for a job through one of these sites?
Write all about it to readersletters@jasubhai.com
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I
ndia’s climb to the peak of Information
Technology began in the mid-1980s, when
technical and non-technical colleges incor-
porated computers into their respective cur-

riculum. On one hand were technical colleges
that introduced four-year BE/BTech

Computer Science and on the other,
were non-technical colleges that

included it as a subject in addi-
tion to Economics, English, etc.
However, over time most of

these colleges developed loopholes
such as obsolete curriculum, poor quality

and quantity of computers. This was
especially true of non-technical col-
leges. The result—dissatisfied students,
mushrooming of private computer
institutes catering to a specific demand

and charging exorbitantly for
imparting knowledge that does-

n’t seem worth it on the sur-
face level.

OOlldd  iissnn’’tt  ggoolldd!!
The problems that ail the sys-
tem of computer education
in our country are numer-

ous. Let’s start off by taking a closer look at the
curriculum or syllabus that is being adhered to by
various colleges. In the name of computer soft-
ware training, students are being taught out-dated
languages and that too on out-dated machines.

Broods Naresh, a BE (Mech) student of Vas-
ant Dada Patil College of Engineering, Mumbai,
“We are taught BASIC, FORTRAN, etc which is
of no use these days. Instead, we should be
taught Java or anything else that is in demand
today. In a way we are being forced to join com-
puter institutes, like in schools where teachers
expect children to come to them for private
tuitions if they want to learn more.”

Not only is the curriculum obsolete, it’s
incomplete as well. A BE degree in Computer
Science tries to cram in a whole lot of things
ranging from algorithms and circuitry to pro-
gramming languages such as Pascal (apart from
the usual BASIC in the first year). This tends to
be a non-focussed approach, and only certain
universities have the option of different electives
and that too in the final year. So, more often than
not, you end up learning things that you may not
at all be interested in. And while your counter-
parts in the US may be learning about the latest
technology being used by the Intels and the
AMDs, here in India, students are being made to
do with 8085, 8086 and very rarely, a 486.

Now circuit design is hardly a subject you
would find covered by private training institutes,
and so you end up neither here nor there, and
more often than not, take the usual path of join-
ing a computer institute and learning about
other programming languages.

GGiivvee  mmee  mmoorree!!
Computers, like Mathematics, is all about prac-
tise. The more you practise, the better you
become. Theoretical knowledge is important,
but without practical knowledge, it amounts to
nothing. This is exactly what is happening in
most colleges.

Says Kanchan, a student of a New Bombay
based engineering college, “For almost one full
semester, our computer science teacher made us
memorise complex Unix commands, but we
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never got a chance to actually practise them. It
was only towards the end of the semester, 15 days
prior to the exam, when we actually saw what
each command did.”

Rohit Sharma, a marketing executive based in
Punjab, faced a similar problem. Says Rohit “Dur-
ing my BA (1996) First Year, as a student of one
of the best colleges of Chandigarh, I had com-
puter science as a subject. In the once-a-week
practical class, of one-hour duration, four stu-
dents used to share one computer, which came
out to a paltry 15 minutes per student per week!”

One might say that this used to happen five
years ago, which is a long time; things must have
changed by now. Sure, they should have! Com-
ments Rohit,“They have but not to the extent they
should have. My brother Mohit, who’s a student of
the same college, tells me that now instead of four,
two students share a computer. This also isn’t suf-
ficient. They should at least allocate one PC to
each student.”

TThhee  ggrreeaatt  ddiivviiddee  
In complete contrast to col-
leges, the system at the PG
level is more comprehensive
and up-to-date than the one
at the graduate level. Com-
pares Aashish Sharma, an
MCA degree holder from
Punjab University, Chandi-
garh “In BCom final year, I
chose Computers as an addi-
tional subject, which involved
study of bare basic topics like
computer fundamentals. In contrast, MCA was a
totally different experience. I had subjects like Ora-
cle, VB, etc. What I did in BCom was a joke.”

The difference between graduate and post-
graduate education exists not only in terms of
the curriculum, but also in terms of the infra-
structure. Says Sajitha Verma, a former Novell
engineer, “I did my MSc during 1988-90. Even
in those days we had an excellent computer lab
which had the latest equipment. Also, our syl-
labus used to get revised each semester.”

Such differences have always existed as post-
graduate level courses are given more preference.
But in the case of computer education, it is
important that the gap be shortened by as much
as possible. This is because a student, who stud-
ied BASIC and PASCAL in college, is suddenly
expected to master Oracle and Visual Basic. The
student is suddenly subjected to pressures of not
only understanding whatever is taught but also
to score good marks in examinations that will
eventually help him get a decent job.

WWhhoo’’ss  rreessppoonnssiibbllee??
In India, the All India Council for Technical Edu-
cation (AICTE) plays a major role in planning

and co-ordinated development of the technical
education system throughout the country. The
syllabus and curriculum is decided by the man-
agement or the university of which the college is
a part, but AICTE is the governing body which
after careful inspection accredits college/univer-
sity to start computer and other technical cours-
es. Not only does it grant permission, it also helps
the local institutions that are accredited to it in
formulating new rules and regulations from time
to time.

When a college or university sends a request
to AICTE for approval, it is forwarded to the
National Body for Accreditation (NBA). It was
constituted by the AICTE as an Autonomous
Body, under Section 10(u) of the AICTE Act,
1987. NBA conducts evaluation of technical
institutions or programs on the basis of guide-
lines, norms and standards specified by AICTE.

Says Dr I.K. Bhatt, Advisor, AICTE, “These
guidelines help to serve a purpose as they help to

maintain a uniform syllabus. They are under
constant scrutiny and it helps to monitor the sys-
tem effectively.”

However, the problem with a centralised uni-
versity structure with no autonomous colleges is
that changing of syllabus to keep up with the
changing trend is a long-drawn process. This can
easily take up to five years, in which time the
technology may have leap-frogged, so that the
gap still remains. So, many a time it is left to indi-
vidual colleges to circumvent the University
process and introduce courses and new subjects
on their own, even though the same may not
have any bearing on the examinations.

Given such a state, there’re very few options
that a student has. An enterprising student might
decided to take the initiative and probably
engage himself in project work with industries
even while completing the course. At the same
time, keeping abreast of the latest through books
and the Internet is another viable option.

Dr Manju Singh and Dr R.P.
Singh, deputy directors of
AICTE, talk about the role
of AICTE
How does AICTE ensure
that colleges provide up-
to-the-mark computer
education? 

The National Board of
Accreditation (NBA) has
started evaluating the quali-
ty of education in the AICTE-
accredited institutions. The
accreditation grades are
three-tiered. ‘A’ grade signi-
fies that the quality of the
program is at par with any
other country. ‘B’ signifies
that though the institution
satisfies all the norms, some
weaknesses still exist which
can be rectified in a short
period (2-3 months). Grade
C signifies that the institu-
tion may be satisfying basic
norms, but a few things are
lacking, which can be recti-
fied in a few years. 

What are the minimum
requirements for colleges
wanting to offer computer-
related courses?

AICTE has specified dif-
ferent norms for different
levels of institutions. Basical-
ly, these include a furnished
building, all machinery and
equipment  and qualified
director and faculty to stu-
dent ratio of 1:15. 

How does AICTE check to
see whether guidelines are
being followed? 

AICTE monitors the col-
lege yearly for the first four-
five years, or till the first two
batches graduate. The col-
lege has to then get itself
graded by the NBA. If the
NBA reports that regulations
are not being met, an
inquiry committee is insti-
tuted. Based on its report,
various punitive actions are
taken.

Keeping Tabs

In BCom final year, I had
Computers as an additional
subject, What I studied then
was a joke. In MCA, I had
subjects like Oracle, VB, etc. 
AAaasshhiisshh  SShhaarrmmaa
Programmer, HCL, Delhi

The true identity of some of the people mentioned in this story
has been withheld on request. 
Learning computers in a college?
Write all about it to readersletters@jasubhai.com



ALISAGAR PARDAWALA

I
am the hard disk, one of the most hardwork-
ing components of your PC, keeper of the
operating system, hardware and software
drivers and games, providing you with what-

ever you need, whenever you ask for it. But late-
ly my performance has dropped considerably,
and I know you’ve been wondering what on
earth is wrong. Well, let me tell you the reason
for my errant behaviour.

When I was new, all the data I stored was
in one place, so I could serve it up quick-
ly when you asked for it. But as
time passed and more and
more data accumulated, I
saved new programs
on different clus-
ters, which

are quite
far away from

each other. So when
you ask for the same

data now, it takes me more
time to furnish it.

Also, all the software you keep
loading and deleting makes me a very

messy place. There’s data scattered all
over, and it could be hiding viruses that can

crash your system and make life difficult for
you in front of the beige (unless you have a Mac)
box. So, time for a spot of cleaning.

DDoo  iitt  tthhee  rriigghhtt  wwaayy
I’ve seen that panicky look on your face every
time you read the message that your disk has run
out of space. But please don’t rush to use some
free system utility you got on the Net. There are
many inadequately tested products floating
around that have been developed by non-pro-
fessionals.

They blindly delete folders from the system
that might contain vital data, so you get your
100 MB of free space at the cost of data being
lost. This is not the best way to clean me! I would
prefer if you installed a cleaning tool like Norton
CleanSweep, which can be run once in two-three
days to free up space.

These programs are safe to use since they
offer you complete control, letting you decide
what to keep and what to delete.

I need a minimum 100 MB of free space at all
times, irrespective of my size. It would be best if
you get into the habit of deleting unnecessary
files and folders from the system on a weekly
basis.

Some files that I could usually do without are
temporary Internet files, cookies and folders and

files in the Temp
folder that you have no
more use for.

BBeetttteerr  ssaaffee  tthhaann  ssoorrrryy
While you’re on a cleaning spree, you will
invariably come across some files with strange
names that will stump you. To delete, or not to
delete, that is the question. It’s possible that these
files are vital for the running of some program,
operating system or hardware drivers, and
removing them might lead to the program mal-
functioning or even crashing. The safe way out
is to make a backup of the files on a floppy or
Zip diskette before deleting them.

Once you’re done, restart the computer and
check if all the programs are working like they
were earlier. If everything is running fine, the
files were obviously useless. If any application
creates problems, you will see an error message
telling you which file is missing. Just reload that
particular file.

Do remember that whenever you press the
Delete button, you are not really eliminating that
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n me Now!

System Tools (in Windows)
Disk Defragmenter 
ScanDisk
System Utilities (freeware and shareware)
Disk Optimiser
CleanDisk Pro
Space Odyssey
TidyDisk
ReprMan
Dedicated Utilities
Norton SystemWorks 
McAfee
OnTrack System Suite

Cleaning Tools Available

I’m your hard disk,
and I’m here with a
simple yet important
message. Listen up
buddy, because
I’ll only 
say this 
once,

■■ rreessoollvvee~~wwiirreedd
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file from your system, but just putting it in the
Recycle Bin. This gives you a chance to restore a
file that has been deleted by mistake. It’s impor-
tant to regularly empty the recycle bin because it
eats up disk space.

HHeellpp  mmee  ffiigghhtt  bbaaddddiieess
I am made up of a combination of electro-
mechanical components that are precisely fabri-
cated and assembled in one casing. Since so
many components are involved, I am prone to
physical damage if not handled with care. The
most common manifestation of this is a bad 
sector, which is a sector that gets jarred and 
damaged.

This can occur due to many reasons, like a
scratch on the platters that store information,
contamination or demagnetisation.

The remedy for bad sectors is a useful little
program called ScanDisk, which scans the disk
surface for errors and fixes them. This utility
comes with the Windows operating system. You
can access it from Accessories > System Tools. The
‘Through’ test allows ScanDisk to scan the sur-
face of the disk, find and repair errors, and to
mark unusable damaged areas.

Once this is done, the area is quarantined so
it does not cause a problem in the future. All you
need is to be patient and wait till ScanDisk com-
pletes the test. Remember to close all programs,
especially the screen saver, which interferes with
and delays the entire process.

GGeett  aa  llooaadd  ooffff  mmee
Besides removing bad sectors, there are other
ways you can optimise my performance. One
nifty way is to reduce the size of your swap file,

popularly known as virtual memory. In the Win-
dows environment, swapping enables a comput-
er to manipulate programs and data files larger
than the main memory. The swap file size could
be kept around 300 MB if you are using 64 MB
of RAM. This is not a hard and fast rule,
though—it finally depends on the type of appli-
cations you use.

If the applications are graphics-intensive like
PhotoShop or any other 3D-rendering software,
where the file size is bigger and the memory sub-
system is strained the most, the best way to deter-
mine the swap file size is to use the system
monitor, which shows the swap usage. To do this,
go to Control Panel > Add/Remove program > Windows
Setup > System Tools. Click on Details.

This will show you the various system tools.
Here, check the box beside System Monitor. Keep
the Monitor running while you work at your
computer.

At the end of the day, go to the System Mon-
itor and check the ‘maximum swap file usage’
and decide the swap file size accordingly.

If you’re confused about the settings, just
choose the ‘Let the windows decide my virtual
memory’ option and Windows will do the need-
ful for you.

AA  cclliicckk  iinn  ttiimmee  ssaavveess  nniinnee
One thing I can’t understand is why people don’t
keep their files in a more organised fashion. Most
of the time they don’t even keep track of where
they’re saving a document, because they know
the four files last opened will be displayed when
they next switch on the PC. Do you do this too,
and later get into trouble, wasting hours looking
for a single misplaced file whose name you’ve
forgotten? Avoid this problem by creating sepa-
rate folders for different categories and saving all
related files accordingly. It only takes a couple of
clicks—not like you have to punch holes in
reams of paper or arrange stacks of files alpha-
betically.

Another thing that would go a long way in
keeping me fit is switching off the computer the
correct way. Improper shutting down or power
failure can lead to the FAT table getting damaged,
clusters getting lost or orphaned and files getting
cross-linked.

Files being used at that time may be lost. On
the other hand, shutting your PC from the
Start menu allows all the files to close, unwant-
ed files to be deleted, and important files such
as system registry files to be copied to the FAT
table.

Just see the difference once you’ve cleaned
and optimised me. I’ll make the system fly, and
applications will open in a flash. So if you don’t
want to face a hard time when its crunch 
time, start keeping me in good shape. And that’s
an order!

One sure-shot method to
speed things up on your PC
is to format the hard disk.
But this is something you
shouldn’t do more than
once in six months. And if
you aren’t sure about it,
please take help, or better
still, leave well enough
alone, because if anything
goes wrong you will end up
losing all data. And that
means everything will have
to be installed again. 

So the best way to pro-
ceed is with caution—take a
backup of everything. You
can do this on a second par-
tition that you won’t re-
format. A safer bet is to use
removable media. Back up
important files, folders and
other vital data. And don’t
forget the data in the
address book, either Out-
look Express or Microsoft
Outlook, because it’s a
tedious job to rewrite all
those addresses and e-mail
IDs. 

To do this in Outlook
Express, go to Windows Explor-
er > Windows > Application Data
> Microsoft > Address Book.
Copy this Address Book
folder completely on your
backup media. For Microsoft
Outlook, from the main
menu open File
Import/Export. The wizard
will open for importing and
exporting files and folders.
In this Window, look for the
personal folder file (it has a
.pst extension) and save it.

PS: Remember the
Address Book Do you…

■ Empty the Recycle Bin on a regular basis?
■ Scan your hard disk after an improper shut-
down?
■ Always shut down your computer from the
Start menu and not by shutting off the
power?
■ Not open and work with an excessively
large number of applications simultaneously?
■ Always logically organise your files? If need
be, store all your documents on a separate
partition so as to facilitate easier backups.
Otherwise, at least keep them in a separate
directory.
■ Avoid storing files and documents in the
root directory of your hard disk?
■ Preferably, activate the setting ‘Do not show
hidden/system files’ to avoid accidentally
erasing crucial files?

Health Tips for your Hard Disk



■■ rreessoollvvee~~uunnwwiirreedd

ANIL PATRICK R.

“O
h boy! Oh boy! I finally managed to get
my hands on that Pocket PC I’ve always
wanted. Now how on earth do I get it to
work in step with my desktop? I think

I’ll have to enter my entire address book. Oh
god, help me!”

If this is what was running through your
mind after you just became the proud owner
of your very own Pocket PC device, then we
suggest you play it cool and take things easy.
Getting your Pocket PC device ready for action
is no big deal.

You can synchronize your Pocket PC device
with your desktop PC so that it constantly
updates itself with the data in your computer.
This allows you to use your Pocket PC device as
an extension to your computer with the same
data in both.

The Pocket PC OS comes with all the good-
ies you need, such as Web browsers, e-mail,
audio and video media players, and so on. All

you need to figure out is what you want to do on
it and leave the rest to your Pocket PC to do it for
you. So let’s get a jumpstart on how you can use
the Pocket PC.

TThhee  ffiirrsstt  ssttrriiddeess
To start with, in addition to your handheld,
you would need an ActiveSync installation CD,
and Outlook 2000. You can also download the
software from the developer’s site or other
download sites, but it is better if you have the
original CD as it also includes other useful
utilities such as AvantGo, IE 5, Windows Media
Manager, Microsoft Money and Microsoft
Reader.

There’s also TScribe, which provides a vir-
tual keyboard and stylised handwriting input
called Character Recognizer, which allows you
to input data in your own handwriting.

Most Pocket PC devices come with a USB
port as standard, so you wouldn’t have any
problems with setting speeds on a serial port.
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Get the two loves of
your life, your
desktop PC and
Pocket PC device, up-
close and personal!

Get them talking

➜
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Just make sure that your PC also has a USB port,
though. Refer to the manual to find out if you
have a serial or a USB port. Microsoft recom-
mends Outlook 2000, though it isn’t a necessary
criterion if you want to use your Pocket PC.

Now that you have all the tools with you, lets
get on with installing ActiveSync on your PC.

Step 1: To start the installation, double-click on
the installation file in the CD or on the one that
you’ve downloaded.

Step 2: Click on Next. Click on Change to select
the drive and folder in which you want
ActiveSync to be set up, then click on Next.

Step 3: Now is the time to go live. Connect your

Pocket PC’s cradle, with the Pocket PC on it, to
the PC’s USB/Serial port and click Next.

Once your PC has detected your Pocket PC
device, you are all set.

In case your Pocket PC is not detected, there’s
no need to worry. We encountered the same
problem while working in Windows 98. Restart-
ing your computer should help it detect the
Pocket PC. Installing ActiveSync on Windows
2000, however, was as easy as a song. The system
detected the device the moment it was connect-
ed, without any restarts.

TToowwaarrddss  ppaarrttnneerrsshhiipp
Now that ActiveSync has been installed on your
machine, let’s get down to introducing and
transferring data from your first love to your lat-
est crush. It’s time both your PC and Pocket PC
got personal! 

Click on ActiveSync. This will bring up the
‘Set up a Partnership’ screen. Click on the Yes
button to synchronise all the data on your Pock-
et PC and your desktop computer. The No but-
ton is used in case you are using someone else’s

computer and don’t want to synchronise your
data, but only want to do a manual transfer.

Follow the prompts, up to the very last step,
to set up your first partnership and click on 
Finish to complete the process. Now ActiveSync
automatically synchronises data between 
your PC and Pocket PC. It automatically 

How do you connect your
Pocket PC device to your
desktop so that you have
the same data in both?
That’s where synchroniza-
tion (or syncing) helps you
out. It’s not as complex as it
sounds. 

Connect your Pocket PC
device to your PC using the
cradle. The cradle comes
with a serial or USB port in
most cases. Just plug in the
connector of the cradle to
your PC’s serial or USB port
and you are ready to start
syncing. 

It’s okay if you don’t hap-
pen to have a cradle for
syncing. Just connect your
Pocket PC device to your PC
which has ActiveSync
installed, using a serial or
USB connector. ActiveSync
automatically detects the
type of connection. It is also
possible to sync using the IR
port of your Pocket PC
device and the one on your
laptop. Sometimes syncing
can be a real pain but in the
case of the Pocket PC, it’s a
very smooth process, using
ActiveSync. ActiveSync lets
you synchronize almost
everything on your PC with
the Pocket PC device. 

Syncing is also used for
other purposes such as
installing applications, trans-
ferring files, surfing the Net
on your handheld via the
connection to your PC, or
using a wireless modem. 

A Syncing Feeling?

Starting the installation

Windows 2000 will auto-detect your handheld

Customising your setup

Towards connectivity

First steps towards partnership

SSooffttwwaarree  
Microsoft Reader, Adobe eBook
Reader, check out 
MMiinnddwwaarree



synchronises the data in your calendar, con-
tacts, favorites, and tasks.

One thing you must refrain from doing is
using the Pocket PC device until synchroniza-
tion is complete. It is also possible to add more
applications to be synchronised automatically
when you connect your handheld to your PC.

Synchronization takes place on a continuous
basis, but you also have the option for manual
syncing. Synchronization will ensure that all
your PIM information and other applications
get synchronised constantly.

You can also set up more than one partner-
ship. Suppose you use a PC at home and a lap-
top in the office, setting up multiple
relationships will help you keep your Pocket PC
device up-to-date with both.

However, it is not recommended to set up
multiple partnerships until you have first mas-
tered the art of using just one. After that you can
set up as many multiple partnerships as you wish.

YYoouu’’vvee  ggoott  mmaaiill  
Your Pocket PC device also allows you to send
and receive e-mail using the Inbox feature. Inbox
synchronises with your PC and keeps the e-mail
updated with those in your Pocket PC. It is very
easy to add Inbox to your synchronization set-
tings. Go to Tools > Options > Sync Options in your PC’s
ActiveSync and check Inbox. That should get
your Inbox up and running.

You can write and store e-mail in your Pock-
et PC by launching Inbox from the Start menu.
Click on New to get to the mail editor and com-
pose your mail.

Use the Contacts button to select the name of
the recipient from your address book. The next
time you connect to your desktop PC, the mail
will be sent automatically while syncing. It is the
same with receiving e-mail. During synchro-
nization, all the mail will be downloaded to your
Pocket PC and you can read them on your own
time.

There’s a slight catch though. You can sync e-
mail only from one PC, unlike other types of
data such as appointments, files, etc. Multiple
partnerships, therefore, would get you no where
when it comes to using e-mail with Inbox.
Another thing you have to keep in mind is the
length of e-mail messages you want to receive.
The default setting allows for 100 lines per 
e-mail.

If you want to see longer messages, you can
set a maximum of 500 lines in Sync Settings in
the Settings option. Remember to select the
Include File Attachments options if you want to
receive all your attachments.

OOnn  tthhee  WWeebb  aanndd  ooffff  iitt  
Besides sending and receiving e-mail, you can
also view offline Web pages on your Pocket PC

device, using AvantGo, an offline browser inte-
grated in the Microsoft Pocket Internet Explor-
er. When surfing the Net on your handheld while
it is connected to your computer, AvantGo.com
caches these Web pages after down sampling the
complexity of the Web pages, and transfers them
to the device via your desktop PC the next time
you synchronise.

You can specify the Web pages and browse
through them offline. So make sure you include
AvantGo in your Synchronization Settings, to
make use of this feature.

IInnssttaalllliinngg  nneeww  ggooooddiieess  
Installing new software on your Pocket PC
device is no big deal, provided you ensure that
the file you are about to install is the right ver-
sion for the Pocket PCs processor. Casio and
Compaq make use of the MIPS type of proces-
sors whereas HP makes use of the SH3 type.

Check your device’s manual if you’re not sure
of the processor type. Make sure that
the program is the right one for your
device if you don’t want to get
‘Wrong Device Type’ messages. The
next thing to do is to ensure that you
have enough disk space and that you
are connected to your PC.

Use ActiveSync to install the pro-
gram from your PC. Click on
ActiveSync on your Pocket PC
device, run the installation file on
your PC and set it up. The program
will be automatically installed on
your Pocket PC device. You can then run it
using the program icon.

You can also copy compressed files with the
.cab extension into the Pocket PC device using
ActiveSync. Go to File Explorer in your Pocket
PC and browse to the folder containing the par-
ticular file, click on it and set it up as per the
instructions.

It is also possible to copy software in the form
of .exe files directly to your Pocket PC device
using ActiveSync. These files can be run direct-
ly without any installation.

The place where Microsoft’s Pocket PC oper-
ating system really shines is with respect to mul-
timedia. A decent resolution screen and better
colour reproduction than most of the Palm
devices around makes it great to display high res-
olution images.

You can also playback MP3 music and watch
short movies and streaming video. Microsoft has
recently released Windows Media Player 7.1 for
the Pocket PC device, which you might want to
download and install.

Looks like you’re now all set to have some
serious fun with your little handy man. So
here’s to a fruitful relationship with your new
Pocket PC device!

73

In the default synchroniza-
tion settings, you can add
more applications to be syn-
chronized. Open ActiveSync
in your PC. Select Options
and then Tools. This brings
up the synchronization box
as shown in the image. Set
as default the applications
you want synchronized, and
click Next. There you go!
Next time you connect your
Pocket PC to your computer,
the application you selected
will also be synchronised. 

The default synchroniza-
tion settings ensure that
your Pocket PC device and

your desktop sync on a con-
tinuous basis. It is possible
to change the synchronizing
interval. Go to Tools in
ActiveSync, select Options
and then Sync Mode. You
will come across three
options—On Connection,
Manually, and Continuously.
Selecting On Connection
ensures that synchronization
takes place only when the
device is initially connected
during a session. Choosing
the Manually option ensures
that synchronisation takes
place only when you so
desire. Continuously is the
default option. Select the
option you need. 

Always in sync
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Working with Toolbars
Working all day with a word processor
can be quite demanding. And staring at
a cluttered screen doesn’t help matters
any. Wouldn’t it be nice if you could cus-
tomise your toolbars, and place them
strategically on your monitor screen?

Apart from being easier on the eye, this
would also give you more space on the
desktop. Toolbars could be customised
to display the buttons that are in fre-
quent use. You can add, delete or copy
buttons from the toolbars that come
with Word.

Many of these customisations can be
done using the [Alt] key. Buttons can be
moved within the toolbar by pressing the
[Alt] key and clicking on the button
that’s to be moved.

Keeping the mouse button pressed,
drag the toolbar button to the new loca-
tion. To delete a button, drag it off the
toolbar. A button can be copied from one
toolbar to another by pressing both [Alt]
and [Ctrl] while dragging the button to
a different toolbar.

Retrieving deleted text even
after closing Word
You can clear text and bring it back using
the ‘spike’ feature in Microsoft Word.
Press [Ctrl] + [F3] after selecting the text
or object that you want to clear. This will
delete the text and append it to the spike.
To retrieve the spike’s contents and to

clear it, press [Ctrl] + [Shift] + [F3].
However, if you need to keep the con-
tents in the spike after recalling them,
select Insert > AutoText > AutoText. In the box
labelled ‘Enter AutoText Entries Here’,
scroll through and select the spike
option. Clicking the Insert button will
then paste the contents of the spike. This
can be seen in the Preview window with-
out clearing the spike.

Wondering what a spike is? Well, it’s
an AutoText Entry area in which Word
stores deleted text. This is not to be con-
fused with the Clipboard. Spike is avail-
able even after an application is closed,
whereas matter on the Clipboard isn’t.

Shrinking documents
While typing a long document, it may
happen that one or two lines of a para-
graph slips to the next page. You might
have wondered how to bring the lines to
fit in the page. Here’s the solution. You
can use the ‘Shrink to Fit’ feature to fit
everything on the page. Choose Print
Preview and click on the Shrink to Fit
button. Now your document is more
compact—and you can feel happy at the
thought that you’ve contributed your bit
to preserving the environment by con-
serving paper.

Restoring graphics size
While taking screenshots you would
normally paste them into your Word
document directly, or after making some
changes. Word fits these into compact
frames and doesn’t show the full size of
the image embedded in the document.
You can restore the original size of the
image by using the [Ctrl] key. Press the
[Ctrl] key while you double-click inside
the image area. And behold, you have
Pamela Anderson in all her glory! 

Avoiding breaking of tables
The spillover mentioned while shrinking
documents can affect tables also. Here’s

a handy tip to keep your tables intact.
Select the first column of the table;
choose Paragraph from the Format
menu. Click the ‘Line and Page Breaks’
tab and check ‘Keep with next’. Now you
can be sure that your table doesn’t spill
over into the next page.

Changing the default save folder 
You might not want to put all your eggs
into one basket—or all your documents
into the same folder. Word by default
shows you the MyDocuments folder to
save or to open files.You could modify this
default Open/Save folder by making
changes to Word’s File Locations tab.
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MICROSOFT WORD
The most popular word processor in use by everybody with a rich set of features. Yet, there are many aspects of the word processor that

you might not be aware of. So, work smarter and faster with these tips

Arrange the toolbars as per your liking

Use the ‘Keep with next’ option to keep
paragraphs together

Specify the folder where you want to
save your files



Choose Tools > Options and click on the File
Locations tab, then choose Documents.
Click Modify and specify the path in
which you’d like your files to be saved or
have Word prompt you to open files from.

Changing text in Print Preview
Oops! While in Print Preview, did you
suddenly notice that you had typed
‘unclear warhead’ instead of ‘nuclear war-
head’? Don’t bother about going back to
your normal view. Just click on the mag-
nifying glass button, and the pointer will
change to a cursor. Now you can edit your
document as you normally would.

Typing from  last change
Closed a document abruptly and lost
track of where you were? Don’t worry,
Word has an elephantine memory. It can
remember the place where you made
your last change. To open a document
and continue typing where you left off
when it was saved, open the document,
press [Shift] + [F5], and presto—you’re
taken to the exact position where you
had last made changes in the document.

Pasting from the Web
Are you working on a story and feel that
you simply must include that nice little
anecdote that you saw on the Web? Well,
a direct copy-paste into your document
could lead to strange formatting and
unhappy colour combinations. To trash
all the formatting that accompanies the
copied text, select the text you pasted and
press [Ctrl] + [Shift] + [N] and all the for-
matting is removed. Basically, this short-
cut assigns the default Normal style to the
copied text. Alternatively, you could press
[Ctrl] + [Spacebar] to remove any for-
matting that’s copied along with the text.

Quick select a sentence
You might want to select a particular sen-
tence for formatting or deletion. You can
select a sentence by pressing [Ctrl] and
clicking on any word in the sentence—
this selects the whole sentence. Also, you
can double-click to select a word, and
triple-click to select a whole paragraph.

Inserting page breaks
Assume you have a five-page document,
and you want to stop in the middle of
page three and begin again on the top of
page four. What’s the easiest way to go
about it? No, don’t press [Enter], [Enter],
[Enter]… until your paragraph moves to
page four. Why not? Well, if you later add
another word or sentence to page three,
it will push the text on page four further
down, and you’ll have to delete several of
the ‘Enters’ to make things work again.
The correct way to accomplish this is to
click at the end of the paragraph and
choose: Insert > Break and then Page Break.
This will insert a code that causes a new
page to start after it. A shortcut key for
this is [Ctrl] + [Enter] at the end of the
paragraph.

Password protecting documents
You can protect your documents by
assigning a password. But you can also
allow others to just view the document
(and not make any changes to it). Go to
Tools, select Protect Document option.
From the window that pops up, choose
the Forms option.

You should ideally provide a pass-
word, because the user can always go
back to Tools to unprotect the docu-
ment. If provided with a password, the
document becomes even more secure.
Now your user would be able to navigate
through the document but wouldn’t be
able to change anything.

Changing fonts using shortcuts
Changing the font size for a set of sen-
tences and resizing another set can be
cumbersome. You could use the key-
board to do the job of resizing instead of

relying on the mouse to change the point
size in the toolbar. [Ctrl] + [Shift] + [>]
increases font size, while [Ctrl] + [Shift]
+ [<] decreases it.

Switching cases
You can change the case of the text in a
jiffy using the keyboard. Press the [Shift]
+ [F3] combo, and the text toggles
between Title Case, UPPERCASE and
lowercase.

Modifying line spacing
If you change the indentation frequent-
ly, clicking on a button time and again is
not the smartest way to go about it. Use
the keyboard to do the same in a flash.
Press [Ctrl] + [1] for single spacing or
[Ctrl] + [2] for double spacing. You
could also type [Ctrl] + [1.5] to get one-
and-a-half line spacing.

Ad will come
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[Ctrl] + [A]: Select all
[Ctrl] + [B]: Bold 
[Ctrl] + [C]: Copy 
[Ctrl] + [D]: Font Formatting 
[Ctrl] + [E]: Center Alignment 
[Ctrl] + [F]: Find/Replace 
[Ctrl] + [G]: Go to 
[Ctrl] + [H]: Replace
[Ctrl] + [I]: Italics 
[Ctrl] + [J]: Justified Alignment 
[Ctrl] + [K]: Insert Hyperlink
[Ctrl] + [L]: Left Alignment 
[Ctrl] + [M]: Indent 
[Ctrl] + [N]: New document 
[Ctrl] + [O]: Open a document 
[Ctrl] + [P]: Print 
[Ctrl] + [Q]: Paragraph Spacing 
[Ctrl] + [R]: Right Alignment 
[Ctrl] + [S]: Save current document 
[Ctrl] + [T]: Hanging Indent 
[Ctrl] + [U]: Underline 
[Ctrl] + [V]: Paste 
[Ctrl] + [W]: Close document 
[Ctrl] + [X]: Cut 
[Ctrl] + [Y]: Repeat 
[Ctrl] + [Z]: Undo 

A to Z of shortcuts

Assign passwords to protect documents



Enabling viewing graphics
If you embed graphics or images in your
document, StarOffice Writer might show
them as frames with the filename
enclosed within. Don’t worry, it could be

that the option to view graphics is dis-
abled by default to enable optimal load-
ing of your document. (A document
that’s stuffed with graphics could take
ages to load.) To enable the option, click
on Tools > Options > Text Document > Contents.
Enable the ‘Pictures and Objects’ option
in the display section. Click OK to effect
the changes… and presto, your pictures
magically appear.

Saving as PostScript 
The advantage of a PostScript file is that
it can be printed from any machine, even
one that doesn’t have StarOffice installed.
To save a file as a PostScript file, click on
File > Print. Enable the ‘Print to File’ option
in the Print dialog box. Save the output
to a file with a .PS extension. Now you
can use the output file to print the doc-
ument from any system with or without
StarOffice.

Maximising workspace
When StarOffice loads, it starts up in a
window of its own and has all the elements
confined within that space. Opening a
Writer document within this would be
even more difficult to view. To maximise
the viewable area and to have a clear view
of the document, use the Integrated Desk-
top option from the View menu or just

press [Ctrl] + [Shift] + [I].This overwrites
the screen with only one visible window,
thereby maximising the view space.

Configuring toolbars
StarOffice Writer has a number of tool-
bars that it loads by default.Your desktop
will be a big mess if you let this happen.
It’s better to have only those toolbars that
you use often. You can do this by config-
uring your toolbars. To choose the tool-
bars that are to be loaded with StarOffice
Writer, go to Tools > Configure. Choose the
Toolbars tab and select the tools that you
would require the most.

Changing default paths
Most of the default settings can be
changed. Ditto with file locations. This
could prove useful if documents you
work on are distributed over different
locations. To change the default path for
StarOffice documents, click through Tools
> Options > General > Paths. Scroll down and
select the Work folder. Click on the Edit
button to change the default path and

change it to a directory of your choice.
Other folders could also be edited from
the list that shows up.

Removing page borders
In StarOffice Writer, the auto border is
enabled by default, and it can be quite
annoying. A document without a border
is always preferable. To change the
default settings, go to Tools > Autocorrect/

Autoformat. Under the Options tab, scroll
down to the Apply Border Item option.
Disable it and click OK to effect the
changes. Now you don’t have to be cir-
cumscribed by borders anymore.

Spell-checking in different 
languages
Occasionally, you might want to check
spellings for other languages compatible
with StarOffice Writer.You can spell-check
documents written in other languages just
as easily as you would check the  ones in
English. Click on Tools > Options > General >

Spelling > Language. Activate All
Languages under Check
Spelling. Click OK to exit the
dialog box. You can set the
language for the text by select-
ing it and clicking on Format >
Character > Font.

Recording your job
If you do repetitive format-
ting or use the menu quite

often for some purpose, you could record
the sequence of operations with the
Macro record option in Writer and exe-
cute the recorded code whenever you
want to perform the same actions. For
example, if you want to insert a picture
(or a series of pictures), you could record
the sequence of operations by clicking the
record in the Tools > Macro submenu and
save the macro with a specific name.
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STAROFFICE
This free Office suite comes with StarOffice Writer—a word processor with some good features

Enable viewing of pictures

Change the default settings to your liking

Uncheck the Apply Borders option
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LOTUS WORDPRO
A word processor that combines complex features and features of daily use with an ease-to-use interface that most 

word processors cannot match  

Creating auto-entry fields
Try typing this: ?^È?§. Easy? Now type
that again. Before you throw in the
towel, remember that you can set Word
Pro do such seemingly complicated
tasks. You can store frequently used
phrases in a glossary entry. To create
such an entry, select the text and click on
Edit > Glossary. Type a name for the entry in
the Glossary entry name box and click
Create. To use this entry, click on Edit >
Glossary, select the entry you wish to
insert and click on Insert. What could be
simpler?

Note: you can also bring up the glos-
sary window by pressing [Ctrl] + [K]

Anchoring to paragraph
If you’re a power user, you might want
certain things in your document to be
nailed in place. WordPro has options
that allow you to stick part of a graphic
or text to one place. If you want to beau-
tify a graph, image or a section of text,

you can use Frames. Click on Create >
Frame. Enter the frame width and height
in the respective boxes and click on OK.
To insert text in this frame, click within
the frame and type the text. To insert an
image, click on File > Import Picture. This
ensures that your text and your picture
doesn’t move anywhere if any reformat-
ting is done to the document.

Slashing the splash screen
This is another time-saver. Every time
you open the Word Pro application, the
splash screen pops up and irritates you.

To disable the opening splash and wel-
come screens, right-click the shortcut
that opens Lotus Word Pro and click on
Properties. At the end of the Target line,
type /q. To disable only the logo screen,
type /s. If Lotus is installed in C:\Lotus,
the command line would be C:\Lotus\word-
pro\wordpro.exe /q.

Working with master documents
When creating a new document using an
Application SmartMaster, Word Pro will
emulate the application’s environment
for creating that document. When you
reopen this document, Word Pro
returns to its native menu set. If
you would like to use an Application
SmartMaster, complete the following
steps:

1. Choose File > New Document
2. Choose the ‘Create from any

SmartMaster’ tab
3. Choose the Type of SmartMaster

that corresponds to the Application envi-
ronment that you would like to work in
(for example, ‘Lotus Ami Pro’, ‘Microsoft
Word’ or ‘Corel WordPerfect’)

4. Click on OK.

Changing default fonts
To change the default font of any of the
SmartMasters available with WordPro
do the following: Choose File > New Docu-
ment. Select the SmartMaster to be
changed and choose OK. Choose Text,
Text Properties from the pull-down
menus. Select the ‘Font’ tab (first tab on
the left) of the Text Properties InfoBox.
Change to the desired font, font size
and/or colour. Select the ‘Style’ tab of the
Text Properties InfoBox. Click ‘Redefine
Style’. Choose OK to close the Text Prop-
erties InfoBox. Choose File > Save As from
the pull-down menus. Change the file
type to ‘Lotus Word Pro SmartMaster
(*.MWP)’. Enter a description if desired.
Change the directory to the location

where the SmartMasters are stored. Type
the filename for the SmartMaster, then
press the [Enter] key. Answer when
prompted: “Would you like the name of
the editors who created this SmartMas-
ter kept anonymous by assigning all edits
to an editor named ‘SmartMaster’?”

Keeping track of versions
It always happens that you wish to revert
to something you had typed earlier, but
which you unfortunately lost. WordPro
allows you to keep track of the docu-
ments you work on, and you can use 

version control on your documents. To
keep track of document revisions, click
on Edit > Markups. This enables tracking of
document revisions. To review changes,
click on Edit > Review Marked Edits. This
relieves you of tracking changes and
reverting to any previous phase of doc-
umentation.

Enabling faster printing
Are you getting stuck while printing long
documents? Check to see if your back-
ground printing option is enabled. It’s
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Use Frames to anchor text

Working with versions

Disable the background printing option



not required for the document to be
printed. Select File from the menu bar,
then User Setup, then WordPro Prefer-
ences. On the Enable tab in the right
panel, scroll down to check if the Back-
ground Printing option is disabled.

Customising menu
WordPro gives you the option of either

loading a customised menu or its default
menu using the menu customisation
option. To restore the Menu Customiza-
tion option, choose File > User Setup, and
then click on Word Pro Preferences.
Then click the Default Files tab. Delete
the entry in the Default Menu File text
box and click OK. Word Pro will now
revert to the standard menu set.

Formatting bullets
The properties of a bullet, number, or
leading text can be different from other
text in the paragraph. Place the insertion
point at the desired bullet or number.
Click the right mouse button and choose
Text Properties.

Click the Bullets tab. Select ‘Edit on
page’. The cursor moves to the protected
space immediately to the left of the bul-
let or outline number. Make the neces-
sary changes.

When you resume working in the
text, Word Pro deselects ‘Edit on page.’

You should consider creating a style for
your changes, so you can apply this style
to the other elements.

Disable snapping to grid
Did you draw objects or insert pictures,
and found that everything gets stuck?
This could happen because WordPro is
aligning the objects to a grid that exists in
the background.

You can turn off this automatic align-
ment if you right-click somewhere in the
drawing frame, select Draw Properties,
and remove the check mark from the
Snap Objects To Grid checkbox in the
Misc. tab.

This is one feature by which WordPro
makes sure that your objects in the doc-
ument are in alignment.
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COREL WORDPERFECT
A lot of people swear by this word processor and claim it is the best when it comes to handling lond documents. Now, get more out of

the software with these nifty tips

Suppressing splash screens
If you work all day in WordPerfect, you’ll
soon find yourself getting tired of the
screen that pops up every time you open
the application. Here’s how you can kill it
for good. First locate the shortcut you use
to start WordPerfect. Right-click the
shortcut and choose Properties from the
menu. Place your cursor at the very end of
the filename in the Target text box. Tap
the space bar once, then type a colon (:).
Click OK to apply the change. The next
time you launch WordPerfect, you’ll see a
slightly faster start-up. It could be just a
few seconds that you gain, but when
you’re in a hurry, every second counts.

Placing your toolbars right
If working in WordPerfect is part of your
job, it’s better that you customise the

looks of the working area of the docu-
ment by placing the toolbars at locations
where they come in handy and don’t
occupy much space. Instead of placing all
the toolbars row by row, put one on the
right panel and one on the left panel so
that you have more space to work. For
example, you could place the Print Pre-
view toolbar on the left edge and the page
toolbar on the right, leaving the default
toolbar at the top, below the menus. This
way you could regain valuable screen
space and be better organised.

Changing default font
When WordPerfect is installed, it choos-
es Times New Roman as the default font
for all the documents that you create.
You could change the default font by
doing the following. Choose File from

the menu and select Document from the
list. Choose Document from the slide
menu. Decide on your choice of font,
press the Settings button and click on
‘Set face and point size as default for all
documents’. You’re done. All the docu-
ments that you create would be in your
favourite font. Just make sure you don’t
select a typeface like Bernhard Fashion
BT, or you may have to visit an optician
between typing sessions.

Smart way to use QuickCorrect
Typing something that’s repetitive is
plain boring. It becomes even more

Customise the menu to your liking

Change the settings of your default font

Disable the Snap
Objects to Grid for
more flexibility
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painful when the phrase happens to be a
long one and has some special symbols.
WordPerfect’s QuickCorrect feature lets
you create and add ‘shortcut’ entries.
Click Tools > QuickCorrect. Type ‘ilu’ in the
Replace box and type ‘I love you!’ in the
With box.

Click Add Entry, and click OK. Now
every time you type ‘ilu’ in WordPerfect,
out pops ‘I love you’! Just don’t let your
boss catch you practising with this par-
ticular example at office.

Switching documents 
There are three basic ways to switch
between open documents. One way is to
click Window, then click on the docu-
ment you want to switch to. The second
way is to add a button to your toolbar that
lets you cycle through open documents.
Next Window switches you to the next
lower document in the Window list. Pre-
vious Window switches to the next high-
er document in the Window list. The
third method to cycle through documents

is to use key-
board short-
cuts. The
default key-

board assigns [Ctrl]
+ [F6] to open the next document and
[Ctrl] + [Shift] + [F6] to open the previ-
ous document.

Sorting files in Open Dialog 
Files can be sorted in the open dialog box.
When you click File > Open, the open dialog
box pops up and asks you to choose a file
to open. This interface is similar to Win-
dows explorer and hence gives you the
option of sorting files and grouping them
according to the file type. You could
arrange the files in this open dialog box as
you would do with Windows Explorer.

Using character map
Using WordPerfect’s QuickFinder or
Windows Find, search for a file called
CHARMAP.WPD. For WP9, it’s in the
\program files\Corel\WordPerfect Office
2000\ programs folder. For WP8, it’s in
the \Corel\Suite8\Programs folder. Open

it in WordPerfect, print it out and keep it
handy.

Making the document fit
If you’ve been wondering how to squeeze
those last few lines spilling over to the 11th
page back on to page 10, use the Make it

Fit command. Select the pages that you
want to fit and click on Format > Make it Fit.
You can then select which of the page
parameters (margins, font size, line spac-
ing, etc) may be modified for fitting the
text. Click on Make it Fit to apply.

Labels in a jiffy 
Here’s how you can create labels easily.
In an empty document, click on Format >
Labels and choose a label definition from
the list. You now get a blank label. Click
on Tools > Address Book, choose the records
in a book, or click on Address List to
make a list from several books. Click on
Insert. The selected addresses will be 
formatted as labels.

Protect paragraph headings
Block Protect prevents selected passages
of text, such as a paragraph heading and
the text of the paragraph, from being
split across two pages. Move the cursor
to the beginning of the text to be select-
ed. Select (or block) the text you want to
keep together. Select only the paragraph
heading and the first two lines of the
paragraph text. Now click Format > Keep Text
Together. Select the Block Protect option.
Choose OK or press [Enter].

Managing Table of Contents
A Table of Contents (TOC) is an index
that shows the sections dealt with in a
document. Creating TOCs helps make
navigation to different sections of a doc-
ument easier. When creating a TOC, you
must first decide on the levels of the
entries. Level 1 heading, for instance,
could be article title, Level 2 heading
could be section titles, and Level 3 head-
ing could be subsection titles. WordPer-
fect’s Table of Contents can have as many
as five levels. Each level has its own style,
which you can edit or leave as is, governed
by WordPerfect’s default parameters. The
TOC function draws on a Feature Bar,
which enables you to mark any of five lev-
els of the TOC, and also provides the but-
tons to Define or Generate the table.

Creating a table Header Row
Tables are inevitable parts of many docu-
ments. If you’re working with a table that
continues on to several pages and you
want the heading of the table to appear
on each page, you can create a Header
Row. Move the cursor into the top row of
the table. Select (block) the rows that are
to appear in the header row. Choose Table
Format or press [Ctrl] + [F12] and
choose the Row selection. Select Header
Row and choose OK to return to the doc-
ument window. Now, every page that the
table skips through would have the same
header row, which makes your job easier.
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Select the option to keep text together

Add buttons 
to switch 
documents

[Ctrl] + [F8]: Change page margins
[F9]: Change Font and Font size
[Ctrl] + [F1]: Spell check
[F2]: Open the Find and Replace
dialog box
[Ctrl] + [Shift] + [Z]: Undelete (the
last three deletions)
[Ctrl] + [F5]: Draft View
[Alt] + [F5]: Page View
[Alt] + [F3]: Reveal Codes on/off
[Ctrl] + [W]: WordPerfect character
set dialog box

WordPerfect Shortcuts



Selecting non-contiguous words
In earlier versions of Word, you could not
randomly select words. But now, with the
same technique you would use to select
non-contiguous files in Explorer using the
[Ctrl] key, you can select words in a doc-
ument randomly.

Click the first word to be selected and
select the next word anywhere in the doc-
ument by holding the [Ctrl] key and
there—you have a random selection now.

Faster word count
Word 2002 allows you to track word
counts as you work on your document.
You don’t have to strain yourself to click
Tools > Word Count. Instead, you can use the
new Word Count toolbar. On the View
menu point to Toolbars and click on
Word Count. Click on Recount any time
you wanted an update on the word
count. You will now see the usual statis-
tics that earlier versions of Word popped
up when you clicked the Tools > Word Count
option. You can also use the shortcut
keys, [Alt] + [C] to recount and [Ctrl] +
[C] for the new word count to appear in
the toolbar.

Displaying more of the recent
documents
Often you would be working on multiple
documents and your job might require
opening documents that were worked on
recently. But the recently used files list on
the Files menu just shows four.You could
lengthen the list that Word shows up in
the Files menu by changing the More
documents option. On the Tools menu,
click on Options. Click the General tab if
its not highlighted. In the Recently Used
file list box, specify the number of files
you want to appear in the New docu-
ments pane. Click OK to make the
changes effective. Now Word shows you
the number of files you had specified,
that were recently worked on.

Continue numbering after 
paragraph breaks
At times, you will encounter situations
where you need to insert a paragraph by
breaking a numbered list and at the same
time, ensure that the list continues after
the paragraph is inserted. Word 2002
allows you to do the same. Click the Num-
bering button on the Formatting toolbar.
When the Autocorrect Options Smart Tag
appears, choose the Continue Numbering
option to resume your numbering list
starting with the next number from where
you had inserted your paragraph.

Documents in a single window
Word 2002 now allows you to have mul-
tiple document interfaces (MDI) instead
of the earlier single document interface
wherein it added multiple tabs for dif-
ferent documents in the Taskbar. To have
an MDI, disable the Windows in Taskbar

option from Tools > Options. Here, clicking
on the Views tab. This way all your doc-
uments remain in the same window and
you will not see too many icons on the
taskbar if you happen to open more than
one document.

Shortcuts to Task Pane
Working with the new Task Pane
requires you to use the mouse a lot.
Instead, you can assign a shortcut for the
same and could either bring up or hide
the task pane. Choose Tools from the
menu and click on Customize. Click on
Commands tab, and click the Keyboard

button near the bottom of the dialog
window. Select the View option in the
categories, which is to the left, and scroll
through the list that’s available on the
right side to locate View Task Pane.
Choose a new shortcut that you wish to
use in the Select New shortcut key field.
Assign any shortcut and click OK to
make the changes effective. Now, you
could press the assigned shortcut key to
bring up or hide the Task Pane.

Printing multiple pages
Word 2002 is in a sense eco-friendly and
you can print multiple pages on a single
sheet of paper. To do so, go to File > Print to
bring up the print dialog. Click the
Zoom button placed in the bottom right
corner of the dialog. Select the number
of pages that you would like to print per
sheet and click OK. Normally, two per
page with 12-point size makes it readable
without compromising much.

Translating into other languages
Word 2002 also comes with a simple word
translator that can convert to other lan-
guages. However, the translator is basic, so
don’t expect much. To convert a sentence,
select the sentence and choose Tools and
then Language. Select the Translate option
to bring up the Translate Dialog window.
Pick the required language dictionary
from the dialog and then click Go.You will
now get the required translation.
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WORD 2002
The latest version of Word that ships with Office XP now comes with a number of user-friendly options

One window for all your docs

Assigning shortcut for task pane
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YATISH SUVARNA

W
hat would you do if your mouse or key-
board hangs when you’re in the middle of
some important work? Bang on it in frus-
tration, in all probability. Reliable input

helps ensure reliable output, so the quality of the
input devices you use with your computer is cru-
cial.

Many different types of input devices exist,
such as keyboards, mice, trackballs and joysticks.
The mouse has undergone a design renaissance
lately. Newer models have been contoured to fit
the human hand comfortably. Apart from the
usual two-button and three-button mice, there are
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mice with built-in wheels that can be used
to scroll through large display windows.

For many years, the design of comput-
er keyboards remained relatively standard:
alphanumeric keys arranged in tradition-
al QWERTY fashion with some addition-
al, computer-specific keys. Newer
keyboards reflect concerns such as
ergonomics. ‘Natural’ keyboards, for
example, divide the familiar horizontal
rows of keys into two discrete vertical
halves, which allow you to type with your
arms at a more comfortable angle. Many
keyboards provide wrist support. Some
include built-in pointing devices—usual-
ly a touch pad. Clearly, input devices have
changed in recent years—both in looks
and in technologies. This review will help
you choose one that matches your person-
al needs and preferences.

MMIICCEE
We tested 27 mice that covered regular
mice along with optical ones.

BBuuiilldd  qquuaalliittyy
Input devices tend to get roughed up while
being used, so they need to be sturdy. The
MMiiccrroossoofftt  IInntteelllliimmoouussee did very well here.
There wasn’t a single crack or any defor-
mation in this device. The same goes for
the Trackman Marble FX that cakewalked
through this test. Other contenders who
passed the test with flying colours includ-
ed the Anubis Autoscroll
mouse, Maple Wheel
3D mouse, Typhoon
3D optical mouse, and
Maple Scrolltrack 4D.

PPeerrffoorrmmaannccee
People who are into
gaming or hardcore
graphics love the preci-
sion that a high-resolution
mouse provides. The 
LLooggiitteecchh  WWhheeeell  MMoouussee optical proved
to be a laudable performer here—it felt
great while playing games and also while
editing images. For the low-end user the
Maple Eagle mouse is a good choice at a
resolution of 520 dpi. The Microsoft Intel-
limouse is good enough for gaming and
image-editing but sometimes loses track
while executing quick movements. The
Maple 2Wheel 4D mouse also proved to be
good in this area with acceptable precision.

Mention must be made of the Logitech
cordless MouseMan wheel, which was very
precise in its movements not only in 
normal Windows use but also in hardcore

gaming. The Logitech Trackman Marble FX
also is very good for the precision-minded
user, though playing games can be a bit
tricky. The mice that were low on precision
were the Typhoon Scroll Mouse 4D,Anubis
Mouse Mena 2 and Turbo Mouse 911.
These mice went off track quite often dur-
ing heavy image editing and fast gaming.

FFeeaattuurreess
The Microsoft Intellimouse doesn’t disap-
point in features. It lets you effortlessly
breeze through the Net, and all your work

and entertainment applica-
tions. It works on almost
any surface and stays pre-
cise because there are no

moving parts. It is also
very easy to

instal l—just
plug it into
the USB
port and it
automati-

cally gets
detected. The

buttons could
have been placed in a

better way though. For instance, the thumb
button could be placed a bit lower, to make
the device more comfortable to use.

The Trackman Marble FX has a sensor
that records the position of the ball many
times per second by continuously bounc-
ing light off the red sphere. The four but-
tons can be configured with the installed
program to be any key on the keyboard, or
other useful commands (double-click, drag
lock, etc). These ‘extra’ buttons were found
to be quite practical, saving some time and

effort. The only negative thing about this
mouse is that the shape of the mouse is
designed specifically for the right-handed.

An interesting thing about the iFeel
mouse is that it comes bundled with
immersion software. However, we found
that the usability and features offered by
iFeel technology—which allows you to
actually feel different sensations through
the mouse, depending on where your cur-
sor is—does not serve any practical purpose
for the home user or for any application.All
this technology does is that it makes the
mouse vibrate in different pre-stored or
customisable tones: you can configure the
mouse to feel as if you were working over
glass, rubber etc. The Maple 2Wheel 4D
Mouse also has incorporated some inter-
esting features like Net jump and Lucky
jump, which put into one convenient grid
commonly used tasks for Web browsing
and Windows environment, respectively.

The Dot Com mouse has a feature
called Live and Direct, which through your
Internet connection brings headlines to
your Dot Com Mouse display, and instant-
ly produces a link to the corresponding
Internet site, which is activated when the @
button is pressed. You can easily get access
to the sites that offer the detailed informa-
tion you need. Because it is shown on a
separate display, you can always keep your
normal work on. The usability of the
device is questionable because mostly peo-
ple prefer the monitor to surf the Net,
rather than any other device that offers
you a display area of less than a couple of
inches. The Hitech Balless Internet mouse
was very low on features—it did not
include any driver software to configure ➜

The system used to evaluate the input
devices consisted of a Celeron 466-based
computer with 64 MB SDRAM. The operat-
ing system was Windows 98 SE, loaded on
a cleanly formatted system. The drivers of
each device were loaded as the testing
was done, and uninstalled before connect-
ing the next one. This was to ensure that
the drivers didn’t conflict with one another.
Mice
We tested each mouse for its build quality
and features. We also took into considera-
tion its customisability. Extra features were
rated for the amount of help they provid-
ed, not just for mere presence. If the
mouse was detected and installed auto-

matically, extra points were awarded. The
most important factor considered was the
ergonomics and the feel of the device. To
test the sturdiness of the devices, we
decided to do a ‘drop test’ on the mice by
dropping it from six feet. 
Keyboards
Comfort is the ‘key’ thing here, because the
keyboard is a component that is generally
used for long periods of time. The position
of the wrists when it rests on the keyboard
is very important, so is the layout of keys.
We also looked at the quality of keystrokes.
The smoothness and placement of impor-
tant keys and shortcut keys, and sturdi-
ness were also taken into consideration.

Microsoft IntelliMouse

TEST PROCESS
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the shortcut keys and there wasn’t any
manual included either.

EErrggoonnoommiiccss
How easy are they on your hands when
used for long stretches of time? This is a
crucial consideratin when it comes to
selecting an input device. Since using a
mouse involves long stretches of con-
stricted hand movement, faults in its
design can cause repetitive stress injuries
to your hands and wrist. Apart from good
grip and non-slip surfaces, the placement
of extra buttons, position of rollers, etc
also makes a difference. More than the
main mouse button, these are the buttons
that will require you to make non-stan-
dard moves with your fingers, which can
result in extra stress. And if you are left-
handed, then you should also check
whether it can be used comfortably by
both right- and left-handed people.

The TTrraacckkmmaann  MMaarrbbllee  FFXX really packs
a punch as far as comfort is concerned. It
grips the desk firmly thanks to its rubber
base, and one can comfortably rest one’s
palm on top of the device. The rubber also
prevents the mouse from slipping and 

sliding. The Logitech Cordless MouseMan
Wheel is also ergonomically shaped. It fits
your palm very nicely and you are not
restricted by the presence of a cord.

VVaalluuee  ffoorr  mmoonneeyy
No matter how advanced the features or
technology, an input device should give
good value for money. If it’s priced higher
than the others but still provides you with
good features, it’s worth considering. The
Logitech Cordless MouseMan Wheel
proves this point. This device is priced a
bit higher than the other mice in its range
but provides you with great features, good
looks, precision and frees you from the
wired world by letting you go cordless. If
you are looking for a low-priced mouse
that offers you good features, the MMaappllee
WWhheeeell33DD mouse should be a good
choice—at just Rs 600, it is cheaper than
the other scroll mice in its category. But
the Anubis Mouse Mena 3 and the Maple
Eagle mouse really break the price barrier
by providing mice that have rock bottom
prices. The Maple Eagle mouse feels com-
fortable and is quite precise; the price is
the icing on the cake.

To test the sturdiness of the mice we
decided drop them thrice from a height
of 6 feet one by one and then checked
for any deformation. TThe mouse that
really couldn’t stand the test was the
Turbo Mouse 911, which got totally
decimated during the test. The mouse
lost its hood in the first drop itself. The
buttons of the Anubis Mouse Isis came
out of their sockets and was unfixable.
The Dot Com mouse faced the same
plight while the buttons were rendered
useless after being dropped thrice. The
Logitech cordless mouse man wheel
survived the test with a broken ball cap.
The trackball of the Maple Scroll Track
was dislodged from its socket but it
was fixed back and no parts were dam-
aged. The mice that romped successful-
ly through this test were the Microsoft
Intellimouse, which didn’t suffer any
cracks or broken parts, and the Log-
itech Trackman Marble FX which proved
to be of excellent build quality. 

Drop Zone

➜

Specifications

MMaannuuffaaccttuurreerr
Anubis
Anubis
Anubis
Anubis
Anubis
Logitech
Logitech
Logitech
Logitech
Logitech
Logitech
Maple
Maple
Maple
Maple
Maple
Maple
Maple
Maple
Maple
Microsoft
Typhoon
Typhoon 
Typhoon 
Typhoon 
Typhoon
NA

MMooddeell
Autoscroll Mouse
Mouse Isis
Mouse Mena 2
Mouse Mena 3
Turbo Mouse 911
Cordless Mouseman Wheel
First Mouse Plus
iFeel Mouse
Mouseman Wheel Optical
Trackman MarbleFx
Wheel Mouse Optical
2Wheel4DMouse[WWW 23]
Cable Free[IRW 25]
Eagle Mouse[OK 720]
Optical Great Eye [WOP 35]
Scroll Track[WWT 5]
Scrolltrack4D[WWT 13]
Wheel 3D Mouse[SWW 23]
Winbest4D Plus[WWW 11]
Wireless Radio3D Mouse [RFSW 25]
Intellimouse Explorer
Dot Com Mouse
3D Optical Mouse
Cordless FM Pro Mouse
Scroll Mouse 4D
Unplugged Mouse( RF)
Balless Internet Mouse

CCoonnttaacctt
Hitech Computers
Hitech Computers
Hitech Computers
Hitech Computers
Hitech Computers
Rashi Peripherals
Rashi Peripherals
Rashi Peripherals
Rashi Peripherals
Rashi Peripherals
Rashi Peripherals
Micro Masters
Selathaar Industries
Selathaar Industries
Selathaar Industries
Selathaar Industries
Selathaar Industries
Selathaar Industries
Selathaar Industries
Selathaar Industries
Mnemonic Systems
Hitech Computers
Hitech Computers
Hitech Computers
Hitech Computers
Hitech Computers
Micro Masters

EE--mmaaiill
bom@hitechit.com
bom@hitechit.com
bom@hitechit.com
bom@hitechit.com
bom@hitechit.com
ho@rptechindia.com
ho@rptechindia.com
ho@rptechindia.com
ho@rptechindia.com
ho@rptechindia.com
ho@rptechindia.com
farr@bom.vsnl.net.in
marketing@maple.cu.in
marketing@maple.cu.in
marketing@maple.cu.in
marketing@maple.cu.in
marketing@maple.cu.in
marketing@maple.cu.in
marketing@maple.cu.in
marketing@maple.cu.in
mnemonic@vsnl.com
bom@hitechit.com
bom@hitechit.com
bom@hitechit.com
bom@hitechit.com
bom@hitechit.com
farr@bom.vsnl.net.in

PPhhoonnee
022-4914642
022-4914642
022-4914642
022-4914642
022-4914642
022-8260258
022-8260258
022-8260258
022-8260258
022-8260258
022-8260258
022-3880597
044-8252275
044-8252275
044-8252275
044-8252275
044-8252275
044-8252275
044-8252275
044-8252275
022-8010871
022-4914642
022-4914642
022-4914642
022-4914642
022-4914642
022-3880597

PPrriiccee  ((RRss))  
330
225
110
110
480
4,500
950
3,600
3,400
6,000
NA
525
1,200
110
1,800
850
850
375
950
1500
3300
3100
1150
1550
440
2800
900

RRaattiinngg
BB
BB--
BB--
BB
CC++
AA--
BB
BB
BB++
BB++
BB++
BB
CC++
BB
BB--
CC++
BB--
BB++
BB--
BB
BB++
BB--
BB++
BB--
BB--
BB
CC++

IInntteerrffaaccee
PS/2
PS/2
PS/2
PS/2
PS/2
Radio
PS/2
USB
Optical
PS/2 or USB
Optical
PS/2
Radio
PS/2
Optical
PS/2
PS/2
PS/2
PS/2
Radio
Optical
Optical
Optical
Radio
USB
Radio
PS/2

TTeecchhnnoollooggyy
Mice
Mice
Mice
Mice
Mice
Mice
Mice
Mice
Mice
Trackball
Mice
Mice
Mice
Mice
Mice
Trackball
Trackball
Mice
Mice
Mice
Mice
Mice
Mice
Mice
Mice
Mice
Mice

Playing with the Mice
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KKEEYYBBOOAARRDDSS
We tested 11 keyboards that also included
a few cordless ones.

BBuuiilldd  qquuaalliittyy
As far as build quality is concerned, the
Samsung SDL1500 feels great. The keys can
withstand a lot of beating even after pro-
longed usage. The noise level is minimal,
and the buttons give a good feel while typ-
ing. The keys do not attract much dust
either. The base of the keyboard grips the
desk very nicely. The Acer Acufeel keyboard
also can withstand a lot of rough use with-
out complaining. The build quality of the
keyboard is excellent and has extra protec-
tion to protect the membrane, which has
the circuit etched on it, from direct contact
from dust and liquid. The keys feel smooth
while typing and make very low noise. The
Logitech cordless freedom navigator is also
a good choice for people who enjoy good
build quality. This keyboard feels good-n-
chunky and the noise while typing is
almost nil.

PPeerrffoorrmmaannccee
The quality of keystrokes is
an important character-
istic. A good key-
board has a nice
feel to it while you
type on it—the
keys get pressed
smoothly and you
don’t have to bang on
them. And of course, it
doesn’t make a loud racket when you type.

You can work faster if the shortcut keys
are placed so that they can be executed faster.
So if you want a keyboard that performs
well, look for the smoothness and placement
of important keys and shortcut keys.

We found the LLooggiitteecchh  CCoorrddlleessss  FFrreeee--
ddoomm  NNaavviiggaattoorr, a mouse-and-keyboard
combo, very good where it came to per-
formance. The normal keys are well laid out
and so are the shortcut keys. The feel of the
keyboard while typing is very good. The
keyboard feels comfortable while typing
and the palm rest can be detached if you
want more desktop space. The soft touch
side panels offer a comfortable grip while
the device is being used. The Maple Inter-
net Media keyboard too has a good layout
of keys and the device includes an e-mail
indicator. It has a standard keyboard lay-
out with eight exclusive function keys, plus
15 dual function Intelli-keys for multime-
dia, Internet and programmable functions.

FFeeaattuurreess
Most of the keyboards that we tested were
feature-rich, but the ones that really stood

out were the
Microsof t
I n t e r n e t
Ke y b o a r d

Pro, Log-
i t e c h
Deluxe

104 and the
L o g i t e c h

cordless free-
dom navigator.

The Microsoft
Internet Keyboard

Pro offers 19 time
saving hot keys and a

pair of USB ports. It fea-
tures two USB ports that allow

users to easily plug USB devices, such as
scanners and game controllers, directly
into the keyboard, eliminating the need to
reach behind the PC to swap peripherals.
Internet hot keys allow users with Internet

access to launch a
browser and surf the Web directly from the
keyboard. There are Internet, e-mail and
multimedia hot-keys. In the Logitech
Cordless Freedom Navigator there are
three sets of small, rubberised keys to
access/control your CD/DVD playback,
open your browser, and put your PC into
standby mode. The Logitech system works
on radio frequencies, therefore it is non-
directional. This saves you from the worry
of pointing the device at the sensor in
order to use it. Logitech has included an
automatic ‘sleep mode’ feature to preserve
battery power while the units aren’t in
active use.

VVaalluuee  ffoorr  mmoonneeyy
The SSaammssuunngg  SSDDLL11550000 gives you great
value for money because though the key-
board does not include features that are
found in the high-end keyboards, it still
provides you with the normal features that
a SoHo user would require. The same goes
for the Acer Acufeel, which is also very com-
petitively priced and is a great choice for the
value-minded consumer. Logitech deluxe
104 provides you with one-touch Internet
access and a space-saving design. The keys
feel very comfortable. The gently curved
palm rest provides adequate wrist support
and can be detached for extra desk space.
The Logitech Deluxe 104 keyboard is one
of the very economical keyboards around.

Specifications

IInntteerrffaaccee
PS/2
USB
PS/2
PS/2
PS/2
PS/2
PS/2
PS/2
USB
PS/2
PS/2

MMaannuuffaaccttuurreerr
Acer
Logitech 
Logitech 
Maple
Maple
Maple
Maple
Maple 
Microsoft
Samsung
Typhoon

MMooddeell  nnaammee
Acufeel
Cordless Freedom Navigator
Deluxe 104
Internet media keyboard [MCK 2000]
Internet multimedia keyboard [MCK 800]
Multimedia keyboard Pro [EKB 804]
Universal keyboard [MCK 500]
Eagletouch [MCK 800 01]
Internet keyboard pro
sdl1500
Slim Internet keyboard

RRaattiinngg
BB
AA--
BB
BB--
BB--
BB
BB--
BB
BB
BB++
BB--

EE--mmaaiill
farr@bom.vsnl.net.in
ho@rptechindia.com
ho@rptechindia.com
marketing@maple.cu.in
marketing@maple.cu.in
marketing@maple.cu.in
marketing@maple.cu.in
marketing@maple.cu.in
mnemonic@vsnl.com
farr@bom.vsnl.net.in
bom@hitechit.com

PPhhoonnee
022-3880597
022-8260258
022-8260258
044-8252275
044-8252275
044-8252275
044-8252275
044-8252275
022-8010871
022-3880597
022-4914642

PPrriiccee  ((RRss))
300
7,750
600
775
1,100
1,800
475
1,500
3,000
500
900

CCoonnttaacctt
Micro Masters
Rashi Peripherals
Rashi Peripherals
Selathaar Industries
Selathaar Industries
Selathaar Industries
Selathaar Industries
Selathaar Industries
Mnemonic Systems
Micro Masters
Hitech computers

Stroking the Keys

Microsoft Internet Keyboard

Samsung SDL1500: 
Value for your money



111

CONCLUSION
MMIICCEE
The LLooggiitteecchh  CCoorrddlleessss  MMoouusseeMMaann  WWhheeeell
is a good choice if price is not an issue.
With the freedom of not being tied down
by wires, the Logitech Cordless MouseMan
features very good accuracy and an
impressive set of features that can be con-
figured through the driver. This mouse is
ideally suited for the power user who is
heavily into graphics, gaming and in-
house presentations. For the value-con-
scious, the MMaappllee  EEaaggllee mouse is a great
choice because it is good enough for 
normal Windows
use. Though the
build quality is pret-
ty average, it offers
good value for
money.

KKEEYYBBOOAARRDDSS
The LLooggiitteecchh  CCoorrddlleessss  FFrreeeeddoomm  NNaavviiggaa--
ttoorr is a good choice if price is not an issue.
This keyboard-and-mouse combo is ideal

for corporate presentations. Microsoft
Internet Keyboard Pro is also a good
choice because it comes with a lot of short-
cut keys and there are two built-in USB
ports. For the value-conscious user, the 
SSaammssuunngg  SSDDLL11550000 is a great choice. It
provides you with excellent build quality,
and though it does not include fancy fea-
tures provided by high-end keyboards, its
affordable price makes it a great choice.

Tablets are hard, plastic devices that
look like mouse pads and come in a
variety of sizes. A tablet comes with a
pen-shaped stylus, which you can use
to draw on the tablet. Many tablets are
pressure-sensitive, which means that
when you press hard on the tablet, you
will see the effects of the extra pressure
onscreen.  

For example, if you were drawing a
line, for example, you would see it get
darker by pressing harder on the tablet.
People who work with a lot of graphics
usually use high precision tablets. With
tablets, a digital imaging artist can draw
things that would be very difficult to
draw with a mouse. Some tablets even
detect the angle of the pen, thus allow-
ing users to change the thickness of the
line drawn by simply tilting the pen. If
you are regularly working with Adobe
Photoshop, then you know that you
can easily create accurate paths with a
tablet. You may take some time getting
used to a tablet, but once you do, it is
much faster and smoother.

Tablet and Pens

1/2 page H. AD

Logitech Cordless
Freedom Navigator

Logitech Cordless Mouseman
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P
lease don’t rush out and buy a laser printer.
If you are looking for a cheap solution for
colour printing, if you intend to use your
printer only occasionally, or if speed is not of

the essence and quality is low on your priority
list, we advise you to look elsewhere.

On the other hand, if you want impressive
quality printouts and need to print thousands of
pages in a month, you’ve come to the right place.
The laser printer is a reliable workhorse that not
only offers amazing speeds but also extremely
low costs per page printed.

Laser printers have long been the mainstay
of huge corporations and medium-level organ-
isations because of their work capacity and out-
put quality. Now they are turning out to be a
feasible alternative even if you are a small office
owner or work from home, with considerably
lower prices and a wider range of options to
choose from.

While inkjets offer a clear advantage price-
wise, lasers continue to have the upper hand
when it comes to print quality. The technology

they use ensures highly accurate printouts that
are completely dry, so there’s no scope for
smudging. These printouts are water-resistant
and will last longer than inkjet printouts without
fading.

Lasers also have an edge over inkjets when it
comes to handling non-regular media such as
envelopes, cards, labels and tags. And though
consumables are expensive, they are worth it—a
single toner cartridge has the capacity of print-
ing anywhere between 3,000 and 10,000 pages of
excellent quality text.

Keeping the needs of SoHo users in mind,
only black-and-white laser printers costing less
than Rs 50,000 have been tested. These included
10 printers from six companies. Canon and
Xerox were not able to participate, as they are on
the verge of launching a new laser line-up, and
they didn’t want to send models that would be
discontinued within a month’s time.

SSppeeeedd
When talking about laser printers, the first thing
you generally think about is speed, especially if
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A new breed of laser
printers offers great
print quality at lower
prices. Are you set to
utilise the laser
advantage? 

PPhhoottooggrraapphh::  Rahul Sharma

IN TEST: 10 LASER PRINTERS

In Black&&White



you need to print large volumes and/or are shar-
ing the printer over a network. If the printer is
not fast, you’d end up wasting a lot of time just
waiting for your documents to print and proba-
bly hold up the prints fired by other users on the
network.

The fastest printer that we received was the
LLeexxmmaarrkk  OOppttrraa  MM441122, which was able to print
text at a splendid rate of 16.61 prints per minute
(ppm). This printer had the most robust build
compared to the others in the comparison test,
that would give the printer a sturdy paper path.

The first runner-up was Hewlett-Packard’s
LaserJet 1220Se. This one was able to print the
text document at the rate of 14.1 ppm. The next
printer that came close was Hewlett-Packard’s
LaserJet 1200, with a speed of 13.5 ppm.

This was surprising as we were expecting
both the Hewlett-Packard models to achieve
almost the same score as they belong to the same
1200 series of printers and use the same print
engine. The only difference between these print-
ers is that the LaserJet 1220Se comes with the
scanning assembly as a standard part and the
LaserJet 1200 doesn’t. Other printers that were
able to come close to these scores were the Sam-
sung ML 6060N and the Wipro Laser 1500 that
scored a speed of 11.89 ppm and 11.96 ppm,
respectively.

In printing the vector images, the LLeexxmmaarrkk
OOppttrraa  MM441122 again took the overall position by
printing 13.44 copies of prints in a minute. This
was a very crucial test, and most of the printers
were either unable to print this document or
started to spool the print for more than 1 hour.
This could be because the printers were not Post-
Script enabled or the drivers supplied with these
printers did not contain support for PostScript
printing.

The printers that were able to print these
documents were the Lexmark M412 that was
able to print the document the fastest, the
Hewlett-Packard LaserJet 1200, the Hewlett-
Packard LaserJet 1220Se.

The Epson EPL 5800 and the Epson EPL
5700L weren’t able to print the exact image. That

means the printer first spooled the entire docu-
ment before printing the vector image. But
unlike the other printers, the EPL 5700L printer
was not able to continue with printing. After
printing the first page, it again started the entire
spooling process for the second page.

This definitely was not practical, as this would
take a long time to print a desired number of
pages. The Epson EPL 5800 was able to take 6.90
prints in a minute, but was not able to print the
exact image that was submitted for printing.
Both the Hewlett-Packard printers did well and
were able to print the vector images with ease but
not as fast as the Lexmark Optra M412.

The Hewlett-Packard LaserJet 1220Se was
able to print 7.40 prints of the vector printout in
a minute, in contrast to the Hewlett-Packard
LaserJet 1200 that was able to take 6.84 prints in
the same amount of time.

Next, we logged the time taken to print
images. There wasn’t much difference with
regard to the text print timings. The only differ-
ence noticed was the printer’s spooling time that
was more for image prints, since the file size of
images is greater than text files.

Here too the fastest was the LLeexxmmaarrkk  OOppttrraa
MM441122, which took 15.82 prints in a

minute. The printer that came second
was the Hewlett-Packard LaserJet 1220Se,

with 13.39 copies of the image in a minute;
and the Hewlett-Packard LaserJet 1200 that was

able to print 12.05 copies in a minute. These
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We evaluated each printer’s perform-
ance on two basic criteria: print speed
and image quality. To ascertain the
print speed we logged the time taken
to print 
1. A sample document file consisting
of five sample letters, each containing
text and a graphical logo, printed in
black and white and greyscale mode. 
2. A text document prepared in
Microsoft Word. A 100 copies of this
page were fired.
3. A page containing vector images
(100 copies printed). The file had a full
bleed size and a thumbnail-sized vec-
tor image. 
4. A document containing an image,
which was printed in normal mode
(see image by the side).

Similar documents were used to
ascertain the image quality both in
terms of text reproduction as well as
replication of image and printing in
variable shades of grey. We also

checked for quality in the vector
image. 

Points were also awarded for other
characteristics such as sturdy build
quality, thorough documentation, bun-
dled software, number of paper trays,
transparency printing, dual-sided print-
ing, economy mode support, post-
script printing, etc.

TEST PROCESS

HP Laserjet 1200: Gives good speeds



■■ sseelleecctt~~tteesstt  ddrriivvee

July 2001114

printers were followed by the Wipro Laser
1500, capable of printing 11.01 copies of
the image in a minute. The Samsung ML
6060N wasn’t able to keep up, printing
only 10.85 prints in a minute. The Epson
range of printers fared quite badly here.
The EPL 5800 was able to print 9.52
copies of the image in a minute, and the
Minolta PagePro 1100 gave 9.59 prints a
minute.

The printer that stood out, as far as
speed goes, was undeniably the LLeexxmmaarrkk
OOppttrraa  MM441122, with the HPs following close
behind.

IImmaaggee  qquuaalliittyy
Graphics image: The Lexmark OptraE312
printer was able to easily replicate details
present in the image. The Epson EPL
5700L too was able to bring out similar
image quality as the Lexmark, but for the
horizontal stripes that were made by the
drum of the printer. The printer, when
delivered to us for testing, was not in work-
ing condition and needed to be serviced by
a technician before we actually ran the
tests.

The Hewlett-Packard range of printers
were able to capture details in all other
aspects of the image such as the back-
ground, the wrinkles on the face, the folds
on the sheet, but when it came to the
details of the hair, the printer was not able
to replicate the image to its full extent. The
Epson EPL 5800 printed the image right
but the contrast level in the print was too
high as compared to the Epson EPL 5700L.

The Minolta QMS PagePro 1100 print-
ed the image better than the Epson EPL
5800. There was less banding but here too
the contrast level in the printout was high-
er, which was not acceptable. The Wipro

Laser 1500 did just the
opposite; here the
brightness levels in
the prints were high-
er. This proved bad
for the print quality,
as the printer was not
able to give details in
the image.

We also looked out
for the ability of the
printer to convert the
image’s colour to
greyscale with suffi-
cient variation to rep-
resent colours. TThhee
LLeexxmmaarrkk  OOppttrraa
EE331122LL successfully
replicated this effect.

This printer would be a right choice
for people who need to print pre-
views of graphical images or
photographs without
wasting time and
resources.
Vector image: Out of
the 10 printers that we
received, only five were
capable of printing the
vector images perfectly.

The Epson EPL 5800
printed the image but the
middle part of the image was
totally blanked out. So for the
quality test, this printer couldn’t be
included. The printer that excelled in this

particular test was the HHeewwlleetttt--PPaacckkaarrdd
LLaasseerrJJeett  11222200SSee and LLaasseerrJJeett  11220000. These
printers were able to successfully replicate
both the full bleed size image and the
thumbnail size image with proper details
in both the images.

The Lexmark Optra M412 too printed
the vector image but could not properly
define the colours. But in terms of the
details in the image the printer betters the
Epson EPL 5700L.

The Epson EPL couldn’t replicate
colours, and there was a drop in the qual-
ity of the image in the thumbnail-size
image. To add to these grievances, there
were patches throughout the printout due
to scratches on the printer drum. The

➜

Like inkjet printers, even laser printers are
prone to paper jams. This problem usually
occurs in heavily used printers. It’s mainly
due to the rollers in the paper path getting
worn out. When new, these rollers that are
generally made of rubber contain a certain
amount of grip that enable them to hold
the paper and pass it forward, but after
sometime these rollers wear out, leading
to paper jams. Jamming problems may
also arise from the dust that collects on
the paper path sensors. When a paper
passes through the paper path in the
printer assembly, the sensors send out sig-
nals to other sensors present in the paper
path, to tell them the location of the
paper. Due to accumulation of dust on
these sensors, if even one of the sensors is
not able to give proper paper location, the
printer might experience paper jams.

Recovering from paper jams
First pull out the paper tray and look into
the assembly for jammed paper. If you
see jammed paper, gently pull it out and
reinsert the paper trays. If you don’t see
jammed paper, open the back door of the
printer. If you see jammed paper around
here, gently pull it out and close the door.
Else, open the top door and pull out the
toner cartridge. Look for paper in the
paper path around the fuser. If you see
jammed paper, pull it out gently and rein-
sert the ink cartridge. Extreme caution
needs to be exercised—if you try to pull
out the paper violently, part of the paper
might tear and get stuck in the fuser
assembly. If you don’t see jammed paper
in any of the above mentioned areas, it
would make more sense to reinsert the
toner cartridge and call a professional.

Paper Jams

EPSON EPL
5800: Not that
great for vector
printing

The page per minute (ppm) was arrived at by taking the average
of the scores obtained in printing the text and image document
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Wipro was able to print the vector image
but the image was too bright.

The Hewlett-Packard printers were able
to print the vector image properly
without much hindrances,
probably because of the
separate drivers pro-
vided for PostScript
printing.
Text quality: This test
brings out the printer’s
ability to print text using
normal fonts in various
sizes. This is very useful
for users looking out for a
midrange laser printer that
would be normally used for print-
ing documents, letters, etc. Well,
here the HHeewwlleetttt--PPaacckkaarrdd  LLaasseerr--
JJeett  11222200SSee and the LLaasseerrJJeett  11220000 bagged the
highest rating. The only weakness was found
to be with the 1-point size printing where
the characters seemed to overlap one anoth-
er in two of the fonts used.

The Wipro Laser 1500 too recorded the
same scores, but here the problem was
noticed with 2-point size where the fonts
appeared to be a bit hazy. The average scor-
er in this category is the Lexmark Optra
M412, which printed till 3-point size but
was a bit hazy at 2-point size and at 1-point
size the character were found to be printed
one on top of the other. The worst in the
section was the Epson EPL 5800, which had
lots of flaws in the print. The 2-point size

and the 1-point size character actually over-
lapped each other for two of the font types.
The rest of the printers were able to repro-

duce fonts up to 4-point size
easily, but displayed

problems with 3-
point and 1-point
size. The printer
that you will need
for printing text
would be the
Hewlett-Packard
1220Se and the

LaserJet 1200.

FFeeaattuurreess
Apart from speed and
image quality, the other
factor that makes for a

good buy when it comes to laser printers is
the presence of features such as the ability
to print on different media (transparen-
cies, different paper sizes, envelopes, etc).
Are there features that improve print qual-
ity or make it easier to work with? 

The HP printers head the list when it
comes to availability of features. The
Hewlett-Packard LaserJet 1220Se (which
comes with the scanner assembly as stan-
dard equipment) is at the top. The other
HP LaserJet 1200 series does have an
option for a scanner-cum-copier but this
assembly doesn’t come as standard equip-
ment. The HP printers come with the sep-
arate drivers for PostScript printing, which

is of great help while doing vector print-
ing. The Lexmark Optra M412 is the only
printer that comes with LCD management
display. This display comes in handy for
configuring the printer, especially when
you use the network interface card.

The Samsung 6060N was the only
printer that came with a 10/100 MBPS net-
work interface card that would be useful if
you have a small workgroup of machines.
The Epson EPL 5800 has 16 MB of mem-
ory, upgradable to 256 MB, which is the
highest in this category. Almost all the
printers came with a ‘toner save’ feature.
The Samsung ML 4600 has the toner sav-
ing button on top, which makes it easily
accessible. The other printers too have the
toner save mode but this has to be enabled
via the printer drivers. When the printer is
turned on and no tasks are given to it, the
printer goes into sleep mode, cutting down
on the electricity bills. This is a prominent
feature of the Lexmark E312L.

The Samsung ML 6060N had the
biggest paper tray—the input tray can hold
a whopping 550 sheets of paper. These are
some of the features we noticed in the
printers. These features were logged and

Trying to save that extra money by getting
your toner cartridge refilled? Think twice!
Is your machine out of warranty? If some-
thing goes wrong while using these
refilled cartridges, how much will you
need to pay for the repairs? Will the print-
er vendor support a printer that uses
refilled cartridges? These are some of the
question you would need to answer
before you do use refilled cartridges. 

We talked to technicians from some
leading vendors in the laser printer market,
like Hewlett-Packard, Lexmark and Epson
about their opinion regarding using refilled
cartridges. The answer was unanimous. All
the technicians clearly said that they never
recommend usage of refilled cartridges but
admitted that many users do use refilled
cartridges after expiry of warranty period.
Here are some reasons why you should
not use refilled cartridges:

1. The quality of the toner used is always
low or not of the quality generally used in
the original cartridge
2. The printer drivers have settings like
density of toner, toner composition, etc
that are meant for a particular type of
toner. So if the quality or type of toner is
wrong, print quality would suffer
3. During refilling, it is possible that the
cartridge drum might get scratched or
damaged, which would affect the smooth
working of the printer
4. Improper sealing of the refilled car-
tridge could cause toner leakage when
the printer is in use. If the toner falls into
the printer’s internals, serious problems
could result.
5. These problems may not arise when
you use the refilled cartridge for the first
time, but they will invariably crop up after
a while

Refilled Cartridges

SAMSUNG ML 6060-L:
Gave good text output

Laser printers are popularly used for
document printing, but did you know
that you could use the same printers to
print on different media? A normal
laser printer would be able to support
printing on various types of media:
plain paper, transparencies, card paper,
labels, etc. These papers too come in
different sizes like A3, A4, A5, B4, B5,
ledger, letter, legal, recycled paper, card
stock, labels, envelopes etc. Printers
may have to be physically adjusted to
accept some type of media like
envelopes.

Remember that printer manufactur-
ers have their own branded paper types
that they recommend for use. Not all
printers are compatible with all types of
paper. The right place to verify this is the
printer’s manual, where the manufac-
turer clearly specifies the type of media
the printer can handle. This can help
you avoid unwanted headaches. If a
certain printer does not support trans-
parencies or label printing and if a per-
son uses this printer to print on such
media, he might damage the printer
fuser or even the printer mechanism. 

Using Different Media
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points were also awarded to printers that
excelled in characteristics like build quali-
ty, thoroughness of documentation, bun-
dled software etc.

BBuuiilldd  qquuaalliittyy
When buying a printer, you should exam-
ine the build quality, especially of the mov-
able components such as the paper tray.
Since you would be handling the paper
feed tray very often, it will wear out fast if
it is flimsy in its build. Also look for any
breakable flaps and examine the rollers in
the paper path and the print assembly as
shoddy build in this area can cause paper
jams.

The Epson EPL 5700 L and the Epson
5800 were strongly built but their lacklus-
tre performance was the biggest disap-
pointment. The Samsung ML 6060 N and
the Lexmark Optra M412 had the best
overall build quality.

The Lexmark Optra E312L and the
Wipro Laser 1500 were also pretty strong-
ly built. The Minolta had a very fragile
cover that could break if not handled care-
fully. The HP LaserJet 1220 SE and Laser-
Jet 1200 were good in performance but
proved quite fragile.

CONCLUSION
If you need to print only occasionally, an
inexpensive and basic inkjet printer would
suffice. But if you need the best in terms of
speed and performance, you’ll definitely
need to go in for a laser printer, especially
if you need to print a large volume of text
documents. A laser printer will print sharp-
er and cleaner text than an inkjet printer—
even if it has a lower print resolution than
the inkjet. The printer that outshone the
others was the LLeexxmmaarrkk  OOppttrraa  MM441122.

This was not only the fastest printer at
16.61 prints per minute, but it also had the
crispness and quality in the prints. But if
you consider the price tag, this printer
would be more ideal for a workgroup with
five or more users connected in a network.

For a home user, the best bet would be
the MMiinnoollttaa  QQMMSS  PPaaggeePPrroo  11110000. The
printer is much more affordable, with
ample speed and quality. With the facility
that incorporates a scanner-cum-copier,
the Hewlett-Packard LaserJet 1220Se
would be a wise choice for a user who seeks
a complete office solution.

1/2 pqge H. AD

LEXMARK Optra M412:
Great speeds with quality 

Minolta QMS Page
Pro 1100:
Low-cost option



July 2001118

MOHAN KRISHNAN and MITUL MEHTA

Y
ou know what’s common between an office
suite and an operating system? Everyone has
one installed on his or her computer. The first
software that you normally install after the

operating system is the office suite—especially the
word processor. Even if you are still caught up in
the DOS age, you still have your faithful Word-
star. But there’s more to an office suite than a word
processor.Your spreadsheet is useful in managing
a whole lot of your tabular information or even

databases, and you can really impress people with
the presentations you create.

TThhee  ccoonntteennddeerrss
Among the four office suites for the Windows
platform that we tested, Microsoft Office XP does-
n’t work with Windows 95 now, and if you are
planning to use the voice recognition feature, you
would need 128 MB RAM. However, it is more
feature-rich than the other versions.

Office suites undergo
version changes and
free suites also make
their presence felt.
Choose the best for
your needs

IINN  TTEESSTT:: 4 OFFICE SUITES
Photograph: Ashesh Shah and Rahul Sharma, 

Imaging: Solomon Lewis

Everything
Office about it

■■ sseelleecctt~~tteesstt  ddrriivvee
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Lotus SmartSuite Millennium Edition, com-
prises Word Pro, 1-2-3, Freelance Graphics,
Approach and Organizer. The feature list might
not be exhaustive, but Lotus still maintains its
remarkable ease of use while providing most
functions. Software602’s 602Pro PC Suite 2000b
is available free for download. This suite comes
with 602Text, the word processor and 602Tab,
the spreadsheet. There’s no presentation soft-
ware; instead there’s an image-editing tool.
Another free package is StarOffice, which gained
popularity after it shipped its free version for the
Linux platform.

TThhee  ooffffiiccee  eennvviirroonnmmeenntt  
Installation, integration, ease of use (interface
and help features) are aspects that you notice
when you look at the office package as a whole.
IInnssttaallllaattiioonn:: Office XP and Lotus SmartSuite
have similar installation features and allow you to
select the individual components to be installed
and also specify whether you want the compo-
nent to be run from the CD. 602Pro doesn’t give
any installation options at all, and the only choice
you have is whether you want to do a network
installation (to run the software from a network
server). With StarOffice, you have to necessarily
install StarOffice Writer, although you can do
away with the other components.
IInntteeggrraattiioonn:: StarOffice has an integrated inter-
face in that there are no separate icons for each
component. Open StarOffice and then click on
File > New to open a text document, a spreadsheet,
a presentation, or choose from existing templates
and let the AutoPilot (the wizard in StarOffice)
guide you. StarOffice also allows you to browse
your local drives, network and the Internet from
the same interface. Such an interface presents an
‘all at one place’ approach but might look a bit
cluttered if you have too many features.
EEaassee  ooff  uussee:: One area where Lotus SmartSuite
clearly scores is in its interface and use of

workspace. Open any docu-
ment and you have the bare
minimum toolbars. Exercise
any option and tools relating to
that option line up. Once you
are done with them, the tools
disappear. You can also right-
click any object (say a text box,
or an image) and modify all the
attributes for that object from a
single box. To an extent, Office
XP’s Task Pane option makes it simpler to use.
Then again, the Task Pane does take up a bit of
your workspace, so you could end up scrolling
horizontally more often than you would 
care to.

The default toolbars of 602Pro are a bit jar-
ring with all the icons cluttered up and with text
in big fonts to explain what the icons mean.
Helpful, but hardly anyone working with a word
processor would need an explanation that the ‘B’
icon stands for ‘Bold’ or that ‘%’ stands for ‘Per-
centage’. Thankfully, you can customise the icons
to make them smaller and remove the text.
Help: Context-sensitive help is what we were
looking for, and that meant that if we exercise
some feature or option and click on the [F1] key,
we should get a help option related to the menu.
StarOffice is the only one that provided such
help, the rest just opened up the Help menu. In
addition, StarOffice has a non-intrusive assistant
that pops up automatically when you are work-
ing with certain commands. While this can be a
useful aid initially, it might get irritating once
you get used to it. In 602Pro, we got such con-
text-sensitive help with the word processor, but
not with the spreadsheet…the favouritism con-
tinues! Lotus prompted you to ask a question
every time you wanted help—useful if you don’t
know what you are looking for, but time-con-
suming if the help you want is just related to a
specific feature.
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When we talk of office suites, we are basi-
cally referring to the word processing,
spreadsheet and presentation software
that most people use. We specifically didn’t
take into account the database feature,
since for home use or normal desktop use,
databases aren’t that crucial. Since we
were testing only these basic components,
we called in for the standard version of the
software and not the professional or other
editions. On the whole, we looked at
aspects such as installation, components
present, interface, help menu and price. 
Word processors: We loaded a test text
document in all the word processors and

started work on it. Specific aspects that we
looked at were the formatting features, the
creation of tables, provision for collabora-
tion and revision tools, working with long
documents in terms of sections, tables of
content and finally the spell-check and
grammar features. 
Spreadsheet: For testing the spreadsheet,
we created a test data that contained
alphanumeric, numeric and date fields. We
then worked towards formatting that data,
performing simple and complex calcula-
tions, creating graphs, adding macros, and
using some advanced features. 
Presentations: For the presentations, we

created some slides and added a whole lot
of elements to each slide, and finally
checked out the slide show. Specific param-
eters that were tested included the wizards
and templates, the kind of formatting, transi-
tions and animations effects that were pos-
sible, and whether we could e-mail the
presentation across in a compressed format.

In all these tests, we kept a lookout for
features that were absent, or were unique.
Also, more weightage was given to word
processing abilities than the presentation
and spreadsheet utilities, since obviously
word processors are still the most fre-
quently used component in an office suite.

The integrated interface of StarOffice

MMoorree  IInnffoo  on 
the test process and the 
products tested, check out 
MMiinnddwwaarree

TEST PROCESS



Y
ou can use your word processor to type
a single page document, and at the same
time create an entire book in it. There-

fore, your wish list from a word processor
may differ depending on the actual use you
make of it.

FFoorrmmaattttiinngg
Except for 602Text, all the other software
gave us a number of paragraph formatting
features, including auto-correct and auto-
format functions. 602Pro didn’t have any
options for hanging indents or drop-caps
and neither were there any widow or
orphan control options.

All the software worked dif-
ferently in terms of retaining
formats of copied text. 602Text
converted any pasted text to the
default formatting of the para-
graph, and didn’t even retain
Web formatting. Word Pro
retains the formatting of the
paragraph that has been copied
and will not take the format of
the paragraph where it is being
copied.

Word 2002, in spite of its Smart Tag
option, was the most troublesome while
pasting text. We chose the option Retain
Source Formatting, but when we pasted
text, the results did not match the source.

The Reveal Formatting option in Word
allows you to identify a format based on a
style and then select all the paragraphs in
the document that match the style at one
go. Quite useful when working with
lengthy documents if you want to globally
change formatting options.

GGrraammmmaarr  aanndd  ssppeellll--cchheecckk
Only Word Pro and Word 2002 had gram-

mar check functions, and in most of the
software, spell-check was not enabled by
default. In Word Pro, if you misspell a
word, the options relating to it show up as
a tiny question mark in the bottom palette.
You have to click on the question mark to
get the options and people can often miss
this. The right-click option of Word is
much better in that sense.

TTaabblleess
We thought the creation of tables would
be simple in all the suites, but 602Text
proved us wrong. Try creating a table and

the first thing you notice is that by default,
cell gridlines aren’t drawn. You cannot
select rows or columns, or select the table,
so to have the gridlines, you have to select
all the cells and add the cell gridlines first,
before you can get to work. Only Office XP
had the feature of drawing a table, and
splitting rows and columns using the tool-
bar. Word Pro had an interesting feature of
specifying different gutter width (the dis-
tance of the text from the cell boundary).
We don’t know what exactly this will be
used for in a table, but you can definitely
make your table look a bit different from
the rest.

LLeennggtthhyy  ddooccuummeennttss
Section-breaks, column breaks, headers and
footers are essential options if you are work-
ing on a report or any lengthy document
such as a book. 602Pro and StarOffice
Writer were disappointing—they don’t sup-
port portrait and landscape mode within
the same document for different sections.
Word Pro allows you to create divisions that
can behave like a totally different document
with different styles, headers, footers, etc,
and within divisions you can again have sec-
tions that can have different headers and
footers. All the suites were similar when it

came to creating the table of
contents and index based on a
defined style.

CCoollllaabboorraattiioonn
Word Pro and Word 2002 have
a number of collaborative tools
that make distributing work
among co-authors or revision-
ers simpler. Both allow you to
protect a document for just
revisioning purposes (that is,
when the revisioner opens the

document, the Track Changes option will
be set by default), and you can send the
document via the default e-mail client to
the intended person.

While Word Pro and StarOffice allow
you to mark comments along with the
tracked changes, the most interesting fea-
tures come from Word 2002. When you are
in the tracking mode, Word 2002 jots
down comments on the side about every-
thing you do. So, if you delete text, you get
a comment about text being deleted, and if
you change formatting (make a word
bold), the comments again appear. Quite
useful in a collaborative environment, to
keep track of the changes that have been
made.

Working with 602Text is hardly appeal-
ing, and the lack of functions means it still
has some way to go before entering the big
league. With a number of interesting fea-
tures, and icons that are quite intuitive and
elegant to use, Lotus Word Pro can be quite
useful, especially for long documents and
reports. But if you want something for a
multi-purpose and varied application use,
ranging from publishing and collaborative
work to simple documents, WWoorrdd  22000022
scores. Word 2002 tries to increase the
intuitive level of the software with some
excellent concepts, and enhances quite a
number of existing features.
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PROCESSING THE WORDS

We checked out the suites for their saving
options and any compatibility issues they
had. Specifically, we checked for compati-
bility with respect to opening a Word
2002 document. Except for 602Pro, the
rest of the suites managed that with
ease. However. all software had problems
with the tables created in Word that had
split cells. In case you think compatibility
problems might arise, the safest bet is to
save it in Rich Text Format (RTF). 

Another aspect we looked at was the

Save for Web feature. When we saved the
document created in StarOffice Writer with
pre-defined styles to an HTML format, and
opened it in Internet Explorer, we found
that none of the styles were rendered
properly and in some cases some of the
heading styles had text missing. Even with
other software recognition of styles was a
problem area. Otherwise, both StarOffice
Writer and 602Text have embedded sup-
port for HTML, and in these you can even
insert scripts or add tags.

Rich with Text

Collaborative tools in Office XP: Quite informative

➜



F
or many, the spreadsheet might just be
a replacement for a calculator, but if you
want, you can really do some amazing

statistical stuff, generate fabulous reports
and charts, or create complicated tables.

FFoorrmmaattttiinngg
Working with cells and cell properties can
be really crazy at times. Take StarOffice
Calc for example. Here, every time you
press the [Delete] key to remove the con-
tents of a cell, you get a confirmation box
asking whether you want to delete the val-
ues, the formatting, the formulas, etc,
which can get a bit irritating. It’s a nice fea-
ture if you are using a number of calcula-
tions and want to keep the value but delete
the formula. There’s a workaround by
using the [Shift] + [Delete] key, but it’s not
the best of methods. 602Tab, like its word
processor, is quite basic and you cannot
merge cells if you want, nor can you exper-
iment with any text orientation.

Lotus 1-2-3 is quite good in that respect
and gives you a number of text orientation
features that can be quite useful if you are
creating a spreadsheet in portrait mode
with a number of columns but limited
rows. In 1-2-3, every cell is taken to be a
range, and therefore you have to work with
range properties for aspects such as merg-
ing or splitting cells. You could also create
text blocks, which may help if you want to
mix text along with cells. It also comes with
a neat handle that lets you move the cell
contents along.

We found Excel still problematic when
it comes to copy-pasting cells. Copy a cell’s
contents from the cell instead of the status
bar, perform a number of operations, and

then try to paste the contents, and you will
find that Excel has lost the copied data
from the system clipboard. The same data
is still available in the Office clipboard and
you can retrieve it from there, but that’s a
tedious thing to do.

1-2-3 and Excel 2002 were the only
ones that had Indian currency also in the
list, although it was listed as INR (the glob-
al notation) and not rupees. In Excel, the
currency list was sorted by just the global
notation, whereas 1-2-3 had the country
name also, thus making life easier for you.

CCaallccuullaattiioonnss  
All the spreadsheet packages except 602Tab
were intuitive when it came to the automat-
ic sum option. They assumed that the cells
above or by the side are what you want to
work with. No such luck with 602Tab. Excel
2002 has added to the list in the Auto Sum
option. You now have a drop-down list that
features other variables such as Average.

StarOffice Calc and Excel 2002 came
with options to trace errors. StarOffice Calc
calls it the Detective option. This feature
allows you to trace the dependencies to a
formula. Excel 2002 has the Formula Audit
feature that traces dependencies as well as
precedents for each cell.

These features are useful if you work
with huge amounts of data, and have to
resolve errors in formulae or instances of
circular references.

An added function in Excel 2002 is the
Watch Window feature that allows you to
specify a cell that will be constantly
watched even while you scroll across the
sheet. The value of the cell is shown in the
Watch Window, and you automatically
come to know if any changes have been
made to it.

GGrraapphhss
StarOffice Calc is simply the best when it
comes to graphs. Because of its tight inte-
gration with the drawing tools, you can
have a variety of graphs and apply gradients
and transparency, apart from a whole lot of
3D effects such as specifying material
source, the geometry of the image, lighting
and texture.With 1-2-3 and Excel 2002, you
just had the standard 2D and 3D variants
and you add some shadows and gradients.

MMaaccrrooss  aanndd  FFoorrmmss
If you are looking at performing a series of
similar calculations over a range of similar
cells, using a macro might be a good idea.
With StarOffice Calc and Excel 2002, cre-
ating this is quite simple—just use the
record button. In 1-2-3, the macros
options are hidden under the Edit menu.
Creation of forms and drop-down lists
without any use of scripts is only possible
in Excel 2002. 1-2-3 also allows you to do
the same, though you have to learn the
Lotus Scripting language for this.

On the whole, 1-2-3 still maintains the
simplicity that it’s known for, but this is at
the cost of features. Most of the features
that you normally need are present in this
software, but advanced features such as
provision for pivot tables and reporting
tools are missing. Even StarOffice Calc suf-
fers from the same problem, though it is
great for graphs.

EExxcceell  22000022 scores over the other con-
tenders because of its feature-list and
increased ease of use with the Smart Tags
and Task Pane (try to fill a numbered series
and see how the Smart Tags help you).
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SPREADING THE SPREADS

The spreadsheet utilities come with some
extra features that are normally quite use-
ful for analysing data in a statistical man-
ner. If you are into sales and marketing,
then goal-seek, scenario builder or trend
analysis is exactly what you are looking
for. 1-2-3 comes with a ‘What-if’ feature
where you can see and analyse changes
in projections that get reflected with dif-
fering data. 

Excel allows you to create different
scenarios or specify a goal and work
backward towards attaining the goal.
Getting a grouped data analysis is much

simpler with the Pivot Table and Pivot
Chart option. StarOffice too has the goal-
seek option. Other advanced features
that you will find in these suites are
options for validating data and grouping,
sorting and consolidating data. Strangely
enough, in 1-2-3, some of the more ana-
lytical, statistical functions such as the
cross-tabs and quick reports are inserted
as a link to the database component
(Lotus Approach), while other tools like
matrix and inverse matrix that are nor-
mally used only by mathematicians are
present as a feature.

Analysing your Data

Enjoy the 3D effects in StarOffice
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S
ometimes, too much can also mean too
problematic. With the number of fea-
tures that presentation software have

these days, it’s a problem selecting the right
presentation for your needs.

WWiizzaarrdd  aanndd  tteemmppllaatteess
All the presentation packages allow you to
start off with a wizard where you can spec-
ify the layouts and themes. With StarOf-
fice Impress, the wizard takes you through
the whole gamut of operations—select
templates, specify page type, the output
medium, indicate the transition—and
your slide is ready. We didn’t particularly
like the templates that much—the colour
schemes seemed a bit too garish. An inter-
esting feature with Lotus is that you even
have templates for the content of the slides.
Select one and Freelance Graphics auto-
generates content for multiple slides (or
pages) based on the options related to the
template. For instance, if you choose Com-
petitor Analysis as the content topic, then
you have options for pages with content
such as Background, Human Resource
Strategy, Anticipated Moves, etc.

FFoorrmmaattttiinngg
What we tried to do was select a template
and then try customising the template to
our needs. In StarOffice Impress, if you
have to change the background objects,

you need to enter the Background view
(located at the bottom pane of the screen
and easy to miss) and enter the Drawing
mode. In Freelance Graphics, the same
thing is made quite simple by using the Edit
> Backdrop option. With PowerPoint 2002,
you don’t have too much of that problem
either, clicking on an object allows you to
select it.

An interesting feature Impress sports is
the Bezier tool, which is normally only pres-
ent in graphics packages. This can be quite
useful for creating curved paths with text
flowing around it. Freelance Graphics also
presents you with a number of graphical

tools to add different connectors, flow
charts, points, arrows, and even create irreg-
ular shapes with text within the shapes.

SSlliiddee  SShhooww
All the presentation software had easy-to-
use slide show options, with the facility to
add notes or to use a pen. Apart from a
slide show, you could even have output in
the form of handouts if you desire.
Impress even allows you to edit while the
presentation was on. PowerPoint has a live
broadcast feature, though we didn’t actu-
ally check out how this feature works.

Freelance Graphics treats each line,
image or clipart as a separate object.
Therefore, you can modify the properties
for each object (say a bulleted text) and
this greatly helps in sequencing (selecting
which object will be displayed first) dur-
ing a presentation. For instance, just right-
click on a particular object (say a bulleted
list), select the properties for that object,
and specify whether you want the object
displayed with the page or after a mouse-
click or after a certain time duration. Add
other aspects such as the transition effect
you want when the image appears or even
add the action that has to be performed
when the object is clicked on (for instance,
you can specify that a movie be played, or
the next slide be presented, etc). Not just
that, you even have content advice related
to the content template that you have cre-
ated. If this isn’t spoon-feeding, what is? 

PowerPoint 2002 leaves the rest far
behind when it comes to the task of creat-
ing slide shows and adding custom anima-
tion. Just right-click on any object (text,
image, etc) and you get all the options you
could ever want.You can specify animation
characteristics, effects, sequence the objects
on the page, and all with Auto Preview (if
you have the option checked). The number
of animation effects, templates, slide
designs and layouts have all increased con-
siderably. Also, with the same right-click
option you can specify a certain action for
the object, if clicked or on a mouseover.
The action you define can, for instance, be
playing a sound or running a program.

In terms of sheer features, there’s noth-
ing that can beat PPoowweerrPPooiinntt  22000022. Free-
lance Graphics, like WordPro and 1-2-3,
offers more simplicity and optimal utilisa-
tion of workspace, so if you like your pre-
sentations simple, then definitely check
these out.

PRESENTING YOUR CASE

Alright! You’ve just created the best sales
report ever with high-quality images and
graphs. But how do you send this huge
file over to your branch manager based in
a different location, and also ensure that
there are no problems with the fonts and
image display? That’s why all presentation
suites come with a ‘packing the presenta-
tion’ option. 

Impress allows you to split your file
into different file sizes (based on the out-
put medium). So, you can split the file
into 1.44-MB sizes if you are transferring
it via floppy. Impress also comes with an
option to keep placeholders instead of
the actual image or text. This can be use-
ful in a collaborative work environment
where you are initially discussing the lay-
out of the presentation without using the
actual content or images. 

PowerPoint 2002 comes with a num-
ber of options for packing your presenta-
tions. For images, you can specify
compression ratios and resolution and
also choose whether to embed the fonts
into the file (so as to not cause a font
mismatch if the person viewing the file
doesn’t have these fonts installed on his
system). 

Also, you can just use the Send To
option to send the file as an attachment
to an e-mail recipient. Freelance Graph-
ics’s Save and Go feature allows you to
compress the file and save it in different
output mediums, and it also allows you
to insert images as a link (that means the
actual image isn’t there, it’s just a place-
holder) instead of embedding the image.
This is again useful for reducing the file
size.

Pack and Go

Working with content templates in Lotus
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CONCLUSION
What do you want in an office suite?
That’s the most important question that,
you, as a user have to answer. With each
succeeding version, developers are pack-
ing in more and more features in the suite
and it is likely that you might not even use
half of these features. MMiiccrroossoofftt  OOffffiiccee  XXPP
definitely scores over the other contenders
in the sheer number of features that are
offered. With the effective use of the Task
Pane, there is the additional dimension of
simplicity too. But remember that these
features come at a price. The standard ver-
sion of Office XP costs Rs 20,500 and
that’s nearly four times the price of Lotus
SmartSuite Millennium Edition. And if

you measure this against 602Pro and
StarOffice that are free, you end up with
quite an uneven comparison in terms of

price. For that matter, even the Profes-
sional and Premium Editions of Microsoft
Office 2000 are priced lesser than Office
XP (ranging from Rs 15,000 to Rs 19,000),
so you can also get Access 2000, Front-
Page, Publisher and other development
tools for that price. The only real lure of
Office XP over its earlier versions would
be in areas of collaborative work when the
document passes among many reviewers
or when you are trying to integrate the
Web and your office applications. For nor-
mal home use that just involves simple
documentation, basic calculations and
presentations, a free suite such as StarOf-
fice is more sensible and doesn’t have
major compatibility issues.

DDeettaaiillss
CCoonnttaacctt  AAddddrreessss

PPrriiccee
CCoommppoonneennttss

IInnssttaallllaattiioonn  SSiizzee  ((TTyyppiiccaall  ))
IInnssttaallll  ccuussttoommiissaattiioonn

HHeellpp

WWoorrdd  PPrroocceessssoorr
GGrraammmmaarr  CChheecckk

DDiiffffeerreenntt  ppoorrttrraaiitt  aanndd  
llaannddssccaappee  llaayyoouuttss

TTaabblleess

SSpprreeaaddsshheeeett
IInnddiiaann  ccuurrrreennccyy  ssuuppppoorrtt

CChhaarrttss

EErrrroorr  cchheecckkiinngg

PPrreesseennttaattiioonn
WWiizzaarrddss  aanndd  tteemmppllaatteess
TTrraannssiittiioonn  aanndd  EEffffeeccttss

SSlliiddee  SShhooww

VVeerrddiicctt

660022PPrroo  PPCC  SSuuiittee  22000000bb
www.software602.com

Free
602Text, 602Tab, 602Photo

49 MB
Fully customisable
Context-sensitive in
602Text only
660022TTeexxtt
No
No

Basic features

660022TTaabb
No
Basic 2D and 3D

No

NNoott  pprreesseenntt
NA
NA

NA

BB--

Lotus SmartSuite Millenium 9.6
Lotus Development Industrial
Corporation, Phone: 2322024,
Fax : 2322026 
E-mail: india@lotus.com
Rs 5,500
Word Pro, 1-2-3, Freelance
Graphics, Lotus Approach,
Lotus Organizer 

279 MB
Fully customisable
Ask the expert for guidance

Word Pro
Yes
Yes

Provides cell-wrapping options
in table
11--22--33
Support for INR
2D and 3D

Tracing

FFrreeeellaannccee  GGrraapphhiiccss
Provision of content templates
Customisable sequencing of
objects

Rehearse Timings, add pointers

AA--

Microsoft Ofice XP (Standard)
Microsoft (India),  
Phone: 011-6294600, 
E-mail: undarb@microsoft.com,
Web site: www.microsoft.com
Rs 20,500
Word 2002, Excel 2002,
PowerPoint 2002, Outlook 2002

219 MB
Fully customisable
Non context-sensitive, but uses
Smart Tags
Word 2002
Yes
Yes

Can draw table, add diagnol
lines
EExxcceell  22000022
Support for INR
2D and 3D

Tracing Dependents and
Precedents
PPoowweerrPPooiinntt  22000022
Quite extensive templates
Task Pane provides number of
transitions and animation
effects
Narration, Add Buttons, Live
Broadcast
AA

StarOffice 5.2
www.staroffice.com

Free
StarOffice Writer, StarOffice
Calc, StarOffice Impress,
StarOffice Draw, StarOffice
Mail, Schedule
170 MB
Have to install StarWriter
Context-sensitive

StarOffice Writer
No
No

Basic features

SSttaarrOOffffiiccee  CCaallcc
No
Advanced lighting and 
texture features
Detective option

SSttaarrOOffffiiccee  IImmpprreessss
Entirely wizard driven
Normal transition and effects

Edit presentations live

BB++

Specifications
The Office Facts

Microsoft Office XP:
Need we add more?
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T
hink of it as a personal secretary. Only this
one doesn’t take long lunch breaks or keep
pestering you for a raise. A personal infor-
mation manager (PIM) lets you schedule

appointments, remember birthdays, plan work-
weeks, send e-mail and make phone calls—all
from the same place.

A PIM is a small software that you can run on
your system to enjoy the functionality of a daily
planner, an address book, a calendar, an alarm
clock, a phone diary, a fax machine and even an
e-mail client!

We’ve put together nine PIMs available in the
market to check which one can make life easiest
for you.

TEST PROCESS
Features are the best indicators of how good a
PIM is. So testing the PIMs largely involved
searching for and scanning features that would
help one maximise the benefits of information
management. Besides features, the PIMS were
also evaluated for ease of use. A very important
aspect of this is integration. The PIM should be
well integrated with the operating system, the 
e-mail client and phone dialler it uses, and also
with other applications and handheld devices.

The aim of the PIM is to make life easier for
a busy person, through uncluttered menus, intu-
itive icons and helpful documentation. So, PIMs
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Juggling and keeping track of your schedules, 
e-mails and appointments is a snap with
personal information managers (PIMs) 

Photograph: Rahul Sharma, Imaging: Neeta Wadiker

IN TEST: 9 PERSONAL INFORMATION MANAGERS

A well-ordered life



with a user-friendly interface and adequate help
and documentation scored brownie points over
others. And of course, the price of the software
was compared with the functionality to deter-
mine whether it was worth spending money on.

The overall score was based on three param-
eters—features, ease of use and price. All three
were given equal weightage.

SScchheedduulleerr
A scheduler is one of the most important fea-
tures in a PIM. It helps you plan your day and
keep track of which tasks need to be completed
and by when. A good scheduler used well can
streamline work and make life easier.

The schedulers of most of the PIMs were fea-
ture-filled, although many failed to make use of
their interface to show off their various features.

Lotus Organizer was good in this respect. It
has a user-friendly feel with an interface that
looks like a diary and is really convenient if you
plan to use your PIM for scheduling work and
tasks throughout the day.

Microsoft Outlook was better. It comes with
a sleek looking calendar that has views of the
current and future months. To add or edit tasks,
simply click on the date to view the time-slots of
the entire day, along with those of that particu-
lar month. Selecting a particular time opens up
a window that allows you to do a range of things,
such as setting a reminder alarm or scheduling
work with your other mates.

RedBox Organizer follows in the path of
these two, although its scheduler isn’t as detailed
as that of Microsoft Outlook. Corel, on the other
hand, has a simple scheduler with basic func-
tions, which makes it good for home users who
don’t need too much of customisation and fea-
tures packed into their PIM.

Day Timer’s Scheduler isn’t as feature-packed
as Microsoft Outlook, and the interface isn’t too
interesting either. Also, everything has to be
done manually by going to menus and selecting

options to activate
features. So when it
comes to sched-
ulers, MMiiccrroossoofftt
OOuuttllooookk and RReedd--
BBooxx  OOrrggaanniizzeerr
come out tops.
Lotus Organizer is
great too but a little
bit of additional
features would be
welcome.

RReemmiinnddeerrss
Just like a secretary
reminds the boss
about important
appointments and other meetings, reminders
ring an alarm or send an alert to tell you when
you need to do a particular task.

With Microsoft Outlook, you can set alerts
that pop up at a particular time. Or you can use
reminder notes that can be dragged and
dropped into any other application. In RedBox,
the reminders section allows you to get a bird’s
eye view of the reminders and alerts when you
load the program onto the main menu. Lotus
Organizer’s reminder can be set by double-
clicking on a particular time in the scheduler,
which in turn brings up a whole lot of other fea-
tures. At the other end of the spectrum are soft-
ware like Cute Organizer and Epoch Organizer,
which have not concentrated on this feature.

Microsoft Outlook once again wins first
place. It allows you to set time, along with other
customisable features, while the others have a
simple alert option that you can set on your PC.

AAddddrreessss  BBooookk
To be able to use the PIM to the fullest, you
should be able to keep a database of your con-
tacts within it. If you want to call a particular
contact, or e-mail him, you should be able to
start the particular application such as a phone
dialler or a mail client just by clicking on the
name. Sorting and categorising should also be
available in a good PIM. If groups can be made
and mailing lists can be created, that’s another
plus point.

The address book feature has been well cre-
ated and integrated into Microsoft Outlook. You
can simply sit down and add a whole list of
entries as standalone contacts, or you can also
set up a small mailing or distribution list that
contains a list of people. The contacts are listed
alphabetically. A large number of other details
can be added besides the individual’s contact
information. You can switch from one view to
another by clicking on the various tabs. Filtering
and sorting of contacts is also possible by right-
clicking, which brings down the menu that
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allows you to do various tasks.
While adding contacts in Lotus Orga-

nizer 6.0, we found that it allows you to
sort your contact list according to rules
that could be set. Right-clicking on the
contact list area and selecting Contacts
Preferences allows you to customise the
view of your contact list.

In RedBox Organizer 4.0, the address
book can be accessed by clicking on the
Address tab on the interface. The look of
RedBox Organizer’s address book is very
colourful and attractive. Tabs have been
made to categorise Business and Friends.
There aren’t too many fields to fill while
entering data.

MMaaiill  ffeeaattuurreess
If your PIM is well integrated with the 
e-mail client or provides you with mail fea-
tures, it makes it that much more conven-
ient for you to communicate not only with
people on the network but also with indi-
viduals from all over the world.

MMiiccrroossoofftt  OOuuttllooookk offered the best fea-
tures, being primarily a mail client that is
used widely. A whole lot of customisation
options have been added to the software,
such as various mail views. Mail can be
sorted according to name or topic. It is well
integrated with the browser and other

applications, so opening a Web site URL or
other document received via mail is really
simple.

Using RedBox Organizer is also really
simple. It uses the default mail client from
the operating system and automatically
puts in the receiver’s mail address, etc.
Lotus Organizer also uses the default mail
client when you choose to send a mail to
someone.

Cute Organizer and Epoch Organizer
both have basic mail client setup features
that are easy to use. The only trouble is that
you have to specify the password when you
set up your mail account, unlike in Out-
look, where you can choose to not do so
during setup. That way, your inbox is
secure because each time mail has to be
sent or received, the password has to be
given.

CyberContact is another PIM with a
small, integrated mail client that allows

you to download and send mail.

PPhhoonnee  ffeeaattuurreess
An in-built or well-integrated phone and
fax dialler is the next thing to look out for
in a PIM. But fax features are not as impor-
tant nowadays since e-mail has become the
preferred mode of communication, so

only phone features are being discussed.
MMiiccrroossoofftt  OOuuttllooookk scores again,

because it is integrated with Microsoft’s
good old Windows phone dialler. It does-
n’t have too many features, but is good
enough if you require simple dialling fea-
tures for outgoing calls.

Most other PIMs, including RedBox
Organizer and CyberContact, use the
default Windows dialler software. Corel
InfoCentral offers quite a few options such
as international calling, etc for setting up
the modem, which is done using the Win-
dows wizard.

Day Timer Organizer 2000 is one of the
best phone diallers around. It’s a stand-
alone phone dialler running completely on
the PIM itself.

It offers the option to use calling cards
in various countries. Incoming and outgo-
ing calls can be recorded and logged with
alerts and alarms. Office goers will cer-
tainly give this one a thumbs-up.

EExxppoorrtt//IImmppoorrtt  ffeeaattuurreess
Export and import features can be very
useful if you have to move all your settings
and contact lists from one software to
another, using a specific file format such as
CSV (Comma Separated Values). This is
useful if you want to change your PIM or
mail client or if you’re moving to a
machine that doesn’t have your favourite
PIM and you need your archive of contacts
and other information.

MMiiccrroossoofftt  OOuuttllooookk has the most com-
prehensive export and import features.You
can export and import contact lists, mail
accounts and mail into CSV or a whole list
of formats available.

Lotus Organizer allows users to export
data to a TXT file, and then import it

Electronic Assistant: Not so great interface

CyberContact: Integrates e-mail client

PDA’s are becoming very popular
nowadays, with companies like Palm
and Handspring selling millions of
these devices. Most of these PDAs use
the versions of the Palm OS and allow
users to write e-mail, take notes, store
schedules, exchange visiting cards and
set alarms. It’s these PIM-like features
that have made PDAs so popular with
users who need to have access to this
information when they are on the
move. So if you are someone who
needs a PIM at all times to stay organ-
ised, just get yourself a PDA.

PDA as a PIM

When you’re on the move, you can’t jolly
well carry your PC around for a quick
glance at your day’s schedule or impor-
tant telephone numbers. In this case, an
online PIM is the best solution. Yahoo
Calendar is one such online PIM. It can be
accessed through the Yahoo Messenger
client once you register for the service. 

Online PIMs aren’t very customisable
and detailed, but they include all basic
features like calendars, reminders and
online diaries. Some additional features

are also usually available, such as news or
horoscopes, which you don’t get on your
desktop PIM. 

Online PIMs such as Web Event allow
you to schedule work with a group of
people over the Internet. Schedule Online
has a wide range of accounts for all kinds
of people, be it students or corporate
executives. You can visit a site called
FusionOne to sync contacts and notes
between your mail client or PIM and the
Internet.

Online PIMS
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through Microsoft Outlook. It also allows
you to export to CSV, which is one of the
most widely used formats around the
world. Other PIMs like RedBox Organizer
also support TXT and CSV import and
export. Day Timer 2000, on the other
hand, uses ASCII and Text values for its
import and export functions. Like CSV,
there also exist other formats such as
VCard and VCalendar, which are used
widely by Microsoft applications. VCard
and VCalendar are special file formats that
allow you to keep huge databases of con-
tacts and appointment lists.

EEaassee  ooff  uussee
One of the easiest software to use was
LLoottuuss  OOrrggaanniizzeerr  66..00. Its interface is
designed like a diary. The multi-tab struc-
ture makes navigation really simple, and
you can change views at the click of a but-
ton. RedBox Organizer’s interface is some-
what similar to that of the Lotus
Organizer. RedBox has big buttons on the
interface, which allow you to switch from

one feature to another. There is a Show Me
How button at the top left corner of the
window, which you can use to learn how to
do a particular task, with the help of a pop-
up window.

In Microsoft Outlook, views can be
changed through the various options in
the View menu, such as enabling and dis-
abling the Preview window, etc.

Outlook also has the immensely
unpopular Clippy to help you out in doing
particular tasks. The features have self-
explanatory icons on the interface. Out-
look Today allows you to view a summary
of your calendar, pending tasks and inbox.

CONCLUSION
After going through the entire gamut of
products, the winners were not difficult to
pick—MMiiccrroossoofftt  OOuuttllooookk followed by
Lotus Organizer and RedBox Organizer.

Of the whole lot, Microsoft Outlook
was the odd one out because its interface
is more like a straightforward office mail
client. But it offers far more features than

the rest. This PIM-cum-mail client is only
for users who want high features and have
a mid- to high-end machine with plenty
of RAM to spare.

Then comes the RedBox Organizer 4.0,
with a neat interface showing off its fea-
tures on the opening menu itself, just like
a well-designed Web page. It also includes
a world globe in the package, which tells
the time zones, the current time in differ-
ent cities all over the world, and the time
taken to travel from one place to another.
Lotus Organizer scores
the most when it comes
to user-friendliness.

However, it lacked integrated features such
as a mail client and a phone dialler. Elec-
tronic Assitant needs a face lift and needs
to improve on the currently amateurish
look on the main interface.

Epoch Organizer and Cute Organizer
are low-end PIMs which do not offer any
huge features but are compact in size.

Feature-rich winner all the way

Specifications

NNaammee

Corel Infocentral 7
Cute Organizer
Cybercontact
Day Timer Organizer 2000
Electronic Assistant Lite 4.0
Epoch Organizer
Lotus Organizer 6
Microsoft Outlook 2002
RedBox 4.0

WWeebb  ssiittee

www.corel.com
www.kaboom.org.uk
www.liraz.com/cybercontact
www.daytimer.com
www.danteproductions.com
www.kaboom.org.uk
www.lotus.com
www.microsoft.com
www.inklineglobal.net

IInntteeggrraatteedd  
mmaaiill  cclliieenntt

No
Yes
Yes
No
No
Yes
No
Yes
No

OOrrggaanniizzeerr

No
Yes
Yes
Yes
Yes
Yes
Yes
No
Yes

AAddvvaanncceedd
PPhhoonnee  
FFeeaattuurreess
Yes
No
No
Yes
No
No
No
No
No

RRaattiinngg

BB
CC++
CC++
BB
BB
BB--
BB++
AA--
BB++

PPrriiccee

Rs 4,600
Rs 700
Free
Rs 3,000
Rs 1,000
Rs 700
Rs 3,760

Rs 450

The PIM Feature
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E
ver done research in your college days? How
you must have wished there was a way to get
an editable copy of all the research material
that you’d painstakingly photocopied from

the college library. Well, if you have a scanner, or
even if you can get the pages scanned and save
it as an image file, then an OCR software will do
the job of converting it into text format that you
can easily edit in your word processor.

Makes your life quite simple, doesn’t it? The
technology behind the OCR software—the OCR
engine that ensures that you get accurate recog-
nition—is quite a marvel, but let’s forget the
engine, and see how the software actually fare.

TThhee  OOCCRR  ffiieelldd
We tested 10 OCR packages in all, of which
three—OmniPage Pro 10, TextBridge Pro Mil-
lennium and Recognita Plus 5.0—are from the
same company, ScanSoft, though there’s a sepa-
rate Web site for the last product mentioned.

The other popular OCR software we tested
included Fine Reader 5.0 (the latest version, as
opposed to 4.0 that was available last year), and
Presto! OCR. The remaining OCR tested includ-
ed Expervision Typereader 6.0, ReadIris Pro 6.0
and PageGenei Pro. Wocar 2.5 is the only one
among the lot that came for free. Most of the
OCR software had a fully functional trial ver-
sion available for download, and those are the
ones we used for testing, except in the case of
FineReader, OmniPage and TextBridge, where
we received a box pack. The OCR software cover
a range of features from allowing you to scan
normal printed documents to fax and dot
matrix printouts. But if you are looking for the
software to recognise your handwriting, then
you better forget it…that’s still miles away.

AAccccuurraattee  ttoo  aa  ddoott
As we expected, the accuracy of the OCR soft-
ware was highest with the laser document (with
an average accuracy of 99.68 per cent). The

IINN  TTEESSTT:: 10 OCR PACKAGES

Imaging: Jeevanand
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Overall, the results get slightly skewed
in favour of FineReader because of its fine
performance in the fax test. If we exclude
the fax test, and just concentrate on the
laser, photocopy and dot matrix docu-
ments, Recognita Plus comes out margin-
ally better than FineReader and even
Presto! OCR is on par with FineReader. So,
if you work in an area where you regular-
ly have to OCR photocopied documents
(say from books and reports) and not
worry that much about reproducing the
exact formatting, Recognita Plus might be
a slightly better option. However, we feel
you should stick to FFiinneeRReeaaddeerr, which
comes out tops with a recognition accura-
cy of 95 per cent across all documents, fol-
lowed by TextBridge with 93 per cent
accuracy. If you are a media company and
receive faxed press releases on a regular
basis or a sales company with branch
offices sending fax reports, then FineRead-
er would be quite a valuable tool.

RRiigghhtt  iinn  ffoorrmmaattiioonn
If you constantly receive reports and other
data from outstation sources, tables will
form an inevitable part of these docu-
ments. It becomes essential, therefore, that

an OCR retains the cell structure of the
tables even while maintaining accuracy.
Two software that really stood out in this
respect were Presto! OCR and TypeRead-
er. Both of them were 100 per cent accurate
in recognising the table structure, even
recognising the split cells as different cells.
Presto! OCR was even better, for it had a
marginally higher word accuracy than

Expervision. We
found that most
OCR recognised
the first table (with
just rows and
columns) without
any problems. But
the second table
with wrapped text
and split cells was
a problem, and the
software tended 
to recognise each 
line (even with
wrapped text) as

an individual cell, and interchanged text
around with the split cells.

TextBridge claimed it doesn’t recognise
forms and therefore didn’t do well, but
OOmmnniiPPaaggee  PPrroo, the counterpart from the
same company did the best when it came
to recognising the form. However, we are
sceptical about the actual usability of
doing an OCR on forms, for even if the
structure of the form is retained, lines in
which you fill-up data aren’t recognised, so
there will still be some formatting work to
be done before you start off with the form.

Even with the newspapers and the mag-
azines, OmniPage Pro came out best in
terms of retaining format as well as accu-
racy and it had no problem recognising
text on a background. OmniPage worked
by retaining the different columns in the
multi-column stories as frames. However,
there were some problems in changing the
scanner settings in OmniPage as the appli-
cation crashed. Also, while performing the
OCR for the newspapers with automatic

Many of the OCR software under test
allowed us to specify the source material
in terms of whether it was a dot matrix or
typewriter output, whether it had tables
or multiple columns in it. We did try test-
ing the OCR by using these settings
instead of the default settings and with-
out exception we found that the accuracy
dipped, especially with the dot matrix
option. For instance, CuneiForm had 30
errors without the dot matrix option, but
this increased to 49. The same was the
case with OmniPage, Presto! OCR, and
PageGenei Pro. FineReader’s 1 error in
the typing test increased to 2 with the

typewriter source selected. TextBridge Pro
lost most of its recognition in the Fax test
when we specified the paper source as
degraded. 

So, we suggest that you stick to the
automatic or default settings before scan-
ning. Also, the developers recommend
scanning in gray scale (as opposed to line
art) for better accuracy as the contrast
levels are better adjusted.  However, this
again doesn’t make much of a difference
with the laser print document. It’s only
the fax document in FineReader that
showed an improvement in accuracy lev-
els with gray scale scanning.

Recognising the Source

The recognition and formatting percentages are an average of the
results of the laser, photocopying, dot matrix, typing and fax tests
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CONCLUSION
As evident, in terms of overall perform-
ance, FFiinneeRReeaaddeerr scores with good per-
formance in all the tests. It’s among the few
software that could recognise superscripts,
and had the best accuracy in the fax test as
well as the magazine that had reverse text.
FineReader also came out tops as far as
retaining layout goes and at Rs 5,000 is
quite reasonably priced.

TextBridge Pro came very close with a
good feature list that is mind-boggling
and even gets overbearing at times. It also

managed a
fair bit of
a cc u r a c y

in the fax test and recognised the text in
reverse. Even Presto! OCR, which is based
on the FineReader OCR engine, gave a

good performance. Wocar was the only
software that came for free, but apart
from the laser printout test, its perform-
ance is nothing worth writing about and
it had the least scores. We did expect a lot
from OmniPage Pro, and it did quite well
in the magazines and newspapers test as
far as recognition capabilities is con-

cerned. A new version, OmniPage Pro 11,
has recently been released and it is said to
have an enhanced OCR engine along with
support for converting PDFs to text doc-
uments while retaining layouts, so that’s
something you can wait for.

NNaammee

Cognitive
CuneiForm 99
Abbyy FineReader
5.0 Pro

ScanSoft
OmniPage Pro 10

ParaVision
PageGenie Pro 
Newsoft Presto!
OCR Pro 4.0
ReadIris Pro 6.0
Recognita Plus 5.0
TextBridge Pro
Millennium 
Expervision
Typereader 6.0
Wocar 2.5

CCoonnttaacctt

www.ocr.com

Vikmans Multimedia,
Phone: 011-6472325, 
E-mail:
manish@vikmans.com,
www.abbyy.com
Sonata, 
Phone: 022-4943055, 
www.scansoft.com
www.pagegenie.com

www.newsoftinc.com

www.irislink.com
www.recognita.hu
www.scansoft.com

www.expervision.com

http://persoweb.france
net.fr/~cambien

PPrriiccee

Rs 6,000

Rs 5,000

NA

Rs 4,700

Rs 4,700

Rs 6,500
NA
Rs 3,700

Rs 11,700

Free

LLaasseerr
83.45

93.25

73.96

67.36

88.74

86.45
83.43
91.14

82.44

81.17

PPhhoottooccooppyyiinngg
80.41

92.54

75.72

67.27

89.22

82.15
83.40
90.39

88.72

82.48

DDoott  mmaattrriixx
83.75

92.72

89.03

78.64

91.91

63.30
77.50
89.90

89.78

54.76

TTyyppiinngg
68.48

99.57

99.78

71.09

99.57

49.13
0.00
99.13

99.13

46.52

FFaaxx
0.00

80.93

0.00

11.18

0.90

0.00
0.00
49.22

0.00

0.00

TTaabbllee
90.10

98.83

95.20

44.76

99.67

93.25
96.75
97.67

99.00

44.76

NNeewwssppaappeerrss
45.00

92.50

97.50

30.00

75.00

20.00
77.50
45.00

75.00

15.00

MMaaggaazziinnee
35.00

97.50

99.00

55.00

92.50

77.50
95.00
97.00

40.00

15.00

OOvveerraallll**

74.86

90.93

83.81

65.47

84.98

73.53
80.08
89.74

76.41

56.31

RRaattiinngg

BB

AA

AA--

BB--

AA--

BB
AA--
AA

BB++

CC++

Performance of the OCR Packages
AAccccuurraaccyy  aanndd  FFoorrmmaattttiinngg  ((%%))

*The Overall score is the sum of the weighted results in the accuracy and formatting tests as also a reflection of the features
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VARUN SINGH

T
his is the third time apple has made our
eyes pop! First with the iMac, then with
OS X and now this powerful and beau-
tiful Titanium PowerBook G4 slick

brick. The metal that’s been used to make

everything from jewllery to the high quali-
ty parts for the space shuttle has never been
seen in such beautiful shapes before.

Commercially-pure Titanium casing,
rubberised pads all around devices inside
the laptop to prevent shocks, perfectly

packaged equipment and the no-dongle
and no-tray approach in designing all
devices from built-in Ethernet to the DVD
ROM drive makes it a perfect rugged and
reliable piece to lug around. Let’s see the
appealing features this baby has to offer.

G4? Ain't any P4!
A CPU Power Marvel when it came out a
year ago. It has been compared to
supercomputers and other Hi-Dhrystone
churning devices, and is also one of the
most power-efficient laptops. The
Mobile version of the G4 doesn't take
much power, and offers you near-desk-
top class performance without any com-
promises. Whether it's 3D applications
or digital video, this baby will see to it that
you never run out of CPU headroom even
while you are on the move.

Airport in my lap!
Yes! Not just the regular
10/100 Ethernet and 56K
Modem, the PowerBook also
has two Airport Antennas,
one on each side. Airport is
Apple’s own wireless network-
ing machinery that offers you 11 megabits per
second connectivity on the move, and is also
compatible with the 802.11 DSSS wireless
protocol. You need to buy the Airport card
separately to activate these two antennas!

Battery status indicator
This little
button on the
battery lets
you find out
how much
charge is left in the battery without having to
turn it on. And when turned on, the new 
OS X’s battery meter shows you how much
charge is left based on approximate usage
time remaining, rather than just percentage
of charge. Apple promises around 4 hours of
battery life!

Apple of my eye
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Huge screen 
Wider than the viewable area of most 
17-inch desktop monitors and offering res-
olutions as high as 1152x788 pixels, this
wide screen active-matrix display is one of
the cleanest and quite obviously the largest
display available on any laptop nowadays.
It's fun to watch DVD movies in wide screen
modes on this baby. 

All-connected
Although it isn't the first laptop to have all sorts
of connections you can ever imagine, it surely is
the smartest. One 400 megabits per second
FireWire port, two USB 1.0 ports, a 10/100 Mbps
Ethernet port, a 56 Kbps modem, a 4 Mbps IrDA
infrared port, one S-Video Out, one regular VGA
connector for connection to digital projectors
and an extra PC Card and CardBus slot for
upgradeability—all this fits un-intrusively with-
out leaving any kind of dongles or weird but-
tons hanging out of the actual laptop. 

One inch? Are you sure?
We couldn’t believe our ears when we heard that
Apple had managed to pack in the powerful G4 into
the new PowerBook, and we couldn’t believe our eyes
when we saw it right in front of us. A design marvel,
this laptop is the most compact device in its class you
would ever see. A fully loaded Titanium weighs only
5.3 pounds, and is just about one-inch thick. But don't
think that makes it any less robust! 

Slot-In DVD! Now we’re talking!
Those of us who have seen Pioneer’s slot-In DVD
drives,know they are the most robust with no trays that
can break. Strangely, nobody except Apple ever
thought of putting in a slot-in DVD-ROM drive in any of
their laptops. Simple and smooth to operate, but a lit-
tle noisy, this little slot will always be wheelin’ for fun.
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P
eer-to-peer (P2P) technology
came to the forefront of popu-
lar consciousness when Nap-
ster’s music sharing network

became a rage, and drew attention for
various reasons. While the future of
Napster may be uncertain, the under-
lying peer-to-peer technology is poised
to change the way we use networks.

A P2P network essentially consists of
several computers (or peers) that direct-
ly exchange data among themselves. This
is quite unlike a client-server model where
all clients (or computers) get data from a
single central server. The functions of
searching for data and the actual exchange
of data take place via software that is
installed on the participating machines.

NNaappsstteerr::  SSeeaarrcchh  oonn  sseerrvveerr,,  sshhaarree  wwiitthh  ppeeeerr
There are several different ways in which

P2P technology can be implemented. In the case
of Napster, the software uses your Internet con-
nection to log you into a central Napster server.

The purpose of the server is to maintain an index
of all users online at any particular moment, and
help them connect to each other. It also ensures
that every user on the network has shared a direc-
tory on their computer that other remote users
can access, and that only MP3 files are exchanged.

When you key in a search for a particular title
or artist, the client software queries the index
server to find a match. When a match is found,
the server displays a list of all systems that have
the file in the results window. Clicking on the file
establishes a direct connection between your
computer and the system that stores the selected
file. On successful connection, the file begins
downloading. The connection is broken once

the download is complete.

GGnnuutteellllaa::  NNoo  sseerrvveerr,,  jjuusstt  ppeeeerrss
In the case of Gnutella however, which is an
open source P2P file sharing network, all
transfers happen without a central server.
Each Gnutella client combines the functions
of a search engine and a file-serving agent.
When you enter a search for information, the
client software goes and searches for other

With P2P networks,
you can exchange
files directly between
the participating
computers and avoid
central servers

Illustration: Mahesh Bhenkar

A Bypass for
EXCHANGE
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clients that could have this information. If a match
is located, then the software creates a connection
that allows you to download the files directly.

Gnutella is actually much more versatile than
Napster because it allows users to share any type
of file, not just MP3s. Also, the absence of a cen-
tral index server means that the clients are almost
impossible to locate. This reduces the vulnera-
bility of the network to different types of net-
work attacks.

However, the distributed search mechanism
used by Gnutella is somewhat inefficient.
Because it can only detect clients that respond to
a request for information, it may not find match-
es that lie beyond its ‘horizon’, or in other words,
are ‘out of sight’ of the software.

FFrreeeenneett::  aann  aalltteerrnnaattee  IInntteerrnneett
Freenet, another P2P system similar to Gnutella,
is working towards creating an entire alternate
Internet, which tries to get around the regular
structure of the Web, which involves the use of
servers to exchange information. Think of it as a
group of computers (individual users) connect-
ed through the Freenet software, which identifies
others on the network.

When searching for specific information on

Freenet, the Freenet software sends
out the request in the form of a
search string via the Internet to all
other Freenet clients. These clients
then try and match this string with
the ones stored on them. If a client
finds a match, it sends a response to
the computer from where the request
originated. This response not only
contains the requested data but also
the address of the node that sent the
response known as ‘reference’.

In case a node doesn’t have the
requested data but knows the refer-
ence of one that does (just like a
bookmark), it passes on the request
to the ‘bookmarked’ client. This
process goes on and on till the user
who made the request initially stops
the search.

SSpprreeaaddiinngg  tthhee  RRuummoorr::  MMccAAffeeee’’ss
VViirruussSSccaann  AASSaaPP  sseerrvviiccee

In addition to file sharing and col-
laboration, P2P technology is also
being used to develop software that
helps in improving the efficiency and
reliability of software used by enter-
prises to protect their networks.

Rumor is a technology used in
McAfee’s VirusScan ASaP service,
(formerly called myCIO) that allows
PCs on a network to become servers
and provide other clients with updat-

ed virus signature files. The first user to log on
downloads an anti-virus update from the server
via the Internet. Then, this user plays the role of
the server for others on the network. Every time
a patch is released or a virus definition is updat-
ed, the system retrieves the latest file and auto-
matically serves it to any client that needs it.

Rumor uses a technology called token-based
authentication that ensures that only legitimate
anti-virus update files can be shared. This helps
eliminate the possibility of rogue files spreading
over the network. Another advantage that Rumor
has over a system such as Napster is that it detects
an incomplete download (due to a broken con-
nection) and allows the process to be resumed
later. This eliminates the likelihood of incomplete
files being distributed through the network.

Another interesting feature is the application-
independence of the technology. This will allow
the system to be extended to deliver other file
updates to users, including all kinds of security
software such as firewalls and other intrusion
detection software.

TThheerree  aarree  mmoorree……
The list of new P2P-based applications goes on.
Groove, a corporate example, is a networking
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Intel and United Devices
have set up a ‘virtual super-
computer’ to aid researchers
optimising a drug for curing
leukemia. 

The virtual supercomput-
er, which is quite similar to
SETi which is being used to
search for extraterrestrial
intelligence, will use a con-
cept called distributes com-
puting that allows utilisation
of unused processing power
and hard disk space of mil-
lions of computers from
across the Internet. Each
computer downloads a
small application that analy-
ses the cancer-fighting prop-
erties of 250 million
molecules. When finished, it
sends processed data back
to researchers, for further
analysis. 

Depending on how
many people choose to par-
ticipate, the time required to
develop new drugs could be
cut down to as little as five
years from the current esti-
mate of 12 years.

The Humane Side

Infographics: Jaya Shetty

Site A asks site B for data matching ‘ZIP’. After passing back
anything that might be of interest, site B passes the request
on to its colleague (same as reference or bookmark) at site
C and keeps a record that site A has made the request. If
site C has something matching the request, it gives the
information to site B, which remembers that it is meant for
site A and passes it through to that site.

Napster: How it Works

WWhhiitteeppaappeerrss  on 
peer-to-peer technologies 
Check out
MMiinnddwwaarree



application based on a P2P
architecture whose goal is to
connect people over the Inter-
net or a local network and then
allow them to work together on
a common project.

The software allows users to
collaborate in encrypted,
shared spaces that are stored
on the computer of each mem-
ber of the virtual meeting
place. This can be beneficial for
enterprises because it lets them
provide employees with an
environment that is conducive
to collaboration while also
utilising the storage capacity of
the hard drives of users instead
of having to dedicate a central
file server to the task. The ability to update files
when offline clients log on and optimum band-
width utilisation are other reasons why Groove
is useful for individuals who do not have high
Internet or LAN speeds.

Consider a Groove-generated collaborative
environment where three people are working on
the same file. Person A makes a change to the
file, which means that the remaining two should

be informed about the change. Instead of send-
ing the complete file, Groove sends only the
delta (a data packet in Groove) for the changed
portion, thus saving bandwidth.

OpenCola Folders is another product that
attempts to tackle the problem of information
overload caused by inefficiencies in convention-
al search engine technologies. It allows users to
configure the software to search for information
with the option to specify additional parameters
such as document type. The software then goes
out and checks whether other OpenCola Fold-
ers can provide it with the required information.

SSoo,,  wwhhaatt’’ss  nneexxtt??
The fact that P2P technology provides develop-
ers with a networking architecture that facilitates
direct communication between people makes it
very popular for applications that involve the
exchange of data. However, this is just the tip of
the iceberg.

Coming soon are intelligent search engines
like BadBlue (www.badblue.com) that use P2P
agents to search networks for files that have been
publicly shared by users. This will probably lead
to the next step in the evolution of search engine
technology.

But some of the more complex applications
that are beginning to come out 
now are those that improve the utilisation of
network resources. Chaincasting, from Chain-
Cast Networks (www.chaincast.com/technology/
chaincasting.html), involves the use of P2P tech-
nologies to establish streaming chains that
reduce the costs associated with the high band-
width requirements for video streaming.

Whether it is entertainment or work, P2P
technology is not just making its presence felt,
but is also providing a viable and preferred alter-
native to client-server networking. So if you still
aren’t a link in the P2P network, prepare to
become one very soon.

July 2001
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Rumor Technology is used to broadcast antivirus and firewall con-
figuration updates to all computers on a single network 

Sample Gnutella Network
JXTA is a protocol, like
TCP/IP or FTP, being devel-
oped by Sun Microsystems,
which could be used to
develop a distributed net-
work using P2P technology,
and to develop basic build-
ing blocks and services for
P2P networks.

The present P2P applica-
tions, excluding Groove and
to a certain extent Gnutella,
are capable of performing
only one task. For example,
Napster is only for file-shar-
ing, SETI@Home or Rumor
only for resource sharing,
and so on. What JXTA plans
to achieve is to design an
application that will be able
to handle file-sharing,
instant messaging, as well
as resource sharing from
one single interface. 

A JXTA stack

1/4 Page AD
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Radar
Plextor’s latest CD-Writer, IBM’s TransNote, a CD-ROM drive, a
motherboard, a graphics card for great gaming experience and
other hardware

HHAARRDDWWAARREE

Best buy for a high-end gam-
ing experience at a normal

cost. The card performed well in
the tests. 

It is capable of delivering a
cool 700 million Texel fill rate
and has processing capabilities
of up to 20 million triangles/sec-
ond. The heat sink on the card
makes it a good buy for the over-
clocker.

ASUS GeForce2 MX
Performance
Build Quality
Value for Money
Features
OOVVEERRAALLLL

verdict B +Great gaming experience AASSUUSS  GGeeFFoorrccee22  MMXX  ((AAGGPP--VV77110000))

+ Very good performance 
+TV out slot
+ Heat sink
Price: Rs.10,500 
Contact: Rashi Peripherals
Phone: 022-8260258 Fax: 022-8190766
E-mail: kalavr@rptechindia.com
Web site: www.rptechindia.com

This astonishingly small drive
comes with a storage capacity

of 1 GB and a compact flash
adapter card  which it uses to con-
nect to the PCMCIA bay of the lap-
top. The drive is a blessing, in
terms of its storage capacity, for
those who use the laptop exten-
sively and need to transfer data to
and from a desktop PC.

verdict B +
Small but spacious IIBBMM  MMiiccrrooddrriivvee

+ Very compact
+1 GB storage capacity 
Price: Rs 23,000 + taxes 
Contact: Zeta Technology
Phone: 022-4102277  
Fax: 022-4100949
E-mail: tejas@zetaindia.com
Web site: www.zetaindia.com

This writer comes with the
BURN proof technology, which

always keeps the buffer full while
the CD is being burned. This is
especially helpful at high speeds,
where even a slight slack in the
data flow can damage the CD.
Though the writing speed has
been improved majorly, the eras-
ing speed is average.

verdict B +
The write thing PPlleexxttoorr  PPlleexxwwrriitteerr

1166//1100//4400  PPXX--11661100TTAAWW

IBM Microdrive
Performance
Build Quality
Value for Money
Features
OOVVEERRAALLLL

+ Very fast 
+ Nero CD burning software included
– Average file copy speed
Price: Rs 13,950 + taxes 
Contact: Zeta Technologies
Phone: 022-4102277  Fax: 022-4100949
E-mail: tejas@zetaindia.com
Web site: www.zetaindia.com

Plextor Plexwriter 
Performance
Build Quality
Value for Money
Features
OOVVEERRAALLLL

SPECIFICATIONS:  
BURN proof technology
Features: fan at the back
chassis to keep the internal
drive electronics, motor and
head cool
Bundled software: included
AHEAD Nero 5 CD-Burning
software
Benchmarks:
19 minutes 42 seconds to
erase/write 650 MB of data;
1250 in CD-Winbench 99,
586 KBps random read, 134
ms average access time 
SiSoft Sandra: 19 minutes
45 seconds at 4x; 6 minutes
51 seconds at 12x

SPECIFICATIONS:   
180 MHz core speed, 166
MHz memory run clock
speed
Bundled software: Drivers,
ASUS DVD 2000, 3DEEP,
Soldier of Fortune
Benchmarks:
Quake III: 102.6 fps (normal
mode), 84.3 fps (high quality
mode); 31.6 fps (1280x1024)
MBTR test: 51.5 fps
(640x480 at 16-bit); 50.9 fps
(640x480 at 32-bit)
1835 in 3D Mark 2001

■■ sseelleecctt~~rreeppoorrtt  ccaarrdd

MMoorree  IInnffoo  on 
the hardware products tested.
Check out
MMiinnddwwaarree

SPECIFICATIONS:  
Interface: PCMCIA
1 GB capacity; compact flash
adapter card; 3600 rpm
drive spindle speed
Benchmarks: 
Drive did not respond in
SiSoft Sandra 2001; drive not
detected in HDTach due to
shortcoming in benchmark   
3 minutes 8.75 seconds to
copy 100 MB from primary
disk; 2 minutes 48.28 sec-
onds to copy to primary disk 
3 minutes 7.62 seconds to
copy 10x10 MB files from pri-
mary hard disk; 2 minutes
44.30 seconds to copy to pri-
mary disk
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Designed to look like a slick
folder, it opens up to show

you two very innovative things: a
foldable and flip-display touch
screen on one side and a big A4-
sized notepad on the other. This
notepad is powered independent-
ly and lets you take notes as if on
regular paper with a special pen
provided.

verdict B +Slim and slick IIBBMM  TTrraannssNNoottee

+ Feature rich
– Small screen
Price: Rs 2,30,000 
Contact: IBM India
Phone: 080-2079999 
E-mail: isawkar@in.ibm.com
Web site: www.ibm.com/in

This card allocates 370-MB
buffer space, which contains

an image of the entire hard disk.
The image is accessible only when
you restart the PC and press the
restore key, which can be pass-
word protected. It’s completely
independent of the size of the
hard disk and protects the hard
drive from viruses and destructive
changes in software configuration. 

verdict B +Restores in a jiffy TTuurrbboo  PPrrootteecctt  CCaarrdd

+ Fast restore
+ Password-protected restore key
– Bit difficult to understand
Price: Rs 4,450 (+ Rs 250 for installation)  
Contact: Turbo Tech
Phone: 022-5705744 Fax: 022-5705755
E-mail: info@turbotech.com
Web site: www.turbotech.com

The board couldn’t go beyond
69 fps in Quake III. You should

download the four-in-one driver
from the VIA site, as the one bun-
dled with the board does no good
to its performance. Though rea-
sonably priced, it still doesn’t offer
the juice that you can get from
other boards in the same category.
Definitely not suitable for gamers
and graphics application users. 

verdict BNot a star performer

+ Gave data transfer performance
+ Poor graphics performers
– Only two PCI slots
Price: Rs 4,500 
Contact: BMI Technologies Pvt Ltd
Phone: 080-5582359
Fax: 080-5582207
E-mail: harishkr@postmark.net

IBM TransNote
Performance
Build Quality
Value for Money
Features
OOVVEERRAALLLL

Terbo Protect Card
Performance
Build Quality
Value for Money
Features
OOVVEERRAALLLL

This 56x card performed well in
all the tests. The amount of

time it took to rip 25-MB tracks
(first, middle and last track) from
an audio CD to MP3 format was
impressive. Though it didn’t come
with any bundled software or
manual, at the present price level,
it’s worth a closer look and is a
good buy for the home PC.

verdict B +Fast reader AAPPEEXX  CCDD--RROOMM  5566xx  ddrriivvee

+ Very cheap
+ Fast ripping time
– No bundled driver or manual 
– No play button
Price: Rs 2,000 
Contact: Apex Computer
Phone: 080-8368483

APEX CD-ROM 56x 
Performance
Build Quality
Value for Money
Features
OOVVEERRAALLLL

BIOSTAR Motherboard M6VCF
Performance
Build Quality
Value for Money
Features
OOVVEERRAALLLL

SPECIFICATIONS: 
Allocates 370 MB of buffer
space
OS support: DOS/Win
3.1/98/NT/2000
Benchmarks:
8-10 seconds to restore lost
data and partitions

SPECIFICATIONS:
Interface: IDE
Features: 56x read speed,
digital and analog out 
Benchmarks:
2328 overall score in SiSoft
Sandra 2001, 3.3 MBps
sequential read speed, 757
KBps random read speed
1940 in CD-Winmark
19 seconds to rip 25 MB
tracks from audio CD to
MP3 from the first track, 35
seconds to rip from the
middle track, 43 seconds to
rip from last track

BBIIOOSSTTAARR  MMootthheerrbbooaarrdd
MM66VVCCFF

SPECIFICATIONS:
VIA 82C964X north bridge
chipset, two PCI slots, 4x
AGP slot. 
Benchmarks: 
69 fps in Quake III, 26.1 fps
in MBTR at 640x480 resolu-
tion at 32-bit depth, 23963
drive index in SiSoft Sandra
2001, 36 MBps sequential
read speed, 8 MBps random
read speed, 24.6 in Content
Creation Winston 2000

SPECIFICATIONS:  
Pentium III 600 MHz proces-
sor, 64 MB RAM, 10 GB HDD,
integrated 10/100 Ethernet,
56K modem, 10.4 inch TFT
Touch screen
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Radar
The latest software in the market for editing photos, logging PC activity,
encryption and more

SSOOFFTTWWAARREE

An encryption utility for Win-
dows having two modes. The

File encryption mode lets you
assign a password to a file and
even hide a file inside another. In
the Private Folder mode, your
folder will be visible in Explorer
only after you launch the software
and key in the password. A great
way to protect sensitive data.

Two-level encryption KKPPKKFFiillee

This anti-virus package has a
well-laid-out interface. Though

it doesn't feature DOS scanning
during bootup, this is not an issue
if you are using versions of Win-
dows that do not use DOS. Over-
all, a good package for users who
are frequently online. Mail Scan is
an independent software and can
be purchased separately.

Protection against bugs

+ Good virus detection and cleaning 
+ Respectable detection of Zipped viruses
– No bootup scans in DOS
Price: Rs 1,800
Contact: Microworld Software Services
Phone: 022-8265701 Fax: 022-8344750
E-mail: vig@mspl.net
Web site: www.mspl.net

Photoshop 6 is much easier to
use than any of its previous

versions and includes additional
features such as the Liquify effect,
the option to add sound-based
descriptions to image files, and
the Web Photo Gallery which con-
verts images automatically for use
on the Net, thus making it a com-
plete and an extremely feature-
rich image editing software. 

Designing fun AAddoobbee  PPhhoottoosshhoopp  66

+ Free
+ Good encryption features
– Bad interface, difficult to use
Price: Freeware
E-mail: john52612000@yahoo.com 

verdict B
KPKFile
Ease of use
Features
Performance
Value for money
OOVVEERRAALLLL

verdict B +
eScan Pro
Ease of use
Features
Performance
Value for money
OOVVEERRAALLLL

+ User friendly, good support for the Web
– Occupies quite a bit of space on the
hard disk, quite resource hungry
Price: Rs 39,456
Contact: Adobe System 
Phone: 022-6437209 Fax: 022-6432275
E-mail: hgoel@adobe.com 
Web site: www.adobe.com 

verdict A -
Adobe Photoshop 6
Ease of use
Features
Performance
Value for money
OOVVEERRAALLLL

MMoorree  IInnffoo  on 
the software products tested. 
Check out
MMiinnddwwaarree

SPECIFICATIONS:
12 MB install size,
requires 5 MB RAM
Features: updates on
virus definitions available
on their site, blocks script
and scans mail 
Benchmarks: 
Virus detection of 99 per
cent; cleaning rate of
72.25 per cent; 10 min-
utes 12 seconds to scan
7,500 viruses

SPECIFICATIONS:
Features: Support for
vector images, extra bar
below the menu bar with
additional settings for
each tool, Wrap Text fea-
ture allows you to apply
various styles to text,
Step Forward and Back-
ward features for Undo
and Redo, more options
to lock layer, Web Photo
Gallery to uplink images
to the Web

eeSSccaann  PPrroo

SPECIFICATIONS: 
Features: Special folder
created which is impos-
sible to access without
password, buries file
inside file
Download Size: 1.57 MB
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The new improved features in
this version are its password

support, conversion of FAT32 file
system to NTFS, support for Win
Me and Win 2000 professional,
and a wizard for copy partition
and undelete partition, which
make it more user friendly and a
complete utility in itself. Partition-
Info gives you information about
the partitions on your hard disk.

Of splits and partitions

This anti-virus program proved
to be below par in detecting old

and new viruses. It failed to detect
any of the 9000 viruses we used
for testing in the compressed
form. The software succeeded in
detecting and repairing the viruses
only after they were extracted into
a temp folder. Protector Plus also
lacks features such as scanning
your e-mail for virus.

Poor show PPrrootteeccttoorr  PPlluuss  22000000

This version is more advanced
and can perform more jobs.

The new features include auto
backup of the client machine; the
ability to load the disk image with
different hardware configurations;
the ability to customise the client
computer to individual or group
needs by cloning the image of one
computer on all the other
machines over the network.

SPECIFICATIONS:
Features: Images can be
dumped onto a client
machine through the net-
work, lets you dump
image on the PC with dif-
ferent hardware configu-
rations, simplified
backup and recovery 

Ghost of an image SSyymmaanntteecc  GGhhoosstt  77..00

This video editing software
comes along with a PCI capture

card. It lets you capture VHS from
camcorders or any other record-
ing device to your PC through the
PCI capture card. It lets you cap-
ture full length, full motion videos
on your PC. The installation is sim-
ple and takes around 104 MB of
disk space with additional tools for
non-linear editing.

Video editor SSttuuddiioo  DDCC  PPlluuss  1100  
SPECIFICATIONS:
104 MB free hard disk
space; compression ratio:
user selectable from
3.1:1 to 100:1; maximum
resolution of 640x480, 30
frames/60 fields per sec-
ond; 640x480, 30
frames/60 fields per sec-
ond output
Features: Additional tools
for non-linear editing
(Micro Video Expert, Stu-
dio DC10 Hardware Test,
Vidcap, DirectX diagnos-
tic tools), facility to insert
sound files and titles

SPECIFICATIONS:
Features: Multiple oper-
ating system manage-
ment; support for FAT,
FAT32, Linux Ext2, Linux
SWAP, NTFS, and HPFS
partitions

PPaarrttiittiioonn  MMaaggiicc  66..00

SPECIFICATIONS:
Features: DOS boot up
check, browsing virus
scan, download scan,
script blocking, can cre-
ate reports and down-
load updates
Benchmarks: 
No viruses detected in
compressed form
To test detection capabili-
ties in the uncompressed
form, we unzipped some
of the newer and dead-
lier viruses and it detect-
ed all of them

verdict A -

+ Intuitive interface
+ Easy to use
+ Feature rich
Price: Rs 3,150
Contact: G.T. Enterprise
Phone: 080-6606093 Fax: 080-6671407
E-mail: gtcdrom@vsnl.com
Web site: www.gtcdrom.com

Partition Magic 6.0
Ease of use
Features
Performance
Value for Money
OOVVEERRAALLLL

verdict B

+ Easy installation, simple to use
+ Virus updates from the Net
– No viruses detected in compressed
form, no e-mail scanning
Price: Rs 1,950 Contact: Adit Microsys
Phone: 079-6400255
E-mail: sales@aditmicrosys.com
Web site: www.aditmicrosys.com

Protector Plus 2000
Ease of use
Features
Performance
Value for Money
OOVVEERRAALLLL

verdict B +
Symantec Ghost 7.0
Ease of use
Features
Performance
Value for Money
OOVVEERRAALLLL

+ Feature rich
+ Very detailed manual
– Bit difficult for first timer
Price: Dependent on number of users 
Contact: Tech Pacific 
Phone: 022-5960227
E-mail: vpai@symantec.com

Studio DC Plus 10
Ease of use
Features
Performance
Value for Money
OOVVEERRAALLLL

verdict B +

+ Compact, easy to use, cheap
– Fewer features
Price: Rs11,899
Contact: Pinnacle Systems
Phone: 011-6464505
Fax: 011-6231431
E-mail: ksanghi@pinnaclesys.com
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Reviews
MMaannoorraammaa  KKnnoowwlleeddggee  
AAddvveennttuurree  22000011

Developer: Malayala
Manorama
Contact: Corporate Voice
Shandwick
Phone: 022-2022293
E-mail: cvsmum@
corvoshandwick.co.in
Price: Rs 495
Rating: 

TThhee  IInntteerrnneett  
EEccoonnoommyy  ooff  IInnddiiaa
This book provides you with
insights into the Internet
Economy of India. The book
contains articles, inter-
views related to vari-
ous aspects of the
Internet in India such
as cyber laws, band-
width, e-commerce
and more.
Developer: INOMY
Media
Phone: 022-2070989
E-mail:
cbsbom@giabm01.vsnl.net.in
Price: Rs 495

CCOOMM++&&XXMMLL::
AASSPP..NNEETT  oonn  TThhee
EEddggee
This is a book for developers
and is about writing
enterprise applica-
tions and covers the
basics of .Net archi-
tecture, the workings
of COM+, ASP.NET and
XML, through building
complete Web-based
applications.
Contact: IDG Books India
E-mail: idgbooks@vsnl.com,
hungryminds@vsnl.net
Price: Rs 249

OODDYYSSSSEEYY  22000011::
EExxpplloorriinngg  tthhee  
IInntteerrnneett
Written in a simple,
easy-to-understand
language, this book
provides you with a
basic introduction to
the Internet. It also pro-
vides a huge list of for-
eign and Indian sites
under various cate-
gories. 
Contact: Proman 
Assosciates
Phone: 022-8016434
E-mail: corporate@proman.net
Price: Rs 290

On the Stands
This CD from the publishers

of Malayalam Manorama
contains a lot of useful infor-
mation and offers easy
manoeuvrability among the
various topics such as ‘India
Panorama’, ‘Quiz’ and more.
Interesting sections include
‘Quiz’ which allows you to test
your visual, auditory and gen-
eral knowledge skills, and
‘Media’ with a collection of
audios, videos, animations,
charts and more. 

Knowledge trip

FFoorreeiiggnn  LLaannuuaaggee  
AAddvvaannttaaggee  22000011

Developer: Encore 
Software
Contact: Microware 
Computer Services
Phone: 022-8729225
E-mail:
sales@mwcdrom.com
Price: Rs 1500
Rating: 

Want to learn a foreign lan-
guage? This five-CD pack

offers you a choice of six popu-
lar international languages—
Spanish, Italian, French,
Portuguese, German, and
Japanese—coupled with a
Talking Dictionary and Vocabu-
lary Builder. It also provides you
the basics of vocabulary and
pronunciation, lets you listen to
dialogues and record and play
back your own in the desired
language.

Linguistic fun

RRiivveerrss  &&  LLaakkeess

Developer: BPB Multimedia
Contact: BPB Publications
Phone: 011-3254990/91,
3272329, 3250318
E-mail: bpb@vsnl.com
giasbm01.vsnl.net.in
Price: Rs 599
Rating: 

If you work for an advertising
agency, design agency or

need some good-looking
images for your Web site then
this is the CD for you. There are
various images under different
categories and they are all roy-
alty free so you needn’t bother
about copyrights. This CD
boasts of 1001 royalty-free
images of picturesque moun-
tains, rivers and lakes. The
images come in high resolution
JPG, BMP and PICT formats.

Image shopping

■■ sseelleecctt~~rreeppoorrtt  ccaarrdd

AArreennaa  
For game reviews 
check out,
PPllaayywwaarree



July 2001

■■ sseelleecctt~~rreeppoorrtt  ccaarrdd

146

The cable experience

Cable operators
usually provide the
Internet connection

through a WAN,
which connects a

large number of
buildings and

residences through a
central server

B
andwidth of up to 256 Kbps! Download
speed of up to 24 Kbytes per second! My
eyes goggled and my mind boggled. Adren-
aline pumped through my entire system.

Everything that was being said about cable Inter-
net seemed to be too good! Too good to be true,
in fact. So I decided to find out for myself if this
latest boon for Internet junkies was in fact every-
thing that it was cracked up to be.

My first stop was in the vicinity of Santa Cruz
and Bandra in Mumbai, where I spoke to two
cable operators, who are now providing Inter-
net access. What they had to say about the ben-
efits of cable Internet was nothing that I hadn’t
already heard—“This connection is not through
the phone…this is the fastest form of Internet
access that you can get for your home…you
won’t have to pay any phone bills to surf the
Net…you can get online whenever you want to,
for however long you want…”

I was definitely intrigued, so I decided to take
a closer look at how these operators actually go
about setting up your cable Internet connection.
What I learnt was that in reality, none of these
operators actually offered ‘cable Internet access’
in the true sense of the phrase. Cable Internet
access usually requires a cable modem for each
individual connection. But what I found was
that cable operators usually provide the Internet
connection through a WAN, which connects a
large number of buildings and residences
through a central server. A conventional LAN

card is installed on your computer and you are
then linked to the operator’s central server using
either the standard UTP (Unshielded Twisted
Pair) or coaxial cable. This method of connec-
tivity is similar to the manner in which homes
are connected with cable TV and—as I realized
while overseeing one of the installations—just
as unstructured! A wire is simply strung from
one house to another via a hub. In a housing
society, this would imply wires running all over
the place, over windowpanes, over pipes and
along them, and it gets even messier as the num-
ber of subscribers increases.

I also found that the only factor that differed
from one operator to the other was the cost of
installation and the monthly charges. In places
where cable Internet services were already avail-
able for a couple of months, the monthly rentals
were approximately Rs 100 to Rs 300 cheaper
than in places where cable services had just been
set up. Installation charges ranged between Rs
4,000 to Rs 6,000 and all operators I spoke with
offered a 100 Mbps LAN card as part of the
installation. I found that operators preferred
UTP cables over coaxial cables because they were
easy to install. “Troubleshooting connections
with UTP cables is much easier compared to
coaxial cables–lesser janjhat!”

What about the special services offered with
cable Internet, you ask? Well, if the operator has
a private ISP license and his own Web server,
then you could get an e-mail account. You could
also get telephony services, allowing you to make
long-distance calls over the Internet at much
cheaper rates. While most operators said they
were in the process of procuring a private ISP
license and having their own Web server run-
ning, they seemed hesitant about providing
telephony services as Internet-based telephony
services are not yet legal in India.

Well, all said and done, cable Internet does
provide faster access and download speeds, but
only when a few people are online. In a cabled
network neighborhood, a large number of
households share a single transmission cable and
the bandwidth gets split among all of them. So
performance tends to take a big dip at peak
hour.

Keep these points in mind while going
in for a cable Internet connection
■ Preferably go in for the Internet con-
nection in a group. Cable operators
give discounts when more than one
person goes in for the connection as
part of a group. It’s also easier to
implement if your neighbour has a
connection.
■ If you buy the LAN card yourself
rather than having the operator install
it, you can save a couple of hundred
rupees.

■ Go in for the ‘unlimited package’
where there is no time restriction on
how long you can surf, as opposed to a
time-restricted scheme. Some operators
do offer this, so make sure you go in for
the right package.
■ Get in touch with the technical per-
sonnel and find out the actual mini-
mum that your speed could drop to.
See that this is not lower than 64 Kbps,
otherwise there would effectively be lit-
tle difference compared to your older
modem-based Internet experience.

Smart Buyer Tips

UUNNDDEERRCCOOVVEERR

Want to share your experiences with getting a cable Internet
connection installed? 
Write in to readersletters@jasubhai.com 

Agent 001 files his report on the cable Internet scene. Read on to see
whether a cable Internet connection is the answer to your surfing woes
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■■ sseelleecctt~~rreeppoorrtt  ccaarrdd

W
ho’s in, who’s out? The competition’s hot,
but only the winners get to this page—a list-
ing of the best performing hardware and

software that have been tested till date in differ-
ent categories.

Every month, at the Digital Media Test &
Research Centre, we carry out a series of com-
parison tests as well as individual product

reviews. Based on these tests, the best products
have been listed here (detailed reviews on Digit
Interactive-Mindware). As different products get
reviewed over the months, the top products
might find themselves slipping out of the charts
and replaced by the latest entrants in the market.
So, keep your ears sharp and eyes open and keep
yourself abreast of the latest cool products.

A listing of the best products in different hardware and software categories

A-List

HARDWARE
Monitors (14- & 15-inch)
SSoonnyy  CCPPDD--EE110000
+ Good features and performance
– Not for professionals
Contact: Rashi Peripherals
Phone: 022-8260258
Fax: 022-8190766
Price: Rs 14,100

Monitors (17-inch)
VViieewwSSoonniicc  PPSS777755
+ Very good image quality
+ Support for high resolution
Contact: Roop Electronics
Phone: 022-6631521
Fax: 022-6103919
Price: Rs 24,000

Monitors(19- & 21-inch)
SSoonnyy  CCPPDD--GG550000
+ Truly flat 21-inch screen; support
for nearly every type of image
Contact: Rashi Peripherals
Phone: 022-8260258
Fax: 022-8190766
Price: Rs 86,500

Graphics card
AASSUUSS  VV77770000  GGeeFFoorrccee  22
GGTTSS  UUllttrraa
+ Blazingly Fast; DDR memory
Contact: Mnemonic Systems

Phone: 022-8260258
Fax: 022-8190766
Price: Rs. 31,500

Speakers
CCrreeaattiivvee  SSoouunnddWWoorrkkss
DDTTTT33550000
+ True Dolby Digital-compliant
sound
Contact: Compuage Infocom
Phone: 022-4913986
Fax: 022-4919069
Price: Rs 30,000

Soundcards
SSoouunnddBBllaasstteerr  LLiivvee!!  
PPllaattiinnuumm  55..11
+ Dolby Digital AC-3 
compliant
+ High quality sound 
processing
Contact: Compuage Infocom
Phone: 022-4913986
Fax: 022-4919069
Price: Rs 12,500

Motherboards
AASSUUSS  PP44TT
+ Fits into any ATX cabinet
+ Good feature list
Contact: Rashi Peripherals
Phone: 022-8260258
Fax: 022-8190766
Price: Rs 17,500

Processors
PPeennttiiuumm  44  --  11..44  GGHHzz
+ Fastest processor tested by us
+ Good build quality
Contact: Ockam Systems
Phone: 022-6234798
Fax: 022-6704503
Price: Rs 35,000 (kit including 

motherboard, 128 MB RDRAM and 
cabinet)

Hard disks (SCSI)
SSeeaaggaattee  CChheeeettaahh  1188XXLL  --
SSTT331188440044LLWW  --  1188GGBB
+ Blazingly fast
– Heats up quite a lot

Contact: ACI
Phone: 022-8595830
Fax: 022-8595831
Price: Rs 16,500

Hard disks (IDE)
IIBBMM  DDeesskkssttaarr  7755GGXXPP
DDTTLLAA--330077007755  --  7755GGBB
+ 10,000 RPM; good data transfer
+ 1 MB buffer
Contact: Wales Technologies
Phone: 022-3828100
Fax: 022-3828200
Price: Rs 19,500

DVD drives
AAooppeenn  11664400  PPrroo  DDVVDD
+ 16x DVD speeds; 512 KB cache
+ Good build quality
– Does not support DMA
Contact: Yogi Comp

Phone: 022-8806582
Fax: 022-8806582
Price: Rs 5,950

CD drives
AASSUUSS  CCDD--SS550000  
+ Good performance
– Slightly inferior build quality 
Contact: Rashi Peripherals
Phone: 022-8260258
Fax: 022-8190766
Price: Rs 3,000

CD-RW drives
PPlleexxttoorr  WW11661100TTAA
+ High write and rewrite speed
+ 2 MB buffer
Contact: Zeta Technologies
Phone: 022-4102277
Fax: 022-4102277
Price: Rs 13,950

Laser Printers
LLeexxmmaarrkk  OOppttrraa  MM441122

+ Good print speeds
– Image quality isn’t that good
Contact: T.V.S. Electronics
Phone: 044-2325506
Fax: 044-2327577
Price: Rs 42,995 + taxes

MMoorree  IInnffoo  on 
the top five products tested in each
category. Check out 
MMiinnddwwaarree
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Inkjet Printers
EEppssoonn  SSttyylluuss  CCoolloorr  888800
+ Very quiet; good results
+ Print resolution of 2880 dpi
Contact: Epson India
Phone: 022-8257286
Fax: 022-8267287
Price: Rs 19,000

Scanners
EEppssoonn  PPeerrffeeccttiioonn  11664400SSUU

+ Transparency unit included as
standard accessory
+ Fast image scanning
– Too bulky (4.5 kgs)
Contact: Epson India
Phone: 080-5321266/70
Fax: 080-5581799
Price: Rs 22,500

PCs
DDeellll  DDiimmeennssiioonn  44110000

+ Customisation possible
– Too compact for expansion
Contact: Dell Computers
Phone: 1600338044 Toll free
Fax: 1600338046 Toll free 
Price: Rs 81,999

Laptops
ZZeenniitthh  2211AA  CCoorrppoorraattee  NNoottee--
bbooookk  
+ Feature packed
+ Excellent performance
– A little bulky
Contact: Zenith 
Computers
Phone: 022-8377300
Fax: 022-8364859
Price: Rs 1,25,000

External Storage Devices
IIOOMMEEGGAA  22GGBB  JJaazz
+ Very good price per MB; hard-
disk-class performance
Contact: Neoteric Infomatique
Phone: 022-4172600
Fax: 022-4163679
Price: Rs 17,500

Handhelds
HHPP  JJoorrnnaaddaa  668800EE
+ Power 133 MHz processor
+ Colour screen
Contact: Hewlett-Packard
Phone: 011-6826000
Fax: 011-6826030
Price: Rs 39,000

MP3 players
CCrreeaattiivvee  NNOOMMAADD  JJuukkeebbooxx
+ Excellent sound quality; onboard
audio processing; USB interface
– Has moving parts
Contact: Compuage Infocom
Phone: 022-4913986
Fax: 022-4919069
Price: Rs 32,000

Keyboards
LLooggiitteecchh  CCoorrddlleessss  FFrreeeeddoomm
NNaavviiggaattoorr
+ Very comfortable
+ Extensive configuration options
Contact: Rashi Peripherals
Phone: 022-8260258
Fax: 022-8190766
Price: Rs 7,750

Digital Cameras
CClliicckkiiTT!!  DDCCEE--440000
+ Good picture quality
+ Effortless connectivity
Contact: Memphis Technology
Phone: 022-8523439
Fax: 022-8523460
Price: Rs 19,999

Pointing devices
LLooggiitteecchh  CCoorrddlleessss  MMoouussee--
mmaann  WWhheeeell
+ Good accuracy with features;
resilient to dirt
+ Many extra function keys

Contact: Rashi Peripherals
Phone: 022-8260258
Fax: 022-8190766
Price: Rs 480

SOFTWARE
Operating systems (Linux)
SSuuSSEE  LLiinnuuxx  77..00
+ Simple to install; many bundled
applications
Contact: G. T. Enterprises
Phone: 080-6606093
Fax: 080-6671407
Price: Rs 1,800

Operating systems (Windows)
WWiinnddoowwss  22000000  
PPrrooffeessssiioonnaall
+ Very stable
– Heavy on system requirements
Contact: Integrated Business 
Solutions
Phone: 022-8214701
Fax: 022-8328240
Price: Rs 8,400

Office Suites
MMiiccrroossoofftt  OOffffiiccee  XXPP

+ Rich features
– Expensive
Contact: Microsoft (India)
Phone: 011-6294600
Price: Rs 20,500

OCR Packages
FFiinneeRReeaaddeerr  PPrroo  55..00
+ Quite accurate
Contact: Vikmans Multimedia
Phone: 011-6472325
Price: Rs 5,000

Antivirus
NNoorrttoonn  AAnnttiivviirruuss  22000011
+ High detection rate
+ Good script blocking capability
– Resource hungry
Contact: N & N Systems
Phone: 022-3680512/17/18
Fax: 022-3680513
Price: Rs 1,600

Firewalls
ZZoonneeAAllaarrmm  PPrroo  22..66  
+ Good performance 
– No protection against ActiveX
controls
Contact: www.zonelabs.com
Price: Rs 2,000 (approx)

CD-burning software
EEaassyy  CCDD  CCrreeaattoorr  55  PPllaattiinnuumm
+ Very fast writing speed
Contact: www.roxio.com
Price: Rs 3,600 (approx)

Voice recognition
DDrraaggoonn  NNaattuurraallllyySSppeeaakkiinngg
vv55..00  ((PPrreeffeerrrreedd  EEddiittiioonn))
+ Impressive speech recognition
– High on system requirements
Contact: HCL Infosystems

Phone: 011-4526518
Fax: 011-4526579
Price: Rs 17,995

Accounting Software
FFAACCTT  11..9900
+ Exhaustive feature list
– No security for database
Contact: Vedika Software
Phone: 022-5006490
Fax: 033-2400824
Price: Rs 14,500
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W
e usually think of Joann, our ace interface
designer, as somewhat of a tomboy. And
you can’t blame us—this girl plays the
drums, zooms around on her CBZ bike,

and kicks some serious butt in Quake. Imagine
our surprise when she returned from Goa not
with a tattoo or a braid, but with a little puppy,
peeking out like a baby kangaroo from the ruck-
sack she had slung across her shoulder.

Turns out that on a three-day training
session at Synapse (our

training centre in
Goa) Joann found the emaciated puppy

on the premises. Its hind legs were paralysed and
its mother had abandoned it. But it was full of
zest, and hopped about on its front legs, winning
the hearts of everyone around. Throughout the
three days, Joann and Ai Chin of the Multime-
dia team sneaked away during the session breaks
to feed it. When it was time to return to Mum-
bai, Joann didn’t have the heart to leave the lit-
tle thing behind in some dog shelter, so she
decided to bring it back with her. After dozens of

suggestions ranging from the practical ‘Doggie’
to the classy ‘Cloey’, the puppy has finally been
named Chance.

So Joann’s ‘one of the guys’ image has taken
a dent, but she sure is making up for it with a lot
of puppy love. Now that the little creature is
firmly ensconced in her house, Joann is having
to sacrifice some of her ‘wild’ ways, but one look
at the two of them together, and we know she
thinks its worth it. She very happily spends all
her free time looking after Chance, going back
home at lunchtime to check on her little ward
and going straight home after work.

Chance has been welcomed with open arms
into the Digit family, and was the guest of hon-
our at the last ‘girlie party’ (Chance is a bitch,
so the girls didn’t have to break their no-guys-
allowed policy. Sigh.) She had a great time
being fussed over by all the women, although
she was slightly miffed at dinner-time, when
she had to have Farex while the big girls ate
chicken biryani.

Joann has found plenty of volunteers to
baby-sit Chance if she wants to take off once in
a while. In fact, one look at those hazel eyes and
everyone starts clamouring for their turn to
mollycoddle Chance. Except for Jasmine of
course. Our International Marketing manager
is Joann’s roommate and she’s learning to live
with the puppy, but that doesn’t mean she has to
like it. Last we heard, she was expressing her
disapproval about being woken up with a cou-
ple of good ol’ doggie licks across her face every
morning.

Chance has had a couple of visits to the vet,
and is undergoing treatment for her partial
paralysis. The vet is not sure if and when this ail-
ment will be cured, but Joann and Chance are
willing to take a chance.

Take a Chance on me!
It was a chance
meeting that brought
Joann and Chance
together. And everyone
agrees that it’s a case
of love at first woof!

Once upon a time, there was a guy
named Sunil S. Now SS was a writer for you
favourite technology magazine, but he had a
burning passion for programming for the
Web. It is but natural that he should move on
to become a full-time programmer for our
Web site. 

Everything fine so far. Except that his
work cycle was such that during the days
when the Digit editorial used to be in a tizzy
about getting the magazine out, he was 

relatively free. And never one to let by an
opportunity to tease the rest of the team, SS
would put up his feet and taunt every has-
sled-looking soul who passed by about how
life as a programmer was so much more fun.

That was until the new site launch came
along and with it came four days and nights
of non-stop work! Of course, the rest of the
gang pitched in to do their bit. The writers
had a brainstorming session to figure out a
name for the site and came up with gems

like ‘humsubkadigit.com’ and ‘merawaladig-
it.com’. Sunil’s co-worker Aalaap G was his
usual reliable self. So what if he happened to
interchange the Mindware and Playware
pages? Then there were the copy editors,
who volunteered to insert taglines into the
articles to be uploaded. It’s another thing
that they changed all the <intro> tags to
<introduction> in true copydesk style.      

But the site is up and running…and they
all lived happily ever after. 

■■ ddiiggiitt  ddiiaarryy

TThhee  WWeebb  ssiittee  SSttoorryy



Hot Stuff
You think a Pentium 4, 1.7
GHz with a GeForce3 3D
card and four Seagate
Cheetahs configured in

RAID is really hot? Now
we’ve got a PC for you
that’s really hot…so hot
that it actually melted! Take
a look for yourself…
Contributed by: Nitin Garg,

via e-mail

Designer 
toilets anyone?

So you really dig the Apple
iMac huh? Well, here’s anoth-
er apple product that you
might want to upgrade to! 
Contributed by: Nitin Soni,

via e-mail

July 2001
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Bottom of the Charts
Man, don’t you

feel bad when you

don’t receive mail

for quite a while?

Makes you feel

sooooooo unpop-

ular! Small fry,

compared to this!

According to

MSN Explorer, this Digit reader is most unpopular…his

inbox shows 1 of –7 mails!

Contributed by: Rahul Rai, via e-mail 

MMoouussee  TTaalleess
On November 17, 1970, Patent 3,541,541 was
awarded to a rather ambiguous sounding
device, the ‘ For A Display System’, more
commonly known to you and me as the
computer mouse. 

Interestingly, the humble mouse was
invented way back in 1963-64, long before
the advent of personal computers. Its inven-
tor, Douglas C Engelbart, has a total of 20
patents to his credit, and has also developed
such famous computing tools as videocon-
ferencing, multiple-window screens and
hypertext besides.  

Although hundreds of millions of 
computer mice have been sold since,
Engelbart’s financial reward has been 
minimal. 

At the time he was working on the
mouse, he was working for the Stanford
Research Institute, which assumed full
rights to the patent. However, the institute
ultimately gave him “a $10,000 check”.

RETRO

Great balls of fire!
Here’s some serious protection for your Web site. Well

folks, as they say, attack is the best form of defence. So

Firewalls are out, fireballs are in! See if throwing these at

hackers is more

effective.

We’re won-

dering whether

to do a test drive

on these babies in our next issue.

Contributed by: Rohan Nathaniel, via e-mail

Enjoy!!
Here’s something you

might find extremely

handy, especially if

you’re in the habit of

juggling girlfriends!

It’s a software that

protects you from

important date losses. And by the way, it’s cash proof!

Contributed by: Soniya Mathur, via e-mail

Here’s a list of the most recent viruses discovered. And

some of the most hilarious definitions to go with each!

Adam and Eve Virus: Takes a couple of bytes out of

your Apple

AT&T Virus: Every three minutes it reminds you what

a great service you are

Freudian Virus: Your computer is obsessed with mar-

rying its own motherboard

Michael Jackson Virus: Hard to identify because it is

constantly altering its appearance

Nike Virus: Just DO It!

Politically Correct Virus: Never calls itself a ‘virus’.

Instead, calls itself an ‘electronic micro-organism’

Contributed by: Suraj Thapa, via e-mail

Arresting Stuff
Tired of being at the

receiving end of jokes

and being ragged by

your cousin, friend,

brother or sister? Here’s

how you can get back at

them…get them arrest-

ed! That’s right;

www.wasarrested.com lets you arrest anyone you like

by creating prank news reports on a variety of crimes.

These reports are then posted at a particular URL, which

you can mail to your victim. Such fun!

Taken from the Net

Readers Rants

Highlight the lighter side of 
computing. Mail your contributions
to  Backbyte
Digit, Plot D-222/2, 
TTC Industrial Area, MIDC, 
Shirvane, Nerul, 
Navi Mumbai 400 706
or send e-mail to
bbaacckkbbyyttee@@jjaassuubbhhaaii..ccoomm

Your chance to
BACKBYTE!

Virus Update High ambitions. Way 
too high!
Now here’s someone with

ambitions that differ from

the rest of us. This beauty

contest participant hopes

to one day be…an AIR

HOSTAGE!! Think she

won?

Contributed by: Sumit Raj, via e-mail
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